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CHAPTER 1 INTRODUCTION 

 

This Package aims to provide ultimate technical support and strength to the EPA / DAO Officers / 
farmers who are considered direct stakeholders in the rehabilitation of Smallholder Self-help Irrigation 
Schemes (Medium-Scale). The Package is prepared based on the outputs and lessons from the 
Verification Projects conducted at eight verification schemes as well as the discussions and results of 
DoI-DAES Workshops, ADD Workshops and farmer workshops. 

 

The Package will intend to cover the technical fields of the following: 

1) Rehabilitation of Irrigation Facilities, 
2) Operation and Maintenance (O&M) of Irrigation Facilities, 
3) Water Management of Irrigation Systems, 
4) Farm Management and Agricultural Extension, and 
5) Management of Farmers Group. 

 

For the purpose of efficient dissemination and convenient use by different users, the Package is 
composed of the following: 

a) Technical Guidelines for the use of the officers of the DoI/ADDs/DAOs/EPAs, 
b) Technical Manuals for the use of the farmers, 
c) Posters for general dissemination, and 
d) Leaflet for general dissemination. 
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CHAPTER 2 REHABILITATION/CONSTRUCTION OF IRRIGATION FACILITIES 

 

The guideline applies for rehabilitation and construction of medium scale irrigation facilities. It applies 
for simple and small scale structures which are made of stone masonry, brick masonry, stones, earth 
etc. However, it does not include construction of sophisticated structures e.g. reinforced concrete as 
well as use of heavy equipment. Most of the works under this guideline are to be done by the farmers 
manually. However, the guideline also contains other related detailed hydraulic analysis, structure 
analysis and stability analysis for structures.  

2.1 River Diversion Weir  

Diversion weir is a structure, which diverts water from a river into a canal for irrigation use. A fixed 
type weir is such a structure as to secure the required water level at intake, to avoid a considerable 
obstacle to floods and to have a section which is safe enough against external forces. In this project, 
fixed type weir is applied and its components are limited to main weir, apron, riverbed protection, 
riverbank protection etc. On the other hand; gate facility, control facility, sluice and fish ladder have 
not been included in the guideline.  

(1) Rehabilitation / Construction Criteria 

1) Material 

Most of materials for rehabilitation work are procured locally whilst use of input from outside is 
minimized. Local materials include sand, stone, bricks, while cement, gabion, tools are regarded as 
outside materials. Local materials and outside materials are to be provided by the beneficiaries and 
donors respectively. 

2) Labor  

The rehabilitation work is done by the farmers under supervision of AEDO and IOs. Labor force is 
provided by the farmers group. Only transportation for materials (if necessary) is provided from 
outside.  

(2) Investigation 

Field investigations are carried out at and around the site as regards river conditions, effects on flood 
control and water use upstream and downstream, and foundation conditions. Prior to the investigations 
selecting necessary items for investigation, the appropriate investigation plan should be put in practice. 

1) Investigation of river conditions 

Investigation of river condition should be executed on (i) water level and discharge, (ii) sedimentation, 
(iii) stream centerline, (iv) riverbed slope, (v) riverbed materials. 

(i) Water level and discharge 
Highest water level and representative water level in each month are required to be obtained. 
Highest water level is obtained by observing past flood mark and by interviewing the villagers. 
Representative discharge in each month is estimated from water level, flow velocity and 
cross-section.  
(ii) Sedimentation 
River sediment is measured in order to arrange for sand removal plan. Sediment at a river 
structure of vicinity area can be referred. 
(iii) Stream centerline 
The location of the weir should be selected at a site where the stream centerline is stable and 
located near the riverbank where the intake is required. 
(iv) Riverbed slope 
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Riverbed slope is an essential hydrological parameter and necessary to estimate discharge. 
Riverbed slope is obtained by surveying the elevation at 20m interval from 100m upstream to 
100m downstream of the weir. 
(v) Riverbed materials 
Riverbed materials should be observed to estimate roughness coefficient. Value of roughness 
coefficient is shown in the Table 2-1. 

Table 2-1 Roughness Coefficient of Natural Flow Canals 

Roughness Coefficient Materials and conditions of canals Minimum Standard Maximum 
Small canals on flat land 
1). Not weedy, straight. Neither cracks nor crevices are seen 

when water reaches the high water level 
2) Weedy and stony. Neither cracks nor crevices are seen 

when water reaches the high water level 
3) Not weedy but meandering. Some crevices and shallows 

are seen. 
4) Some weeds and stones, meandering. Some abysses and 

shallows are seen. 
5) Meandering. Some crevices and shallows are seen. The 

changes in gradients and cross-sections are few at low 
water level. 

6) The same as 5) but stony. 
7) Weeds and deep crevices are seen along moderate flow 

areas. 
8) Area where weeds grow densely, deep crevices are seen, 

or many trees are present 

 
0.025 

 
0.030 

 
0.033 

 
0.035 

 
0.040 

 
 

0.045 
0.050 

 
0.075 

 
0.030 

 
0.035 

 
0.040 

 
0.045 

 
0.048 

 
 

0.050 
0.070 

 
0.100 

 
0.033 

 
0.040 

 
0.045 

 
0.050 

 
0.055 

 
 

0.060 
0.080 

 
0.115 

Canals in mountain areas. No plants in canals. River banks 
are usually steep. Trees and shrubs along river banks are 
submerged when water reaches the high water level. 
1) Cobblestones and gravel on river bed 
2) Large cobblestones on river bed 

 
 
 

0.030 
0.040 

 
 
 

0.040 
0.050 

 
 
 

0.050 
0.070 

Large canals 
1) Constant cross sections without large cobblestones or 

shrubs 
2) Rough and irregular cross sections 

 
0.025 

 
0.035 

 
 
 
 

 
0.060 

 
0.100 

Source: Engineering Manual for Irrigation and Drainage Canal Works, The Japanese Institute of 
Irrigation and Drainage 1987. 

2) Investigation on the influence of flood control and water use 

The condition of drainage discharges into rivers upstream and downstream during the ordinary flow 
should be investigated in order to find the influence of rise of water level by weir upon drainability 
upstream and downstream. Flood water level and flood pond area should be investigated to decide the 
height of weir. Present condition of river utilization such as irrigation, hydropower, water rights, 
fishery and others should also be investigated. 

3) Investigation on the foundations 

Investigation on the foundations are executed for items such as the structure and properties of the 
ground, bearing capacity of the ground, conditions of riverbed deposits, ground water level and flow 
condition of ground water. 

Investigation on the foundations should be carried out in order to design suitable foundation structures 
for the ground condition. Test pitting makes possible appraisal of strata and geology by the naked eye 
and to estimate bearing capacity. Standard allowable bearing capacity is shown in Table 2-2.  

3
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Table 2-2 Allowable Bearing Capacity of Foundation 

Remarks 
Foundation 

Allowable Bearing 
Capacity (kN/m2) N-value * qu 

(kN/m2) 
Friction 

Coefficient 
Rock  1,000 ~100  0.7 
Solid Sand   500 ~50  0.6 
Semi consolidated 
silt, clay 

 300 ~30  0.7 

Conglomerate layer Thick 
Not thick 

600 
300 

  0.6 

Sand ground 
 

Thick 
Medium  
thick 
Loose 
Very loose 

300 
200 
100 
50 
0 

30 – 50 
20 – 30 
10 – 20 
5 – 10 

~5 

 0.6 
0.5 

 
 

Clayey ground Very solid 
Solid 
Medium solid 
Soft 
Very soft 

200 
100 
50 
20 
0 

15 – 30 
8 – 15 
4 – 8 
2 – 4 
0 – 2 

~250 
100 – 250 
50 – 100 
25 – 50 

~25 

0.5 
0.45 

 
 
 

Loam Solid 
Rather solid 
Soft 

150 
100 
50 

~5 
3 – 5 
~3 

~150 
100 – 150 

~100 

 
 
 

* Unconfined compression strength 
Source: Technical Standard for River Works and Erosion and Sediment Control Works, Ministry of 
Land, Infrastructure and Transport, 1997 

 

4) Investigation for construction works 

Investigation for construction works should be conducted on the following items, which are necessary 
for construction planning. 

(i) Meteorology, stream condition, ground water, riverbed conditions 
Meteorology and stream condition should be thoroughly investigated because of their utmost 
importance for deciding the construction schedule based on the investigation on 10 year data of 
rainfall and river run off, channels, elevation of cofferdam, etc. Especially, temperature is 
important for work plan of concrete (mortar) works.  
(ii) Construction equipment, tools, materials, transportation and labor. 
Construction materials include cement, sand, gravel, stone, steel materials, bricks and timber etc. 
The supply situation of materials should be checked. Availability of local materials, necessity of 
transportation, availability of transportation and availability of tools should also be checked. 
Transportation of materials should be arranged if necessary. Minimum use of construction 
equipment is encouraged for medium scale irrigation schemes. Number of skilled labor and 
unskilled labor should also be checked. 

5) Topographical survey 

Topographical survey for weirs should be done on the following items; 

(i) Plane survey 
Plane survey is necessary not only for construction of the weir and intake but also for the 
planning and design of cofferdam. Curvature conditions of the river should be surveyed. It is 
desirable to draw contour lines on the map. 
(ii) Longitudinal and cross section  
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Profile and cross section of the river are used for designing weir and hydraulic calculations.  
(iii) Collection of topographic and other related maps 
Prior to field investigations and surveys, topographic maps and other related maps around the 
scheme should be collected in order to prepare the investigation schedule, and to make a 
preliminary design. 

6) Investigation for rehabilitation of existing facilities. 

In case of rehabilitation of existing weir, following items should be investigated in addition to above 
items. 

i) Present condition of existing weir 
ii) Topographical survey for rehabilitation items 

Table 2-3 List of Items to be Investigated (River Diversion Weir) 

Items Description Method Outputs 
1. River Conditions 
(i) Water level and 
discharge 
 
 
 
 
(ii) Sedimentation 
 
(iii) Stream centerline 
 
 
 
 
(iv) Riverbed slope 
 
 
(v) Riverbed materials 
 

 
- Highest water level 
 
 
- Representative water 
level and flow velocity in 
each month 
- Sediment at a structure 
of vicinity area 
- Stream centerline is 
stable. 
- Stream centerline is 
located near the bank 
where intake is required 
- Riverbed slope 
 
 
- Materials and 
conditions of the river 

 
- Observation of past flood 
mark and interview to the 
villagers 
- Observation at the river 
 
 
- Observation of sediment 
configuration. 
- Visual observation at the 
river 
- Visual observation at the 
river 
 
- Surveying. 20m interval, 
from 100m upstream to 
100m downstream. 
- Visual observation at the 
river 

 
HWL= 
 
 
WL= 
 
 
Stones, sand or silt 
 
Yes or no 
 
Yes or no 
 
 
Riverbed slope= 
 
 
Estimated roughness 
coefficient= 

2. Influence of flood 
control and water use 
(i) Drainage discharge 
into the river 
(ii) Flood pond area 
 
 
 
 
(iii) River utilization 
 

 
 
- Influence to the drain 
 
- Flood pond area does 
not influence farmland, 
trees etc. 
- Flood water level does 
not exceed river bank. 
- Present utilization of the 
river 
- Water rights 

 
 
- Surveying location and 
elevation of drain 
- Observation at the site 
 
 
- Observation at the site 
 
- Irrigation for downstream
Fish pond, Others 
-Interview to relevant party

 
 
Location=, Elevation= 
No influence 
No influence 
 
 
No influence 
 
Requirement= lit/s 
Requirement= lit/s 
Quantity = lit/s. Water 
fee=      MK 

3. Foundation 
(i) River bed  
 
 
 
 
(ii) Abutment 
 

 
- Depth of bedrock, 
allowable bearing 
capacity 
 
- Depth of bedrock, soil 
property 
 

 
- Visual observation, Test 
pitting, visual observation 
Penetration test 
 
- Visual observation, test 
pitting 
 

 
Outcrop, Depth of 
bedrock=  
Blow number at the 
depth=  
Outcrop, Depth of 
bedrock=, Soil 
property 
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 - Ground water - Visual observation Ground water level= 
4. Construction works 
(i) Meteorology 
 
 
 
(ii) Construction 
equipment, materials, 
transportation 
 
 
 

 
- Collection of  all 
existing meteorological 
data 
 
- Availability of materials 
 
- Number of available 
tools  
- Available transportation 
- Number of available 
labor 

 
- Data collection and site 
observation 
 
 
- Stone, Sand, Cement 
 
- Wheelbarrow, Bucket, 
Shovel, Pickaxe, etc. 
- Truck, tractor, oxcart 
- Skilled labor, Unskilled 
labor 

 
Annual rainfall, Stream 
condition, temperature, 
water level, Height of 
cofferdam 
= km from the site, 
= to be procured in   
= units, = pcs 
 
DAO, DA, ADD, 
Farmers, = number 

5. Topographical survey 
(i) Plane survey 
 
 
 
 
(ii) Longitudinal and 
cross section 
 
 
 
 
 
 
 
 
 
 
(iii) Collection of 
topographic and other 
related maps. 

 
- Configuration of the 
river, centerline of the 
weir, location of intake, 
cofferdam, stockyard etc. 
should be indicated. 
- Longitudinal section of 
the river. 
- Cross section of the 
river along the weir 
centerline. 
- Longitudinal section of 
the main canal from 
inflow point to intake 
structure. 
- Cross section of the 
main canal at the intake 
structure. 
- Available maps around 
the scheme 

 
- Site surveying with 
measuring tape and 
compass. Plane table. 
 
 
- Site surveying with 
measuring tape and level. 
- Site surveying with 
measuring tape and level. 
 
- ditto 
 
 
 
- ditto 
 
 
- Data collection 
 

 
Plan: scale 1/100 
 
 
 
 
Longitudinal section: 
scale 1/50 
Cross section: scale 
1/50 
 
Longitudinal section: 
scale 1/50 
 
 
Cross section: scale 
1/50 
 
Various maps 

6. Investigation for 
rehabilitation 
(i) Present condition of 
existing weir 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
- Dimensions of the weir 
 
 
 
 
- Material of the structure
- Condition of material 
 
- Crack at the weir 
 
- Water leakage 
 
 
- Damage of the structure
- Stability 
- Sediment 
 
- Longitudinal section of 
the structures to be 

 
 
- Site investigation, 
observation, measuring 
tape.  
 
 
- ditto 
- ditto 
 
- ditto 
 
- ditto 
 
 
- ditto 
- ditto 
- ditto 
 
- ditto 
 

 
 
Length=  m, 
Base width=  m, 
Top width=  m, 
Upstream slope= , 
Downstream slope= , 
Material is=  
Condition of material 
is good/bad 
Location, length and 
width of the crack= 
Location of water 
leakage. Quantity of 
water leakage= lit/min.
Location, situation 
Stable/not stable 
Configuration and 
depth 
Longitudinal section: 
scale 1/200~1/500 
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(ii) Topographical survey 
for rehabilitation items 

rehabilitated. 
- Cross section of the 
structures to be 
rehabilitated. 

 
- Site surveying with 
measuring tape and 
compass. 

 
Cross section: scale 
1/50 
 

(3) Rehabilitation / Construction Planning / Design  

1) General Layout 

River diversion work is comprised of main weir, intake, spillway, apron, riverbed protection and slope 
protection.  

The location of the weir should be decided considering stability of structure, operation and 
maintenance, canal slope, canal length and elevation of beneficiary area. Intake floor must be higher 
than the highest elevation of beneficiary area. The shorter length of canal is economical.  

The elevation of both side banks should be high enough to avoid flooding upstream. If the elevation of 
the bank is not high enough, may result into a flood upstream by rising water level by the weir. The 
height of the weir should be decided considering flood water level of upstream. General layout of 
gravity diversion weir type irrigation scheme is shown in Figure 2-1. 

Many of existing medium scale weir do not have apron, riverbed protection and slope protection. It is 
desirable to improve those parts. However, necessity of such improvement should be decided 
considering current situation of upstream and downstream riverbed and river bank.  

Raising the crest of existing weir should be decided very carefully considering flood elevation and 
influence to riverbed, abutment and river bank. 

 

Figure 2-1 General Lay-out for Gravity Diversion Weir Type Irrigation 

 

2) Design intake discharge and design intake water level 

Design intake discharge should be the maximum intake discharge of the main canal at intake point. 
Design intake water level should be the water level of maximum intake discharge of the main canal at 

main weir

main canal

stone masonry with mortar

gabion
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intake point. 

3) Design flood discharge and design flood water level 

a. Design flood discharge 
 

 

 

 

 

 

Figure 2-2 Sample Cross Section of a River 

Design flood discharge should be the larger value of maximum experienced flood discharge or 
regional maximum flood discharge. Maximum experienced flood discharge is roughly estimated by 
Manning Formula. Required data and information are cross section of the river (refer to Figure 2-2), 
gradient, past maximum flood mark (elevation) and roughness coefficient. 

Q = A x V (m3/sec) 
 Where; 
 Q = Discharge (m3/sec) 
 A = Flow area (m2) 
 V = Flow velocity (m/sec) 
 V = 1/n x R2/3 x I 1/2 
 n = Roughness coefficient refer to Table 2-1  
 I = Gradient of the riverbed 
 R = Hydraulic mean depth (m) 
Example 
Coordinates; a(ax, ay), b(bx, by), c(cx, cy), d(dx, dy), e(ex, ey), f(fx, fy) 
FWL; h (from past maximum flood mark) 
gx = ax + (bx – ax) x (ay – h) / (ay – by), gy = h  
hx = dx + (ex – dx) x (h – dy) / (ey – dy), hy = h 
A = A1 + A2 + A3 + A4 
A1 = (bx –gx) x (gy – by) / 2 
A2 = ((h – by) + (h – cy)) x (cx – bx) / 2 
A3 = ((h – cy) + (h – dy)) x (dx – cx) / 2 
A4 = (hx – dx) x (h – dy) / 2 
R = A / P   P: Wetted Perimeter 
P = gb + bc + cd + dh 
 = √((bx – gx)2 + (h – by)2)  + √((cx – bx)2 + (by – cy)2) + √((dx – cx)2 + (dy – cy)2) 

+ √ ((hx – dx)2 + (h – dy)2) 

Table 2-4 shows referential hydraulic analysis result of uniform flow for simple shape river. 

Regional maximum flood discharge is computed from specific discharge of maximum flood discharge 
of another dam in neighboring districts. 

Q = A x q 
Q = Discharge (m3/sec) 
A = Catchment area (km2) 
q = Specific discharge (m3/sec/km2) 

 

a 

b 

c d 

e f 

g h
FWL 

Fb 

A3A2 A4 

A1 

8



 
 

Final Report, Annex 1 Technical Guidelines August 2009 

  

b. Design flood water level 

Design flood water level should be lower than embankment. In this guideline, difference between 
design flood water level and top of riverbank (Fb in Figure 2-2) should be more than 0.6m. If Fb is 
less than 0.6m, a weir should not be constructed at the location. The weir should be designed so as to 
have Fb more than 0.6m. 

Upstream depth of the river after construction of a weir is computed with various hydraulic analyses. 
However, in this guideline, simplified calculations, Manning Formula should be adopted. Calculation 
method is the same as that of design flood discharge explained in “a. Design flood discharge”. Cross 
section for calculation should be at the weir. Riverbed should assume as weir crest considering 
accumulation of sediment. Water flow area for calculation should be area (j, k, l, e, m) in Figure 2.3. 

 

 

 

 

 

 

 

Figure 2-3 Sample Cross Section of a Weir 

In case of perfect overflow at the weir, upstream depth of the weir at the design flood discharge is 
roughly estimated as below. 

 qw = mo x bw x √(2g) x h13/2 = ko x bw x  h13/2   (m3/sec)    
 qw = Discharge (m3/sec ) 
 mo, ko = Discharge coefficient, mo = 0.385, ko = 1.70 (considering a situation with 

sedimentation expected to accumulate on the top of the weir) 
 bw = Weir length (m) 
 g = Gravity acceleration (9.8m/sec2) 
 h1 = Upstream head from the top of the weir (m) 
   h1 = d1 + V2 / 2g 
 V = qw / A = qw / (d1 x bw) 
 d1 = Upstream depth 
Source: Engineering Manual for Irrigation and Drainage Head Works, The Japanese Institute of 
Irrigation and Drainage 1989. 

Table 2-5 shows referential hydraulic analysis result of perfect overflow at a weir. 

 
 
 

b 

c d 

e 

f 
j m

FWL Fb 

a 
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l 
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Table 2-4 Referential Hydraulic Analysis Results of Uniform Flow 

Assumed Cross Section of River

Roughness coefficient n = 0.045

Table  Depth - Discharge B = 5.0m
Water Depth Gradient Velocity Discharge Froude 

WD (m) I V (m/s) (m^3/s) Number
1.000 0.010 1.851 10.179 0.591
1.200 0.010 2.032 13.658 0.593
1.400 0.010 2.195 17.514 0.593
1.600 0.010 2.342 21.733 0.591
1.800 0.010 2.477 26.305 0.590
2.000 0.010 2.602 31.222 0.588
2.200 0.010 2.718 36.480 0.585
2.400 0.010 2.828 42.076 0.583
2.600 0.010 2.931 48.009 0.581
2.800 0.010 3.029 54.279 0.578
1.000 0.005 1.309 7.198 0.418
1.200 0.005 1.437 9.657 0.419
1.400 0.005 1.552 12.384 0.419
1.600 0.005 1.656 15.368 0.418
1.800 0.005 1.751 18.600 0.417
2.000 0.005 1.840 22.077 0.416
2.200 0.005 1.922 25.795 0.414
2.400 0.005 2.000 29.752 0.412
2.600 0.005 2.073 33.948 0.411
2.800 0.005 2.142 38.381 0.409
1.000 0.003 1.069 5.877 0.341
1.200 0.003 1.173 7.885 0.342
1.400 0.003 1.267 10.112 0.342
1.600 0.003 1.352 12.548 0.341
1.800 0.003 1.430 15.187 0.340
2.000 0.003 1.502 18.026 0.339
2.200 0.003 1.569 21.062 0.338
2.400 0.003 1.633 24.293 0.337
2.600 0.003 1.692 27.718 0.335
2.800 0.003 1.749 31.338 0.334
1.000 0.002 0.828 4.552 0.264
1.200 0.002 0.909 6.108 0.265
1.400 0.002 0.982 7.832 0.265
1.600 0.002 1.047 9.719 0.264
1.800 0.002 1.108 11.764 0.264
2.000 0.002 1.164 13.963 0.263
2.200 0.002 1.216 16.314 0.262
2.400 0.002 1.265 18.817 0.261
2.600 0.002 1.311 21.470 0.260
2.800 0.002 1.355 24.274 0.259

width B

0.5

1
.0

W
D
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T a b l e   D e p t h  -  D i s c h a r g e B  =  1 0 . 0 m
W a t e r  D e p t h G r a d i e n t V e l o c i t y D i s c h a r g e F r o u d e  

W D  ( m ) I V  ( m / s ) ( m ^ 3 / s ) N u m b e r
1 . 0 0 0 0 . 0 1 0 2 . 0 0 7 2 1 . 0 7 1 0 . 6 4 1
1 . 2 0 0 0 . 0 1 0 2 . 2 2 7 2 8 . 3 2 1 0 . 6 4 9
1 . 4 0 0 0 . 0 1 0 2 . 4 2 6 3 6 . 3 4 6 0 . 6 5 5
1 . 6 0 0 0 . 0 1 0 2 . 6 1 0 4 5 . 0 9 7 0 . 6 5 9
1 . 8 0 0 0 . 0 1 0 2 . 7 8 0 5 4 . 5 3 6 0 . 6 6 2
2 . 0 0 0 0 . 0 1 0 2 . 9 3 8 6 4 . 6 3 5 0 . 6 6 4
2 . 2 0 0 0 . 0 1 0 3 . 0 8 6 7 5 . 3 7 0 0 . 6 6 5
2 . 4 0 0 0 . 0 1 0 3 . 2 2 6 8 6 . 7 2 0 0 . 6 6 5
2 . 6 0 0 0 . 0 1 0 3 . 3 5 8 9 8 . 6 7 0 0 . 6 6 5
2 . 8 0 0 0 . 0 1 0 3 . 4 8 4 1 1 1 . 2 0 6 0 . 6 6 5
1 . 0 0 0 0 . 0 0 5 1 . 4 1 9 1 4 . 8 9 9 0 . 4 5 3
1 . 2 0 0 0 . 0 0 5 1 . 5 7 4 2 0 . 0 2 6 0 . 4 5 9
1 . 4 0 0 0 . 0 0 5 1 . 7 1 6 2 5 . 7 0 0 0 . 4 6 3
1 . 6 0 0 0 . 0 0 5 1 . 8 4 5 3 1 . 8 8 8 0 . 4 6 6
1 . 8 0 0 0 . 0 0 5 1 . 9 6 6 3 8 . 5 6 3 0 . 4 6 8
2 . 0 0 0 0 . 0 0 5 2 . 0 7 8 4 5 . 7 0 4 0 . 4 6 9
2 . 2 0 0 0 . 0 0 5 2 . 1 8 2 5 3 . 2 9 5 0 . 4 7 0
2 . 4 0 0 0 . 0 0 5 2 . 2 8 1 6 1 . 3 2 0 0 . 4 7 0
2 . 6 0 0 0 . 0 0 5 2 . 3 7 5 6 9 . 7 7 0 0 . 4 7 1
2 . 8 0 0 0 . 0 0 5 2 . 4 6 4 7 8 . 6 3 4 0 . 4 7 0
1 . 0 0 0 0 . 0 0 3 1 . 1 5 9 1 2 . 1 6 5 0 . 3 7 0
1 . 2 0 0 0 . 0 0 3 1 . 2 8 6 1 6 . 3 5 1 0 . 3 7 5
1 . 4 0 0 0 . 0 0 3 1 . 4 0 1 2 0 . 9 8 4 0 . 3 7 8
1 . 6 0 0 0 . 0 0 3 1 . 5 0 7 2 6 . 0 3 7 0 . 3 8 1
1 . 8 0 0 0 . 0 0 3 1 . 6 0 5 3 1 . 4 8 7 0 . 3 8 2
2 . 0 0 0 0 . 0 0 3 1 . 6 9 6 3 7 . 3 1 7 0 . 3 8 3
2 . 2 0 0 0 . 0 0 3 1 . 7 8 2 4 3 . 5 1 5 0 . 3 8 4
2 . 4 0 0 0 . 0 0 3 1 . 8 6 3 5 0 . 0 6 8 0 . 3 8 4
2 . 6 0 0 0 . 0 0 3 1 . 9 3 9 5 6 . 9 6 7 0 . 3 8 4
2 . 8 0 0 0 . 0 0 3 2 . 0 1 1 6 4 . 2 0 5 0 . 3 8 4
1 . 0 0 0 0 . 0 0 2 0 . 8 9 7 9 . 4 2 3 0 . 2 8 7
1 . 2 0 0 0 . 0 0 2 0 . 9 9 6 1 2 . 6 6 6 0 . 2 9 0
1 . 4 0 0 0 . 0 0 2 1 . 0 8 5 1 6 . 2 5 4 0 . 2 9 3
1 . 6 0 0 0 . 0 0 2 1 . 1 6 7 2 0 . 1 6 8 0 . 2 9 5
1 . 8 0 0 0 . 0 0 2 1 . 2 4 3 2 4 . 3 8 9 0 . 2 9 6
2 . 0 0 0 0 . 0 0 2 1 . 3 1 4 2 8 . 9 0 6 0 . 2 9 7
2 . 2 0 0 0 . 0 0 2 1 . 3 8 0 3 3 . 7 0 6 0 . 2 9 7
2 . 4 0 0 0 . 0 0 2 1 . 4 4 3 3 8 . 7 8 2 0 . 2 9 8
2 . 6 0 0 0 . 0 0 2 1 . 5 0 2 4 4 . 1 2 6 0 . 2 9 8
2 . 8 0 0 0 . 0 0 2 1 . 5 5 8 4 9 . 7 3 3 0 . 2 9 7

T a b l e   D e p t h  -  D i s c h a r g e B  =  1 5 . 0 m
W a t e r  D e p t h G r a d i e n t V e l o c i t y D i s c h a r g e F r o u d e  

W D  ( m ) I V  ( m / s ) ( m ^ 3 / s ) N u m b e r
1 . 0 0 0 0 . 0 1 0 2 . 0 7 0 3 2 . 0 9 1 0 . 6 6 1
1 . 2 0 0 0 . 0 1 0 2 . 3 0 8 4 3 . 2 1 0 0 . 6 7 3
1 . 4 0 0 0 . 0 1 0 2 . 5 2 7 5 5 . 5 3 4 0 . 6 8 2
1 . 6 0 0 0 . 0 1 0 2 . 7 2 9 6 8 . 9 8 5 0 . 6 8 9
1 . 8 0 0 0 . 0 1 0 2 . 9 1 8 8 3 . 5 0 0 0 . 6 9 5
2 . 0 0 0 0 . 0 1 0 3 . 0 9 5 9 9 . 0 2 9 0 . 6 9 9
2 . 2 0 0 0 . 0 1 0 3 . 2 6 2 1 1 5 . 5 2 7 0 . 7 0 3
2 . 4 0 0 0 . 0 1 0 3 . 4 2 0 1 3 2 . 9 6 0 0 . 7 0 5
2 . 6 0 0 0 . 0 1 0 3 . 5 7 0 1 5 1 . 2 9 4 0 . 7 0 7
2 . 8 0 0 0 . 0 1 0 3 . 7 1 3 1 7 0 . 5 0 4 0 . 7 0 9
1 . 0 0 0 0 . 0 0 5 1 . 4 6 4 2 2 . 6 9 2 0 . 4 6 8
1 . 2 0 0 0 . 0 0 5 1 . 6 3 2 3 0 . 5 5 4 0 . 4 7 6
1 . 4 0 0 0 . 0 0 5 1 . 7 8 7 3 9 . 2 6 9 0 . 4 8 2
1 . 6 0 0 0 . 0 0 5 1 . 9 3 0 4 8 . 7 8 0 0 . 4 8 7
1 . 8 0 0 0 . 0 0 5 2 . 0 6 3 5 9 . 0 4 4 0 . 4 9 1
2 . 0 0 0 0 . 0 0 5 2 . 1 8 8 7 0 . 0 2 4 0 . 4 9 4
2 . 2 0 0 0 . 0 0 5 2 . 3 0 6 8 1 . 6 9 0 0 . 4 9 7
2 . 4 0 0 0 . 0 0 5 2 . 4 1 8 9 4 . 0 1 7 0 . 4 9 9
2 . 6 0 0 0 . 0 0 5 2 . 5 2 4 1 0 6 . 9 8 1 0 . 5 0 0
2 . 8 0 0 0 . 0 0 5 2 . 6 2 6 1 2 0 . 5 6 5 0 . 5 0 1
1 . 0 0 0 0 . 0 0 3 1 . 1 9 5 1 8 . 5 2 8 0 . 3 8 2
1 . 2 0 0 0 . 0 0 3 1 . 3 3 3 2 4 . 9 4 8 0 . 3 8 9
1 . 4 0 0 0 . 0 0 3 1 . 4 5 9 3 2 . 0 6 3 0 . 3 9 4
1 . 6 0 0 0 . 0 0 3 1 . 5 7 6 3 9 . 8 2 9 0 . 3 9 8
1 . 8 0 0 0 . 0 0 3 1 . 6 8 4 4 8 . 2 0 9 0 . 4 0 1
2 . 0 0 0 0 . 0 0 3 1 . 7 8 7 5 7 . 1 7 4 0 . 4 0 4
2 . 2 0 0 0 . 0 0 3 1 . 8 8 3 6 6 . 7 0 0 0 . 4 0 6
2 . 4 0 0 0 . 0 0 3 1 . 9 7 4 7 6 . 7 6 4 0 . 4 0 7
2 . 6 0 0 0 . 0 0 3 2 . 0 6 1 8 7 . 3 5 0 0 . 4 0 8
2 . 8 0 0 0 . 0 0 3 2 . 1 4 4 9 8 . 4 4 1 0 . 4 0 9
1 . 0 0 0 0 . 0 0 2 0 . 9 2 6 1 4 . 3 5 2 0 . 2 9 6
1 . 2 0 0 0 . 0 0 2 1 . 0 3 2 1 9 . 3 2 4 0 . 3 0 1
1 . 4 0 0 0 . 0 0 2 1 . 1 3 0 2 4 . 8 3 6 0 . 3 0 5
1 . 6 0 0 0 . 0 0 2 1 . 2 2 0 3 0 . 8 5 1 0 . 3 0 8
1 . 8 0 0 0 . 0 0 2 1 . 3 0 5 3 7 . 3 4 3 0 . 3 1 1
2 . 0 0 0 0 . 0 0 2 1 . 3 8 4 4 4 . 2 8 7 0 . 3 1 3
2 . 2 0 0 0 . 0 0 2 1 . 4 5 9 5 1 . 6 6 5 0 . 3 1 4
2 . 4 0 0 0 . 0 0 2 1 . 5 2 9 5 9 . 4 6 1 0 . 3 1 5
2 . 6 0 0 0 . 0 0 2 1 . 5 9 7 6 7 . 6 6 1 0 . 3 1 6
2 . 8 0 0 0 . 0 0 2 1 . 6 6 1 7 6 . 2 5 2 0 . 3 1 7
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T a b l e   D e p t h  -  D i s c h a r g e B  =  2 0 . 0 m
W a t e r  D e p t h G r a d i e n t V e l o c i t y D i s c h a r g e F r o u d e  

W D  ( m ) I V  ( m / s ) ( m ^ 3 / s ) N u m b e r
1 . 0 0 0 0 . 0 1 0 2 . 1 0 5 4 3 . 1 5 2 0 . 6 7 2
1 . 2 0 0 0 . 0 1 0 2 . 3 5 3 5 8 . 1 7 4 0 . 6 8 6
1 . 4 0 0 0 . 0 1 0 2 . 5 8 3 7 4 . 8 4 5 0 . 6 9 7
1 . 6 0 0 0 . 0 1 0 2 . 7 9 6 9 3 . 0 5 9 0 . 7 0 6
1 . 8 0 0 0 . 0 1 0 2 . 9 9 7 1 1 2 . 7 3 1 0 . 7 1 4
2 . 0 0 0 0 . 0 1 0 3 . 1 8 6 1 3 3 . 7 8 9 0 . 7 2 0
2 . 2 0 0 0 . 0 1 0 3 . 3 6 4 1 5 6 . 1 7 3 0 . 7 2 4
2 . 4 0 0 0 . 0 1 0 3 . 5 3 4 1 7 9 . 8 2 8 0 . 7 2 9
2 . 6 0 0 0 . 0 1 0 3 . 6 9 7 2 0 4 . 7 1 1 0 . 7 3 2
2 . 8 0 0 0 . 0 1 0 3 . 8 5 2 2 3 0 . 7 8 1 0 . 7 3 5
1 . 0 0 0 0 . 0 0 5 1 . 4 8 9 3 0 . 5 1 3 0 . 4 7 6
1 . 2 0 0 0 . 0 0 5 1 . 6 6 4 4 1 . 1 3 5 0 . 4 8 5
1 . 4 0 0 0 . 0 0 5 1 . 8 2 6 5 2 . 9 2 3 0 . 4 9 3
1 . 6 0 0 0 . 0 0 5 1 . 9 7 7 6 5 . 8 0 3 0 . 4 9 9
1 . 8 0 0 0 . 0 0 5 2 . 1 1 9 7 9 . 7 1 3 0 . 5 0 5
2 . 0 0 0 0 . 0 0 5 2 . 2 5 3 9 4 . 6 0 3 0 . 5 0 9
2 . 2 0 0 0 . 0 0 5 2 . 3 7 9 1 1 0 . 4 3 1 0 . 5 1 2
2 . 4 0 0 0 . 0 0 5 2 . 4 9 9 1 2 7 . 1 5 8 0 . 5 1 5
2 . 6 0 0 0 . 0 0 5 2 . 6 1 4 1 4 4 . 7 5 3 0 . 5 1 8
2 . 8 0 0 0 . 0 0 5 2 . 7 2 3 1 6 3 . 1 8 7 0 . 5 2 0
1 . 0 0 0 0 . 0 0 3 1 . 2 1 5 2 4 . 9 1 4 0 . 3 8 8
1 . 2 0 0 0 . 0 0 3 1 . 3 5 9 3 3 . 5 8 7 0 . 3 9 6
1 . 4 0 0 0 . 0 0 3 1 . 4 9 1 4 3 . 2 1 2 0 . 4 0 3
1 . 6 0 0 0 . 0 0 3 1 . 6 1 4 5 3 . 7 2 8 0 . 4 0 8
1 . 8 0 0 0 . 0 0 3 1 . 7 3 0 6 5 . 0 8 5 0 . 4 1 2
2 . 0 0 0 0 . 0 0 3 1 . 8 3 9 7 7 . 2 4 3 0 . 4 1 5
2 . 2 0 0 0 . 0 0 3 1 . 9 4 2 9 0 . 1 6 6 0 . 4 1 8
2 . 4 0 0 0 . 0 0 3 2 . 0 4 1 1 0 3 . 8 2 4 0 . 4 2 1
2 . 6 0 0 0 . 0 0 3 2 . 1 3 4 1 1 8 . 1 9 0 0 . 4 2 3
2 . 8 0 0 0 . 0 0 3 2 . 2 2 4 1 3 3 . 2 4 1 0 . 4 2 5
1 . 0 0 0 0 . 0 0 2 0 . 9 4 1 1 9 . 2 9 8 0 . 3 0 1
1 . 2 0 0 0 . 0 0 2 1 . 0 5 2 2 6 . 0 1 6 0 . 3 0 7
1 . 4 0 0 0 . 0 0 2 1 . 1 5 5 3 3 . 4 7 2 0 . 3 1 2
1 . 6 0 0 0 . 0 0 2 1 . 2 5 1 4 1 . 6 1 7 0 . 3 1 6
1 . 8 0 0 0 . 0 0 2 1 . 3 4 0 5 0 . 4 1 5 0 . 3 1 9
2 . 0 0 0 0 . 0 0 2 1 . 4 2 5 5 9 . 8 3 2 0 . 3 2 2
2 . 2 0 0 0 . 0 0 2 1 . 5 0 5 6 9 . 8 4 3 0 . 3 2 4
2 . 4 0 0 0 . 0 0 2 1 . 5 8 1 8 0 . 4 2 2 0 . 3 2 6
2 . 6 0 0 0 . 0 0 2 1 . 6 5 3 9 1 . 5 5 0 0 . 3 2 7
2 . 8 0 0 0 . 0 0 2 1 . 7 2 2 1 0 3 . 2 0 8 0 . 3 2 9

T a b l e   D e p t h  -  D i s c h a r g e B  =  2 5 . 0 m
W a t e r  D e p t h G r a d i e n t V e l o c i t y D i s c h a r g e F r o u d e  

W D  ( m ) I V  ( m / s ) ( m ^ 3 / s ) N u m b e r
1 . 0 0 0 0 . 0 1 0 2 . 1 2 7 5 4 . 2 3 2 0 . 6 7 9
1 . 2 0 0 0 . 0 1 0 2 . 3 8 2 7 3 . 1 7 2 0 . 6 9 5
1 . 4 0 0 0 . 0 1 0 2 . 6 1 8 9 4 . 2 1 2 0 . 7 0 7
1 . 6 0 0 0 . 0 1 0 2 . 8 4 0 1 1 7 . 2 2 0 0 . 7 1 7
1 . 8 0 0 0 . 0 1 0 3 . 0 4 8 1 4 2 . 0 8 9 0 . 7 2 6
2 . 0 0 0 0 . 0 1 0 3 . 2 4 5 1 6 8 . 7 2 7 0 . 7 3 3
2 . 2 0 0 0 . 0 1 0 3 . 4 3 2 1 9 7 . 0 5 7 0 . 7 3 9
2 . 4 0 0 0 . 0 1 0 3 . 6 1 0 2 2 7 . 0 1 0 0 . 7 4 4
2 . 6 0 0 0 . 0 1 0 3 . 7 8 1 2 5 8 . 5 2 7 0 . 7 4 9
2 . 8 0 0 0 . 0 1 0 3 . 9 4 4 2 9 1 . 5 5 6 0 . 7 5 3
1 . 0 0 0 0 . 0 0 5 1 . 5 0 4 3 8 . 3 4 8 0 . 4 8 0
1 . 2 0 0 0 . 0 0 5 1 . 6 8 4 5 1 . 7 4 0 0 . 4 9 1
1 . 4 0 0 0 . 0 0 5 1 . 8 5 2 6 6 . 6 1 8 0 . 5 0 0
1 . 6 0 0 0 . 0 0 5 2 . 0 0 8 8 2 . 8 8 7 0 . 5 0 7
1 . 8 0 0 0 . 0 0 5 2 . 1 5 5 1 0 0 . 4 7 2 0 . 5 1 3
2 . 0 0 0 0 . 0 0 5 2 . 2 9 4 1 1 9 . 3 0 8 0 . 5 1 8
2 . 2 0 0 0 . 0 0 5 2 . 4 2 7 1 3 9 . 3 4 0 0 . 5 2 3
2 . 4 0 0 0 . 0 0 5 2 . 5 5 3 1 6 0 . 5 2 0 0 . 5 2 6
2 . 6 0 0 0 . 0 0 5 2 . 6 7 3 1 8 2 . 8 0 6 0 . 5 3 0
2 . 8 0 0 0 . 0 0 5 2 . 7 9 0 2 0 6 . 1 6 1 0 . 5 3 3
1 . 0 0 0 0 . 0 0 3 1 . 2 2 8 3 1 . 3 1 1 0 . 3 9 2
1 . 2 0 0 0 . 0 0 3 1 . 3 7 5 4 2 . 2 4 6 0 . 4 0 1
1 . 4 0 0 0 . 0 0 3 1 . 5 1 2 5 4 . 3 9 3 0 . 4 0 8
1 . 6 0 0 0 . 0 0 3 1 . 6 4 0 6 7 . 6 7 7 0 . 4 1 4
1 . 8 0 0 0 . 0 0 3 1 . 7 6 0 8 2 . 0 3 5 0 . 4 1 9
2 . 0 0 0 0 . 0 0 3 1 . 8 7 3 9 7 . 4 1 5 0 . 4 2 3
2 . 2 0 0 0 . 0 0 3 1 . 9 8 1 1 1 3 . 7 7 1 0 . 4 2 7
2 . 4 0 0 0 . 0 0 3 2 . 0 8 4 1 3 1 . 0 6 4 0 . 4 3 0
2 . 6 0 0 0 . 0 0 3 2 . 1 8 3 1 4 9 . 2 6 1 0 . 4 3 2
2 . 8 0 0 0 . 0 0 3 2 . 2 7 7 1 6 8 . 3 3 0 0 . 4 3 5
1 . 0 0 0 0 . 0 0 2 0 . 9 5 1 2 4 . 2 5 3 0 . 3 0 4
1 . 2 0 0 0 . 0 0 2 1 . 0 6 5 3 2 . 7 2 4 0 . 3 1 1
1 . 4 0 0 0 . 0 0 2 1 . 1 7 1 4 2 . 1 3 3 0 . 3 1 6
1 . 6 0 0 0 . 0 0 2 1 . 2 7 0 5 2 . 4 2 2 0 . 3 2 1
1 . 8 0 0 0 . 0 0 2 1 . 3 6 3 6 3 . 5 4 4 0 . 3 2 5
2 . 0 0 0 0 . 0 0 2 1 . 4 5 1 7 5 . 4 5 7 0 . 3 2 8
2 . 2 0 0 0 . 0 0 2 1 . 5 3 5 8 8 . 1 2 7 0 . 3 3 1
2 . 4 0 0 0 . 0 0 2 1 . 6 1 5 1 0 1 . 5 2 2 0 . 3 3 3
2 . 6 0 0 0 . 0 0 2 1 . 6 9 1 1 1 5 . 6 1 7 0 . 3 3 5
2 . 8 0 0 0 . 0 0 2 1 . 7 6 4 1 3 0 . 3 8 8 0 . 3 3 7
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Table 2-5 Referential Hydraulic Analysis Results of Perfect Over-flow at a Weir 

 

2)  Main Weir  

Main weir should be made of concrete or stone masonry with mortar. The foundation should have 
enough bearing capacity and be impervious. The sectional shape of main weir body is trapezoid, being 
vertical or close to vertical on the upstream face and with a gentle slope on the downstream face, 
giving some width on the weir crest. Where there is a flow of stones, it may be desirable to make the 
slope of the upstream face gentle and that on the downstream face steep as in case of debris so as to 
protect the weir body from damage due to falling stones. Weir should be laid on sound and stable 
foundation. Surface soil of riverbed such as silt or sand should be removed. Standard cross section of 
main weir is shown in the Figure 2-4 and stability condition shown in Figure 2-5.  

P e r f e c t  O v e r f l o w  D e p t h  a t  t h e  W e i r

Q k 0 b w h 1 A V d 1
8 .5 0 0 1 .7 0 0 5 .0 0 0 1 .0 0 0 3 .4 6 5 2 .4 5 3 0 .6 9 3

1 1 .1 7 4 1 .7 0 0 5 .0 0 0 1 .2 0 0 3 .8 4 0 2 .9 1 0 0 .7 6 8
1 4 .0 8 0 1 .7 0 0 5 .0 0 0 1 .4 0 0 4 .4 8 0 3 .1 4 3 0 .8 9 6
1 7 .2 0 3 1 .7 0 0 5 .0 0 0 1 .6 0 0 5 .5 4 0 3 .1 0 5 1 .1 0 8
2 0 .5 2 7 1 .7 0 0 5 .0 0 0 1 .8 0 0 6 .2 3 5 3 .2 9 2 1 .2 4 7
2 4 .0 4 2 1 .7 0 0 5 .0 0 0 2 .0 0 0 6 .9 3 0 3 .4 6 9 1 .3 8 6
2 7 .7 3 7 1 .7 0 0 5 .0 0 0 2 .2 0 0 7 .6 2 0 3 .6 4 0 1 .5 2 4
3 1 .6 0 4 1 .7 0 0 5 .0 0 0 2 .4 0 0 8 .3 1 5 3 .8 0 1 1 .6 6 3
3 5 .6 3 5 1 .7 0 0 5 .0 0 0 2 .6 0 0 9 .0 0 5 3 .9 5 7 1 .8 0 1
3 9 .8 2 5 1 .7 0 0 5 .0 0 0 2 .8 0 0 9 .7 0 0 4 .1 0 6 1 .9 4 0
1 7 .0 0 0 1 .7 0 0 1 0 .0 0 0 1 .0 0 0 6 .9 3 0 2 .4 5 3 0 .6 9 3
2 2 .3 4 7 1 .7 0 0 1 0 .0 0 0 1 .2 0 0 7 .6 8 0 2 .9 1 0 0 .7 6 8
2 8 .1 6 1 1 .7 0 0 1 0 .0 0 0 1 .4 0 0 8 .9 6 0 3 .1 4 3 0 .8 9 6
3 4 .4 0 6 1 .7 0 0 1 0 .0 0 0 1 .6 0 0 1 1 .0 8 0 3 .1 0 5 1 .1 0 8
4 1 .0 5 4 1 .7 0 0 1 0 .0 0 0 1 .8 0 0 1 2 .4 7 0 3 .2 9 2 1 .2 4 7
4 8 .0 8 3 1 .7 0 0 1 0 .0 0 0 2 .0 0 0 1 3 .8 6 0 3 .4 6 9 1 .3 8 6
5 5 .4 7 3 1 .7 0 0 1 0 .0 0 0 2 .2 0 0 1 5 .2 4 0 3 .6 4 0 1 .5 2 4
6 3 .2 0 7 1 .7 0 0 1 0 .0 0 0 2 .4 0 0 1 6 .6 3 0 3 .8 0 1 1 .6 6 3
7 1 .2 7 0 1 .7 0 0 1 0 .0 0 0 2 .6 0 0 1 8 .0 1 0 3 .9 5 7 1 .8 0 1
7 9 .6 5 0 1 .7 0 0 1 0 .0 0 0 2 .8 0 0 1 9 .4 0 0 4 .1 0 6 1 .9 4 0
2 5 .5 0 0 1 .7 0 0 1 5 .0 0 0 1 .0 0 0 1 0 .3 9 5 2 .4 5 3 0 .6 9 3
3 3 .5 2 1 1 .7 0 0 1 5 .0 0 0 1 .2 0 0 1 1 .5 2 0 2 .9 1 0 0 .7 6 8
4 2 .2 4 1 1 .7 0 0 1 5 .0 0 0 1 .4 0 0 1 3 .4 4 0 3 .1 4 3 0 .8 9 6
5 1 .6 0 8 1 .7 0 0 1 5 .0 0 0 1 .6 0 0 1 6 .6 2 0 3 .1 0 5 1 .1 0 8
6 1 .5 8 1 1 .7 0 0 1 5 .0 0 0 1 .8 0 0 1 8 .7 0 5 3 .2 9 2 1 .2 4 7
7 2 .1 2 5 1 .7 0 0 1 5 .0 0 0 2 .0 0 0 2 0 .7 9 0 3 .4 6 9 1 .3 8 6
8 3 .2 1 0 1 .7 0 0 1 5 .0 0 0 2 .2 0 0 2 2 .8 6 0 3 .6 4 0 1 .5 2 4
9 4 .8 1 1 1 .7 0 0 1 5 .0 0 0 2 .4 0 0 2 4 .9 4 5 3 .8 0 1 1 .6 6 3

1 0 6 .9 0 6 1 .7 0 0 1 5 .0 0 0 2 .6 0 0 2 7 .0 1 5 3 .9 5 7 1 .8 0 1
1 1 9 .4 7 5 1 .7 0 0 1 5 .0 0 0 2 .8 0 0 2 9 .1 0 0 4 .1 0 6 1 .9 4 0

3 4 .0 0 0 1 .7 0 0 2 0 .0 0 0 1 .0 0 0 1 3 .8 6 0 2 .4 5 3 0 .6 9 3
4 4 .6 9 4 1 .7 0 0 2 0 .0 0 0 1 .2 0 0 1 5 .3 6 0 2 .9 1 0 0 .7 6 8
5 6 .3 2 1 1 .7 0 0 2 0 .0 0 0 1 .4 0 0 1 7 .9 2 0 3 .1 4 3 0 .8 9 6
6 8 .8 1 1 1 .7 0 0 2 0 .0 0 0 1 .6 0 0 2 2 .1 6 0 3 .1 0 5 1 .1 0 8
8 2 .1 0 8 1 .7 0 0 2 0 .0 0 0 1 .8 0 0 2 4 .9 4 0 3 .2 9 2 1 .2 4 7
9 6 .1 6 7 1 .7 0 0 2 0 .0 0 0 2 .0 0 0 2 7 .7 2 0 3 .4 6 9 1 .3 8 6

1 1 0 .9 4 6 1 .7 0 0 2 0 .0 0 0 2 .2 0 0 3 0 .4 8 0 3 .6 4 0 1 .5 2 4
1 2 6 .4 1 4 1 .7 0 0 2 0 .0 0 0 2 .4 0 0 3 3 .2 6 0 3 .8 0 1 1 .6 6 3
1 4 2 .5 4 1 1 .7 0 0 2 0 .0 0 0 2 .6 0 0 3 6 .0 2 0 3 .9 5 7 1 .8 0 1
1 5 9 .3 0 0 1 .7 0 0 2 0 .0 0 0 2 .8 0 0 3 8 .8 0 0 4 .1 0 6 1 .9 4 0

4 2 .5 0 0 1 .7 0 0 2 5 .0 0 0 1 .0 0 0 1 7 .3 2 5 2 .4 5 3 0 .6 9 3
5 5 .8 6 8 1 .7 0 0 2 5 .0 0 0 1 .2 0 0 1 9 .2 0 0 2 .9 1 0 0 .7 6 8
7 0 .4 0 1 1 .7 0 0 2 5 .0 0 0 1 .4 0 0 2 2 .4 0 0 3 .1 4 3 0 .8 9 6
8 6 .0 1 4 1 .7 0 0 2 5 .0 0 0 1 .6 0 0 2 7 .7 0 0 3 .1 0 5 1 .1 0 8

1 0 2 .6 3 6 1 .7 0 0 2 5 .0 0 0 1 .8 0 0 3 1 .1 7 5 3 .2 9 2 1 .2 4 7
1 2 0 .2 0 8 1 .7 0 0 2 5 .0 0 0 2 .0 0 0 3 4 .6 5 0 3 .4 6 9 1 .3 8 6
1 3 8 .6 8 3 1 .7 0 0 2 5 .0 0 0 2 .2 0 0 3 8 .1 0 0 3 .6 4 0 1 .5 2 4
1 5 8 .0 1 8 1 .7 0 0 2 5 .0 0 0 2 .4 0 0 4 1 .5 7 5 3 .8 0 1 1 .6 6 3
1 7 8 .1 7 6 1 .7 0 0 2 5 .0 0 0 2 .6 0 0 4 5 .0 2 5 3 .9 5 7 1 .8 0 1
1 9 9 .1 2 5 1 .7 0 0 2 5 .0 0 0 2 .8 0 0 4 8 .5 0 0 4 .1 0 6 1 .9 4 0
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Figure 2-4 Standard Cross-Section of a Main Weir 

a. Stability analysis 

 

 

 

 

 

 

 

 

 

Figure 2-5 Stability Analysis Condition (Main Weir) 

 Pw: Hydrostatic pressure 
     Pw = H2 / 2 (t) 
 Pe: Earth pressure due to sediment 
    Pe = (w – wo) x co x H2 / 2 (t) 

 w: unit weight of deposited silt (1.8 t/m3) 
 wo: unit weight of water (1.0 t/m3) 
 co: coefficient of earth pressure   co = 0.45 
Pd: Downstream resisting pressure against sliding (in case of soil foundation) 
  Pp = 0.5 x La x (2.3 – w0) x α 
       La: length of apron (m) 

     α: coefficient of friction against ground ( refer Table 2-2) 
Wd: Dead weight of weir (t) 

Condition of stability is; 

(i) Safety against overturning 
 e   l/6 
 e = |ΣM / ΣV – l/2| 
 e: Eccentric distance (m) 
 ΣM : total of moments (t . m) 
 ΣV : resultant force of vertical force (t) 

(ii) Safety against sliding 
 Sf = α x ΣV / ΣH 
 α: coefficient of friction against ground ( refer Table 2-2) 
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 Sf: safety factor Sf > 1.5 
 ΣH : resultant force of horizontal force (t) 

(iii) Safety against settlement 
The compressive strength at the bottom should be within the safe bearing capacity of the 
foundation. 

 p = ΣV / A x (1±6 x e / l) 
 p: compressive strength caused at both ends of the bottom (t/m2) 
 A: bottom area (m2) 

Table 2-6 shows the result of sample stability analysis. 

Case-1: Rock foundation, α= 0.7, upstream slope: vertical, downstream slope 1:1.0, In case of weir 
height more than 4.0m, safety factor of sliding is less than 1.5. In this case, providing cut off 
is effective. There is no problem about safeness against overturning and safeness against 
settlement. 

Case-2: Soil foundation, α= 0.45, upstream slope: vertical, downstream slope 1:1.0, Even weir 
height is 1.0 m, safety factor of sliding is less than 1.5. In this case, providing the 
downstream stone masonry apron is effective. 

Case-3: Soil foundation, α = 0.45, upstream slope: vertical, downstream slope 1:1.0, with 
downstream sliding resistance force. In case that the weir height is more than 2.0m, required 
length of apron is very long. 

Case-4: Soil foundation, α= 0.45, upstream slope: 1:0.3, downstream slope 1:1.0, with downstream 
sliding resistance force. In case that the weir height is more than 3.0m, required length of 
apron is very long. 

Case-5: Soil foundation α= 0.45, upstream slope: 1:0.5, downstream slope 1:1.0, with downstream 
sliding resistance force. Making the upstream slope gentle, the length of apron can be 
reduced. 

In all cases, the safety against overturning satisfies required condition. Maximum required 
compressive strength is about 10 t/ m2 and it is smaller than allowable bearing capacity of solid clayey 
soil.   

Table 2-6 Results of Sample Stability Analysis (Weir) 

 

case-1 Stability Analysis of weir α=0.7, Foundation: Rock or semi consolidated clay
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2
m m t t t t t･m t m m t/m^2 t/m^2

1.0 1.100 0.500 0.000 0.180 2.243 1.350 0.680 0.052 0.183 2.308 2.616 1.461
1.5 1.600 1.125 0.000 0.405 4.370 3.724 1.530 0.052 0.267 1.999 3.266 2.196
2.0 2.100 2.000 0.000 0.720 7.073 7.816 2.720 0.055 0.350 1.820 3.899 2.837
2.5 2.600 3.125 0.000 1.125 10.350 14.083 4.250 0.061 0.433 1.705 4.538 3.423
3.0 3.100 4.500 0.000 1.620 14.203 22.983 6.120 0.068 0.517 1.624 5.186 3.976
3.5 3.600 6.125 0.000 2.205 18.630 34.972 8.330 0.077 0.600 1.566 5.841 4.509
4.0 4.100 8.000 0.000 2.880 23.633 50.509 10.880 0.087 0.683 1.520 6.500 5.028
4.5 4.600 10.125 0.000 3.645 29.210 70.051 13.770 0.098 0.767 1.485 7.163 5.537

case-2 Stability Analysis of weir α=0.45, Foundation: Solid Clayey Ground, without downstream horizontal force
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2
m m t t t t t･m t m m t/m^2 t/m^2

1.0 1.100 0.500 0.000 0.180 2.243 1.350 0.680 0.052 0.183 1.484 2.616 1.461
1.5 1.600 1.125 0.000 0.405 4.370 3.724 1.530 0.052 0.267 1.285 3.266 2.196
2.0 2.100 2.000 0.000 0.720 7.073 7.816 2.720 0.055 0.350 1.170 3.899 2.837
2.5 2.600 3.125 0.000 1.125 10.350 14.083 4.250 0.061 0.433 1.096 4.538 3.423
3.0 3.100 4.500 0.000 1.620 14.203 22.983 6.120 0.068 0.517 1.044 5.186 3.976
3.5 3.600 6.125 0.000 2.205 18.630 34.972 8.330 0.077 0.600 1.006 5.841 4.509
4.0 4.100 8.000 0.000 2.880 23.633 50.509 10.880 0.087 0.683 0.977 6.500 5.028
4.5 4.600 10.125 0.000 3.645 29.210 70.051 13.770 0.098 0.767 0.955 7.163 5.537
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3) Apron 

To prevent scouring downstream of the weir by the overflowing water, a downstream apron is 
provided. The length of the apron can be obtained from following formula. (Engineering Manual for 
Irrigation and Drainage Head Works, The Japanese Institute of Irrigation and Drainage 1989). 

L = 0.6 x C x √H 
 Where, L: length of downstream apron (m) 

C: Bligh’s C, coefficient which varies depending on the type of the foundation.    
(Table 2-7) 

       H: Height of the weir from downstream riverbed (m) 

Table 2-7 Coefficients for Blighs’ Method and Lanes’ Method 

Foundation Bligh’s coefficient C Lane’s coefficient C’ 
Silty sand or silt 
Fine sand 
Medium sand 
Coarse sand 
Gravel 
Coarse gravel 
Sandy gravel 
Cobble stone with gravel 
Rocks with cobble stone and gravel 
Rocks with gravel and sand 
Soft clay 
Medium clay 
Heavy clay 
Hard clay 

18 
15 
- 

12 
- 
- 
9 
- 
- 

4 – 6 
- 
- 
- 
- 

8.5 
7.0 
6.0 
5.0 
4.0 
3.5 
- 

3.0 
2.5 
- 

3.0 
2.0 
1.8 
1.6 

case-3 Stability Analysis of weir α=0.45, Foundation: Solid Clayey Ground, with downstream horizontal resisting force
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2 La
m m t t t t t･m t m m t/m^2 t/m^2 m

1.0 1.100 0.500 0.146 0.180 2.243 1.350 0.534 0.052 0.183 1.891 2.616 1.461 0.500
1.5 1.600 1.125 0.293 0.405 4.370 3.724 1.238 0.052 0.267 1.589 3.266 2.196 1.000
2.0 2.100 2.000 0.731 0.720 7.073 7.816 1.989 0.055 0.350 1.600 3.899 2.837 2.500
2.5 2.600 3.125 1.170 1.125 10.350 14.083 3.080 0.061 0.433 1.512 4.538 3.423 4.000
3.0 3.100 4.500 1.901 1.620 14.203 22.983 4.219 0.068 0.517 1.515 5.186 3.976 6.500
3.5 3.600 6.125 2.779 2.205 18.630 34.972 5.551 0.077 0.600 1.510 5.841 4.509 9.500
4.0 4.100 8.000 3.803 2.880 23.633 50.509 7.078 0.087 0.683 1.503 6.500 5.028 13.000
4.5 4.600 10.125 5.119 3.645 29.210 70.051 8.651 0.098 0.767 1.519 7.163 5.537 17.500

case-4 Stability Analysis of weir α=0.45, Foundation: Solid Clayey Ground, with downstream horizontal resisting force, upstream slope 1:0.3
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2 La
m m t t t t t･m t m m t/m^2 t/m^2 m

1.0 1.250 0.500 0.000 0.180 2.501 1.708 0.680 0.058 0.208 1.655 2.556 1.446 0.000
1.5 1.900 1.125 0.146 0.405 5.060 5.156 1.384 0.069 0.317 1.646 3.243 2.083 0.500
2.0 2.550 2.000 0.293 0.720 8.366 11.348 2.428 0.081 0.425 1.551 3.910 2.652 1.000
2.5 3.200 3.125 0.585 1.125 12.420 21.052 3.665 0.095 0.533 1.525 4.573 3.190 2.000
3.0 3.850 4.500 1.024 1.620 17.221 35.036 5.096 0.109 0.642 1.521 5.236 3.710 3.500
3.5 4.500 6.125 1.609 2.205 22.770 54.068 6.721 0.125 0.750 1.524 5.900 4.220 5.500
4.0 5.150 8.000 2.194 2.880 29.066 78.916 8.686 0.140 0.858 1.506 6.565 4.723 7.500
4.5 5.800 10.125 3.071 3.645 36.110 110.347 10.699 0.156 0.967 1.519 7.230 5.222 10.500

case-5 Stability Analysis of weir α=0.45, Foundation: Solid Clayey Ground, with downstream horizontal resisting force, upstream slope 1:0.5
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2 La
m m t t t t t･m t m m t/m^2 t/m^2 m

1.0 1.350 0.500 0.000 0.180 2.674 1.994 0.680 0.071 0.225 1.769 2.605 1.357 0.000
1.5 2.100 1.125 0.000 0.405 5.520 6.436 1.530 0.116 0.350 1.624 3.500 1.757 0.000
2.0 2.850 2.000 0.000 0.720 9.229 14.738 2.720 0.172 0.475 1.527 4.410 2.066 0.000
2.5 3.600 3.125 0.146 1.125 13.800 28.075 4.104 0.234 0.600 1.569 5.331 2.336 0.500
3.0 4.350 4.500 0.293 1.620 19.234 47.624 5.828 0.301 0.725 1.564 6.258 2.585 1.000
3.5 5.100 6.125 0.439 2.205 25.530 74.561 7.891 0.371 0.850 1.542 7.188 2.824 1.500
4.0 5.850 8.000 0.585 2.880 32.689 110.063 10.295 0.442 0.975 1.515 8.121 3.055 2.000
4.5 6.600 10.125 0.878 3.645 40.710 155.305 12.893 0.515 1.100 1.525 9.055 3.281 3.000
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Table 2-8 below contains computed lengths of aprons for different weir heights and soil conditions, 
with C for medium clay assumed at 5.0. 

Table 2-8 Required Length of Apron 

 Required length of apron (m) 
Height of weir 

(m) 
Silty sand or silt Fine sand Coarse sand Medium clay 

1.0 7.7 6.4 5.1 2.2 
1.5 10.8 9.0 7.2 3.0 
2.0 13.3 11.1 8.9 3.7 
2.5 15.3 12.8 10.2 4.3 
3.0 17.1 14.3 11.4 4.8 
3.5 18.8 15.6 12.5 5.2 
4.0 20.3 16.9 13.5 5.7 
4.5 21.6 18.0 13.4 6.0 

4) Riverbed Protection and Slope Protection 

Riverbed protection work is provided continuously to the apron to prevent scouring. Riverbed 
protection work prevent scour by reducing the energy of the high velocity flow that passes the weir 
gradually using the resistance of riverbed protection, making the flow velocity the same as that of 
downstream river following the riverbed protection.  

The material of riverbed protection work should be gabions. Recommended length of riverbed 
protection work should be obtained from following Bligh’s formula. Slope protection of both sides 
should be the same length and same material as apron and riverbed protection. 

La = L – Lb 
L = 0.67 x C x √ (H x q) x f 

 La: Length of apron 
Lb: length of riverbed protection (m) 

 L: total length of protection including length of apron la (m) 
 H: height of the weir from downstream riverbed. 
 q: flow quantity per unit width of design flood discharge (m3/sec/m) 
 f: safety factor, 1.5 in case of movable weir, 1.0 in case of fixed weir 
 C: Bligh’s coefficient 
 Generally, q = 2.0 to 8.0 in medium scale irrigation scheme. 

From above 1) ~ 2), recommended dimensions of weir are shown in the Table 2-9. 

Table 2-9 Standard Dimensions of Weir 

a. Rock Foundation 

Height of weir  
(m) 

Upstream surface 
slope 

Downstream 
surface slope 

Length of 
apron (m) 

Length of 
riverbed 

protection 
(m) 

Remarks 

1.0 Vertical 1:1.0 0 0  
1.5 Vertical 1:1.0 0 0  
2.0 Vertical 1:1.0 0 0  
2.5 Vertical 1:1.0 0 0  
3.0 Vertical 1:1.0 0 0  
3.5 Vertical 1:1.0 0 0  
4.0 Vertical 1:1.0 0 0  
4.5 Vertical 1:1.0 0 0 Provide cut off
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b. Soil Foundation 

Height of weir  
(m) 

Upstream surface 
slope 

Downstream 
surface slope 

Length of 
apron , La 

(m) 

Length of 
riverbed 

protection 
(m) 

Remarks 

1.0 Vertical 1:1.0 2.5 Lb  
1.5 Vertical 1:1.0 3.0 Lb  
2.0 Vertical 1:1.0 4.0 Lb  
2.5 1:0.3 1:1.0 4.5 Lb  
3.0 1:0.3 1:1.0 5.0 Lb  
3.5 1:0.3 1:1.0 5.5 Lb  
4.0 1:0.5 1:1.0 6.0 Lb  
4.5 1:0.5 1:1.0 6.0 Lb  

In case of rehabilitation of existing weir, the dimensions of the weir, apron and riverbed protection should 
be modified to meet above table. 

 

5) Intake 

The intake should function to make sure that intake design discharge from a river and transfer the flow 
to the irrigation canal. Generally discharges in rivers are subject to change and at the time of flood, 
huge amount of soil, sand and floating debris materials are carried by the river flow. Therefore, intake 
requires such as easy control of intake discharge and prevention of the materials carried from flowing 
into the canal. The intake is opened in the dry season and closed in the rainy season.  

It is desirable to set the intake elevation higher than the riverbed elevation at least 0.5m to prevent soil 
and sand flowing into the canal. 

The material of intake should be stone masonry. The sectional shape of intake body is trapezoid, being 
vertical on the upstream face and with a gentle slope on the downstream face. The crest elevation 
should be more than 0.6m higher than design flood water elevation. Pipes should also be installed at 
the elevation of 20cm from the canal bed. Upstream and downstream 1.0m, each section should be 
stone masonry lined to prevent scouring. Standard cross section of intake is shown in the Figure 2-6 
and stability Analysis condition is shown in Figure 2-7. 

 

Figure 2-6 Standard Cross Section of Intake 
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a. Stability analysis 

 

 

 

 

 

 

 

 

 

Figure 2-7 Stability Analysis Condition (Intake) 

 

b. Capacity of pipe  

Pipes are installed in the intake structure to convey water to canal. The water flow capacity of pipe is 
shown in the Table 2-10 below; 

Table 2-10 Maximum Pipe Flow Quantity of Uniform Flow 

Pipe Diameter (Nom. Size) Gradient 1/300 Gradient 1/500 
φ 100 3.9 lit/s 3.1 lit/s 
φ 125 6.7 lit/s 5.2 lit/s 
φ 150 9.6 lit/s 7.5 lit/s 
φ 200 24.4 lit/s 18.9 lit/s 
φ 225 32.3 lit/s 25.1 lit/s 
φ 450 177 lit/s 137 lit/s 

In case of φ140 and φ200, it is recommended to install two pipes to control flow quantity. During wet 
season, pipes should be blocked with plastic paper or sacks.  

Table 2-11 shows the result of stability analysis.  

Case-1: Rock foundation, α= 0.7, upstream slope: vertical, downstream slope 1:1.0, Eccentric 
distance is less than l/6. Safety factor of sliding is more than 1.5. Maximum compressive 
strength is 5.9 t/ m2. 

Case-2: Soil foundation, α= 0.45, upstream slope: vertical, downstream slope 1:1.0, In case that the 
height is more than 4.3m, safety factor of sliding is less than 1.5. In this case, providing cut 
off is effective. 
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Table 2-11 Stability Analysis of Intake 

 

6) Cutout 

There are situations that a weir can be over flowed by surplus water even in the dry season. However, 
since most of weirs are used as a path to cross the river in the dry season, cutout is made to let surplus 
water to flow and so the top of the weir can be passed. The width of the top of the weir should be 0.6m. 
Arrangement of cut-out is shown in Figure 2-8, and the water flow capacity in Table 2-12 below.  

 

 

 

 

 

Figure 2-8 Cut-out Dimension Points of Weirs (Example) 

 

Table 2-12 Water Flow Capacity of Cut-out 
Bottom width (m) Top width (m) Depth (m) Flow quantity (m3/s) 

0.5 0.7 0.2 0.15 
0.6 0.8 0.2 0.18 
0.7 0.9 0.2 0.21 
0.8 1.0 0.2 0.24 

(4) Rehabilitation plan 

Rehabilitation plan should be made based on investigation result. From the investigation results, 
rehabilitation items are studied and rehabilitation work planned. Rehabilitation work should be 
planned to make the dam and facilities functional and safe to meet the condition and standard 
described in this guideline. 

0.7m~1.0m 1.5m~2.0m 0.7m~1.0m   

0.2m 0.5m~0.8m 

case-1 Stability Analysis of intake α=0.7, Foundation: Rock or semi consolidated clay
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2
m m t t t t t･m t m m t/m^2 t/m^2

1.0 1.600 0.180 0.000 0.000 2.208 2.112 0.180 0.157 0.267 8.587 2.190 0.570
1.5 2.100 0.605 0.000 0.000 4.106 4.703 0.605 0.096 0.350 4.750 2.489 1.421
2.0 2.600 1.280 0.000 0.000 6.578 8.892 1.280 0.052 0.433 3.597 2.832 2.228
2.5 3.100 2.205 0.000 0.000 9.626 15.091 2.205 0.018 0.517 3.056 3.212 2.998
3.0 3.600 3.380 0.000 0.000 13.248 23.712 3.380 0.010 0.600 2.744 3.618 3.742
3.5 4.100 4.805 0.000 0.000 17.446 35.168 4.805 0.034 0.683 2.541 4.043 4.467
4.0 4.600 6.480 0.000 0.000 22.218 49.872 6.480 0.055 0.767 2.400 4.481 5.179
4.5 5.100 8.405 0.000 0.000 27.566 68.236 8.405 0.075 0.850 2.296 4.931 5.879

case-2 Stability Analysis of intake α=0.45, Foundation: Solid Clayey Ground
H L Pw Pd Pe ΣV ΣM ΣH e l/6 Sf p1 p2
m m t t t t t･m t m m t/m^2 t/m^2

1.0 1.600 0.180 0.000 0.000 2.208 2.112 0.180 0.157 0.267 5.520 2.190 0.570
1.5 2.100 0.605 0.000 0.000 4.106 4.703 0.605 0.096 0.350 3.054 2.489 1.421
2.0 2.600 1.280 0.000 0.000 6.578 8.892 1.280 0.052 0.433 2.313 2.832 2.228
2.5 3.100 2.205 0.000 0.000 9.626 15.091 2.205 0.018 0.517 1.964 3.212 2.998
3.0 3.600 3.380 0.000 0.000 13.248 23.712 3.380 0.010 0.600 1.764 3.618 3.742
3.5 4.100 4.805 0.000 0.000 17.446 35.168 4.805 0.034 0.683 1.634 4.043 4.467
4.0 4.600 6.480 0.000 0.000 22.218 49.872 6.480 0.055 0.767 1.543 4.481 5.179
4.3 4.900 7.605 0.000 0.000 25.358 60.425 7.605 0.067 0.817 1.500 4.750 5.600
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2.2 Water Impounding Dam 

Water impounding dam is a structure in which water is saved by constructing a small 
dam/embankment at a stream. In Malawi, many of small-scale dam do not have an outlet and the 
farmers irrigate their farmland around the pond with watering can or treadle pump. This is also 
sometimes observed in Dimba farming, downstream of the pond. Only a few dam with outlet irrigate 
downstream area by gravity. Generally, available amount of water of the pond is limited and irrigable 
area should be decided carefully. 

(1) Rehabilitation/Construction Criteria 

Main items for rehabilitation and construction are embankment, spillway and outlet. Some dams have 
outlet and discharge pipes. 

1) Material  

Most of materials for the work should be procured locally and input from outside should be minimized. 
Locally available materials include; sand, stone, bricks, soil. Cement, gabion, tools are input from 
outside.  

2) Labor  

The work should be done by the farmers under supervision of AEDOs and IOs. Labor force is 
provided by the farmers association. Only transportation for materials (if necessary) might need 
assistance from outside. 

(2) Investigation 

Field investigations are carried out at and around the site on necessary items for design, construction, 
rehabilitation and O&M. Prior to the investigations selecting necessary items for investigation, the 
appropriate investigation plan should be put in practice. 

1) Meteorological and hydrological investigations 

Meteorological and hydrological conditions of the site should be investigated through data collection 
and observation. Items for meteorological and hydrological investigation include; temperature, 
precipitation, evaporation, wind direction, wind velocity and river discharge. These data are relevant in 
determination of dam scale, design flood discharge, design of dam body, outlet and intake facilities 
and formulation of construction planning. 

2) Investigation of river conditions 

This investigation is performed to clarify the present river conditions. Investigation items include 
discharge, water temperature, water quality, riverbed conditions etc. These data are the basis for 
investigation of the following items. 

i) Volume and configuration of sediment (discharge and river bed conditions) 
ii) Back water upstream of the pond and sediment (river bed conditions) 
iii) Outlet type 

3) Topographic investigations 

Topography of the pond and surrounding area should be clarified through data collection and 
topographic survey. Topographic investigations are important to determine storage capacity and main 
features of the dam. 

i) Pond and surroundings 
Topographic survey covering an adequately wide area around the pond should be carried out 
for the determination of storage capacity, arrangement of dam related facilities, plan of access 
road and borrow area. 
ii) Dam and surroundings 
Topographic survey at the dam site should be executed in the required area with sufficient 

21



 
 

Final Report, Annex 1 Technical Guidelines August 2009 

  

accuracy to allow proper design of spillway, intake facilities and other appurtenant facilities, 
and also to calculate quantities of embanking, excavation and backfilling. This survey should 
also include longitudinal and cross sectional maps. 

4) Geological investigation 

Geological conditions of the pond and surrounding area including the dam site and borrow area also 
need to be clarified through data collection, field survey and observation. 

i) Data collection and study 
Existing data should be collected and studied. Necessary data and items to be studied are 
topographic map and aerial photographs, geological map, soil texture map and soil map. 
ii) Surface geological survey 
Data obtained through surface geological survey should include topography, geological 
structure, hydrogeology etc. Based on these data, possible landslide zones, existence of 
pervious foundation, distribution of materials and locations of fault and fractured zones are 
studied and the most adequate dam site is selected. Earth covering, soil properties, rock type, 
weathering conditions and depth of rocks can be estimated. 
iii) Subsurface geological survey 
This survey aims at classifying foundation ground at dam sites on the bases of engineering 
properties of the same such as geological conditions (lithologic character, fracture, etc.), 
physical, mechanical and hydraulic properties and presenting concrete data for determination 
of dam type and foundation improvement. In this medium scale irrigation project, since the 
height of water impounding dam is not high (generally less than 15m), subsurface geological 
survey are not be required. 

5) Investigation for construction works 

Investigation for construction works should be conducted on the following items, which are necessary 
for construction planning. 

i) Meteorology, surface water, ground water, riverbed conditions 
Meteorology and surface water should be thoroughly investigated because of their utmost 
importance for deciding the construction schedule. Based on the investigation on annual 
rainfall and river run off, channels, elevation of cofferdam, etc. should be determined. 
Especially, temperature is important for work plan of concrete (mortar) works. No concrete 
(mortar) should be mixed or placed when the shade air temperature reached thirty-five degrees 
centigrade (35°C) or more. 
ii) Construction equipment and materials 
Construction materials include cement, soil, sand, gravel, stone, steel materials, bricks and 
timber etc. The supply situation of materials should be checked. Availability of local materials, 
necessity of transportation, availability of transportation and availability of tools should be 
checked. Transportation of materials should be arranged if necessary. Minimum use of 
construction equipment is encouraged for medium scale irrigation schemes basically. Number 
of skilled labor and unskilled labor should be checked. 

6) Investigation for Rehabilitation of Existing Dam 

In case of rehabilitation of existing dam, following items should be investigated in addition to above 
items. (Refer to Table 2-13) 

i) Present condition of existing dam 
ii) Topographical survey for rehabilitation items 
iii) Data on water use management of existing dam 
iv) Operation and maintenance system of existing dam 
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Table 2-13 List of Items to be Investigated (Water Impounding Dam) 
Items Description Method Outputs 

1. Meteorological and 
hydrological 
investigations 

 
 
 

- Collection of 
meteorological and 
hydrological data 
 
 
 

- Data collection and site 
observation 
 
 
 
 

- Annual rainfall, 
temperature, wind 
direction, wind velocity, 
river discharge, 
evaporation, other dams’ 
data 

2. River conditions 
(i) Water level and 
discharge 
 
 
 
 
(ii) Sedimentation 
 
(iii) Riverbed slope 
 
 
 
(iv) Riverbed materials 
 
(v) River Utilisation 

 
- Highest water level 
 
 
- Representative water 
level and flow velocity in 
each month 
- Sediment at a structure 
of vicinity area 
- Riverbed slope 
 
 
 
- Materials and 
conditions of the river 
- Water rights 

 
- Observation of past 
flood mark and 
interview to the villagers
- Observation at the 
river 
 
- Observation of 
sediment configuration. 
- Surveying. 20m 
interval, from 100m 
upstream to 100m 
downstream. 
- Visual observation at 
the river 
- Interview to relevant 
party 

 
HWL= 
 
 
WL= 
 
 
Stones, sand or silt 
 
Riverbed slope = 
 
 
 
Estimated roughness 
coefficient= 
Quantity =    lit/s   
Water fee =     MK 

3. Topographic 
investigations 
(i) Pond and 
surroundings 
 
 
 
 
(ii) Dam and 
surroundings 
 
 
 
 
 
 
 
 
(iii) Collection of 
topographic and other 
related maps. 

 
 
- Shape of the pond, 
centerline of the dam, 
location of spillway, 
intake, cofferdam, 
stockyard, contour line 
etc. should be indicated. 
- Longitudinal section of 
the dam center. 
 
- Cross section of the 
along dam centerline. 
- Longitudinal section of 
the spillway. 
- Cross section of the 
along the spillway 
centerline. 
- Available maps around 
the scheme 

 
 
- Site surveying with 
measuring tape and 
compass. Plane table. 
Site surveying with 
measuring tape and level
 
- Site surveying with 
measuring tape and 
level. 
ditto 
 
ditto 
 
ditto 
 
 
Data collection 
 

 
 
Plan: scale 
1/1000~1/2000 
 
 
 
 
- Longitudinal section: 
scale 1/200~1/500 
Cross section: scale 1/50 
 
 
 
 
 
 
 
Various maps 
 

4. Geological 
investigation 
(i) Data collection  
 
 
 
(ii) Surface geological 
survey 
 

 
 
- Collection of existing 
geological data 
 
 
- Location of the dam, 
design conditions 

 
 
- Data collection  
 
 
 
- Site surveying 
 
 

 
 
- Topographic map, aerial 
photographs, geological 
map, soil texture, soil 
map 
- Location of possible 
land slide zones, pervious 
foundation, fault, 
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  fractured zones. 
Distribution of materials, 
earth covering, soil 
properties, rock type, 
weathering conditions, 
depth of rocks 

5. Construction works 
(i) Meteorology 
 
 
 
(ii) Construction 
equipment, materials, 
transportation 
 
 
 

 
- Collection of  all 
existing meteorological 
data 
 
- Availability of materials 
 
- Number of available 
tools  
 
- Available transportation 
- Number of available 
labor 

 
- Data collection and site 
observation 
 
 
- Soil, Stones, Sand, 
Cement 
- Wheelbarrow, Bucket, 
Shovel, Pickaxe, 
Trowel, Others 
- Truck, tractor, oxcart 
- Skilled labor, 
Unskilled labor 

 
Annual rainfall, 
Stream condition, 
temperature, water level 
Height of cofferdam = 
= km from the site,  
= to be procured in    
= units, = pcs, 
 
 
DAO, DA, ADD 
Farmers, = number 

6. Rehabilitation of 
existing dam 
(i) Present condition of 
existing dam 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(ii) Topographical survey 
for rehabilitation items 
 
 
 
 
(iii) Data on water use 
management of existing 
dam 
(iv) Operation and 
maintenance system of 
existing dam 

 
 
- Crack at embankment   
 
 
- Erosion of embankment 
- Collapse/deformation  
of embankment 
- Seepage at downstream  
 
- Damage of structures 
- Freeboard 
- Function, capacity of 
spillway 
- Function, capacity of 
intake 
- Sediment 
- Safety 
- Longitudinal section of 
the structures to be 
rehabilitated. 
- Cross section of the 
structures to be 
rehabilitated. 
- Discharge for outlet 
 
 
- Operation and 
maintenance 
 

 
 
- Site investigation, 
observation, measuring 
tape. 
- ditto 
- ditto 
 
- ditto 
 
- ditto 
- ditto 
- ditto 
 
- ditto 
 
- ditto 
- ditto 
- Site surveying with 
measuring tape and 
compass. Plane table. 
 
 
 
- Daily operation record 
of outlet. 
 
-Operation and 
maintenance record 

 
 
Length= m, width= cm 
 
 
Length= m, width= m 
Length= m, width= m 
 
Location, quantity= 
lit/min 
Location, situation 
Fb= m 
Enough or not 
 
Enough or not 
 
Configuration and depth 
Good or bad 
- Longitudinal section: 
scale 1/200~1/500 
Cross section: scale 1/50 
 
 
 
- Daily discharge for the 
canal. 
 
- Operation and 
maintenance record. 

 

(3) Rehabilitation/Construction Planning/Design 

1) General Layout 

General layout of water impounding dam type irrigation scheme is shown in Figure 2-9. 
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Figure 2-9 General Lay-out for Water Impounding Dam Type 

 

2) Design flood discharge and design flood water level 

a) Design flood discharge 
Design flood discharge should be the maximum value of experienced flood discharge or 
regional maximum flood discharge. 
Design flood discharge is estimated as same as 2.1 (3) 3) a. 
b) Design flood water level 
Design high water level at spillway.  

3) Embankment 

Embankment and foundation should have enough water tightness and strength, and be safe against 
sliding failure or seepage failure. 

Standard cross section of the dam should be as follows; 

Upstream Slope: 1:1.5 (in case that the dam height is less than 5.0m) 
1:2.0 (in case that the dam height is more than 5.0m) 

Downstream slope: 1:1.5 (in case that the dam height is less than 5.0m) 
1:2.0 (in case that the dam height is more than 5.0m) 

Crest width: minimum 3.0m 
Crest elevation: 1.0m higher than flood water level 

 Berm: width 1.0m at every 5.0m height 
 Slope protection: vegetation 

A standard Cross section of a dam is shown in Figure 2-10. 
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  HWL: High Water Level (Flood Water Level) 
  FWL: Full Water Level (Crest level of the spillway) 

Figure 2-10 Standard Cross Section of a Dam 

4) Spillway 

The spillway structure should be designed to ensure the safe release of a maximum flow equivalent to 
the design flood discharge. The spillway structure must be carefully determined so as not to produce 
adverse effects on the dam body, foundation and reservoir. 

The water velocity of spillway channel should be very high due to steep slope. Energy dissipation 
section should be set at the end of spillway channel connecting to existing river. 

Concrete or stone masonry with mortar is preferable for the material for spillway due to its solidness 
and durability.  

Freeboard of spillway downstream channel should be not less than 0.6m. Channel bed width should 
not be less than 1.0 m considering maintenance. In case of the wall height exceeds 1.0m, weep holes 
should be installed at the middle height of the wall and 1.5 m interval in the wall of downstream 
channel. Weep holes should be 50 mm diameter PVC pipe. 

Figure 2-10 shows the general longitudinal section of a spillway. Table 2-14~Table 2-18 show 
hydraulic analyses of Inlet Channel (both Open Canal and Pipe Culvert) and Spillway Channels.  

HWL. 

3.0m 

1.0m 

1.0m 

S = 1:1.5(2.0) 

drain ditch 
0.2m x 0.2m 

5.0m
 

vegetation 

FWL. 
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Table 2-14 Head at Inlet Channel (Open Canal) 

F > 1.0m
critical depth

Discharge Channel width Water Depth Velocity Head Freeboard Channel Depth
(m^3/s) B (m) WD (m) V (m/s) (m) F (m) CD (m)

1.000 1.000 0.433 1.898 0.617 1.083 1.700
1.500 0.343 1.745 0.498 1.002 1.500
2.000 0.287 1.624 0.422 1.078 1.500

5.000 1.500 0.934 2.720 1.311 1.089 2.400
2.000 0.802 2.596 1.146 1.054 2.200
2.500 0.706 2.482 1.020 1.080 2.100
3.000 0.633 2.380 0.922 1.078 2.000
3.500 0.576 2.291 0.844 1.056 1.900

10.000 4.000 0.830 2.727 1.209 1.091 2.300
5.000 0.724 2.577 1.063 1.037 2.100
6.000 0.645 2.452 0.952 1.048 2.000
7.000 0.584 2.347 0.865 1.035 1.900
8.000 0.536 2.256 0.796 1.004 1.800

15.000 6.000 0.840 2.780 1.234 1.066 2.300
7.000 0.762 2.665 1.124 1.076 2.200
8.000 0.700 2.566 1.036 1.064 2.100
9.000 0.649 2.479 0.963 1.037 2.000

10.000 0.606 2.402 0.900 1.000 1.900
20.000 9.000 0.784 2.716 1.160 1.040 2.200

10.000 0.733 2.633 1.087 1.013 2.100
11.000 0.689 2.560 1.023 1.077 2.100
12.000 0.651 2.493 0.968 1.032 2.000
14.000 0.589 2.377 0.877 1.023 1.900

30.000 14.000 0.770 2.710 1.145 1.055 2.200
16.000 0.705 2.601 1.050 1.050 2.100
18.000 0.653 2.507 0.974 1.026 2.000
20.000 0.609 2.425 0.909 1.091 2.000
22.000 0.572 2.353 0.854 1.046 1.900

40.000 18.000 0.790 2.753 1.177 1.023 2.200
20.000 0.737 2.664 1.099 1.001 2.100
22.000 0.692 2.585 1.033 1.067 2.100
24.000 0.654 2.515 0.977 1.023 2.000
26.000 0.620 2.451 0.927 1.073 2.000

50.000 24.000 0.758 2.705 1.131 1.069 2.200
26.000 0.719 2.637 1.074 1.026 2.100
28.000 0.685 2.575 1.023 1.077 2.100
30.000 0.654 2.519 0.978 1.022 2.000
32.000 0.627 2.467 0.938 1.062 2.000

width B

C
D

1.0

2
.0

W
D

F

H
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Table 2-15 Head at Inlet Channel (Pipe Culvert) 

B = D x n + (n + 1.0) x 0.5 (m) 
D: diameter of culvert 
n: number of pipe culvert 

 

 

Table 2-16 Critical Depth of Spillway Downstream Channel 

 

F  >  1 .0 m

c r it ic a l d e p th  o f p ip e  c u lv e r t
D is c h a rg e D ia m e te r W a te r  D e p th V e lo c it y H e a d F re e b o a rd C h a n n e l D e p th

(m ^ 3 / s )/ p ip e D  (m ) W D  (m ) V  (m / s ) H  (m ) F  (m ) C D  (m )
0 .2 0 0 0 .6 0 0 0 .2 8 9 1 .4 8 4 0 .4 0 1 1 .0 9 9 1 .5 0 0
0 .4 0 0 0 .6 0 0 0 .4 1 5 1 .9 1 9 0 .6 0 3 1 .0 9 7 1 .7 0 0
0 .6 0 0 0 .6 0 0 0 .5 0 3 2 .3 7 0 0 .7 9 0 1 .0 1 0 1 .8 0 0
0 .8 0 0 0 .6 0 0 0 .5 5 6 2 .9 2 6 0 .9 9 3 1 .0 0 7 2 .0 0 0
1 .0 0 0 0 .6 0 0 0 .5 8 0 3 .5 7 3 1 .2 3 1 1 .0 6 9 2 .3 0 0

0 .2 0 0 0 .9 0 0 0 .2 5 6 1 .3 4 1 0 .3 4 8 1 .0 5 2 1 .4 0 0
0 .4 0 0 0 .9 0 0 0 .3 6 7 1 .6 4 3 0 .5 0 5 1 .0 9 5 1 .6 0 0
0 .6 0 0 0 .9 0 0 0 .4 5 3 1 .8 6 9 0 .6 3 1 1 .0 6 9 1 .7 0 0
0 .8 0 0 0 .9 0 0 0 .5 2 7 2 .0 6 8 0 .7 4 5 1 .0 5 5 1 .8 0 0
1 .0 0 0 0 .9 0 0 0 .5 9 2 2 .2 5 5 0 .8 5 1 1 .0 4 9 1 .9 0 0
1 .2 0 0 0 .9 0 0 0 .6 4 9 2 .4 4 3 0 .9 5 4 1 .0 4 6 2 .0 0 0
1 .4 0 0 0 .9 0 0 0 .7 0 0 2 .6 3 7 1 .0 5 5 1 .0 4 5 2 .1 0 0

w id th  B

C
D

1 .0

2
.0

W
D

F

H

F  >  0 . 6 m

c r i t i c a l  d e p t h
D i s c h a r g e C h a n n e l  w i d t h W a t e r  D e p t h V e l o c i t y F r e e b o a r d C h a n n e l  D e p t h

( m ^ 3 / s ) B  ( m ) W D  ( m ) V  ( m / s ) F  ( m ) C D  ( m )
1 . 0 0 0 1 . 0 0 0 0 . 4 3 3 1 . 8 9 8 0 . 6 6 7 1 . 1 0 0

1 . 5 0 0 0 . 3 4 3 1 . 7 4 5 0 . 6 5 7 1 . 0 0 0
2 . 0 0 0 0 . 2 8 7 1 . 6 2 4 0 . 6 1 3 0 . 9 0 0

5 . 0 0 0 1 . 0 0 0 1 . 1 2 4 2 . 8 4 7 0 . 6 7 6 1 . 8 0 0
1 . 5 0 0 0 . 9 3 4 2 . 7 2 0 0 . 6 6 6 1 . 6 0 0
2 . 0 0 0 0 . 8 0 2 2 . 5 9 6 0 . 6 9 8 1 . 5 0 0
2 . 5 0 0 0 . 7 0 6 2 . 4 8 2 0 . 6 9 4 1 . 4 0 0
3 . 0 0 0 0 . 6 3 3 2 . 3 8 0 0 . 6 6 7 1 . 3 0 0

1 0 . 0 0 0 1 . 0 0 0 1 . 6 4 6 3 . 3 3 3 0 . 6 5 4 2 . 3 0 0
2 . 0 0 0 1 . 2 2 6 3 . 1 2 0 0 . 6 7 4 1 . 9 0 0
3 . 0 0 0 0 . 9 8 5 2 . 9 0 8 0 . 6 1 5 1 . 6 0 0
4 . 0 0 0 0 . 8 3 0 2 . 7 2 7 0 . 6 7 0 1 . 5 0 0
5 . 0 0 0 0 . 7 2 4 2 . 5 7 7 0 . 6 7 6 1 . 4 0 0

1 5 . 0 0 0 2 . 0 0 0 1 . 5 6 1 3 . 4 5 6 0 . 6 3 9 2 . 2 0 0
3 . 0 0 0 1 . 2 6 9 3 . 2 5 3 0 . 6 3 1 1 . 9 0 0
4 . 0 0 0 1 . 0 7 6 3 . 0 7 1 0 . 6 2 4 1 . 7 0 0
5 . 0 0 0 0 . 9 4 1 2 . 9 1 4 0 . 6 5 9 1 . 6 0 0

2 0 . 0 0 0 2 . 0 0 0 1 . 8 4 6 3 . 7 0 8 0 . 6 5 4 2 . 5 0 0
3 . 0 0 0 1 . 5 1 5 3 . 5 1 5 0 . 6 8 5 2 . 2 0 0
4 . 0 0 0 1 . 2 9 1 3 . 3 3 3 0 . 6 0 9 1 . 9 0 0
5 . 0 0 0 1 . 1 3 2 3 . 1 7 4 0 . 6 6 8 1 . 8 0 0
6 . 0 0 0 1 . 0 1 3 3 . 0 3 5 0 . 6 8 7 1 . 7 0 0

3 0 . 0 0 0 4 . 0 0 0 1 . 6 6 4 3 . 7 3 0 0 . 6 3 6 2 . 3 0 0
5 . 0 0 0 1 . 4 6 6 3 . 5 6 9 0 . 6 3 4 2 . 1 0 0
6 . 0 0 0 1 . 3 1 6 3 . 4 2 5 0 . 6 8 4 2 . 0 0 0
7 . 0 0 0 1 . 1 9 7 3 . 2 9 8 0 . 6 0 3 1 . 8 0 0
8 . 0 0 0 1 . 1 0 2 3 . 1 8 5 0 . 6 9 8 1 . 8 0 0

4 0 . 0 0 0 5 . 0 0 0 1 . 7 5 8 3 . 8 7 1 0 . 6 4 2 2 . 4 0 0
6 . 0 0 0 1 . 5 8 1 1 . 5 8 1 0 . 6 1 9 2 . 2 0 0
7 . 0 0 0 1 . 4 4 1 3 . 5 9 4 0 . 6 5 9 2 . 1 0 0
8 . 0 0 0 1 . 3 2 8 3 . 4 7 7 0 . 6 7 2 2 . 0 0 0

5 0 . 0 0 0 6 . 0 0 0 1 . 8 2 2 3 . 9 7 2 0 . 6 7 8 2 . 5 0 0
7 . 0 0 0 1 . 6 6 3 3 . 8 3 9 0 . 6 3 7 2 . 3 0 0
8 . 0 0 0 1 . 5 3 4 3 . 7 1 8 0 . 6 6 6 2 . 2 0 0

1 0 . 0 0 0 1 . 3 3 6 3 . 5 1 0 0 . 6 6 4 2 . 0 0 0

w i d t h  B

C
D

1 . 0

2
.0

W
D

F
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Table 2-17 Uniform Flow Depth of Spillway Downstream Channel 

Table 2-18 Hydraulic Calculation of Energy Dissipater (Stilling Basin) 

u n ifo rm  f lo w  d e p th
D is c h a r g e C h a n n e l w id th S lo p e W a te r  D e p th V e lo c ity F re e b o a rd C h a n n e l D e p th
(m ^3 / s ) B  (m ) % D 1  (m ) V 1  (m / s ) F  (m ) C D  (m )

1 .0 0 0 1 .0 0 0 2 0 .0 0 0 0 .1 4 1 6 .6 0 9 0 .6 5 9 0 .8 0 0
1 .0 0 0 1 0 .0 0 0 0 .1 7 5 5 .2 4 9 0 .6 2 5 0 .8 0 0
1 .0 0 0 5 .0 0 0 0 .2 1 7 4 .1 5 4 0 .6 8 3 0 .9 0 0
1 .0 0 0 1 .0 0 0 0 .3 5 7 2 .3 7 4 0 .6 4 3 1 .0 0 0

5 .0 0 0 1 .0 0 0 2 0 .0 0 0 0 .3 8 3 1 0 .9 6 5 0 .6 1 7 1 .0 0 0
1 .0 0 0 1 0 .0 0 0 0 .4 7 3 8 .5 4 5 0 .6 2 7 1 .1 0 0
1 .0 0 0 5 .0 0 0 0 .5 8 3 6 .6 3 4 0 .6 1 7 1 .2 0 0
1 .0 0 0 1 .0 0 0 0 .9 3 6 3 .6 3 9 0 .6 6 4 1 .6 0 0

1 0 .0 0 0 2 .0 0 0 2 0 .0 0 0 0 .3 7 4 1 2 .2 0 9 0 .6 2 6 1 .0 0 0
2 .0 0 0 1 0 .0 0 0 0 .4 6 4 9 .6 4 9 0 .6 3 6 1 .1 0 0
2 .0 0 0 5 .0 0 0 0 .5 7 6 7 .5 9 5 0 .6 2 4 1 .2 0 0
2 .0 0 0 1 .0 0 0 0 .9 4 4 4 .2 8 5 0 .6 5 6 1 .6 0 0

1 5 .0 0 0 3 .0 0 0 2 0 .0 0 0 0 .3 7 0 1 2 .7 3 9 0 .6 3 0 1 .0 0 0
3 .0 0 0 1 0 .0 0 0 0 .4 5 8 1 0 .1 4 1 0 .6 4 2 1 .1 0 0
3 .0 0 0 5 .0 0 0 0 .5 6 8 8 .0 4 4 0 .6 3 2 1 .2 0 0
3 .0 0 0 1 .0 0 0 0 .9 3 5 4 .6 2 6 0 .6 6 5 1 .6 0 0

2 0 .0 0 0 4 .0 0 0 2 0 .0 0 0 0 .3 6 7 1 3 .0 3 2 0 .6 3 3 1 .0 0 0
4 .0 0 0 1 0 .0 0 0 0 .4 5 4 1 0 .4 1 9 0 .6 4 6 1 .1 0 0
4 .0 0 0 5 .0 0 0 0 .5 6 3 8 .3 0 4 0 .6 3 7 1 .2 0 0
4 .0 0 0 1 .0 0 0 0 .9 2 6 4 .8 3 8 0 .6 7 4 1 .6 0 0

3 0 .0 0 0 6 .0 0 0 2 0 .0 0 0 0 .3 6 4 1 3 .3 4 6 0 .6 3 6 1 .0 0 0
6 .0 0 0 1 0 .0 0 0 0 .4 5 0 1 0 .7 2 0 0 .6 5 0 1 .1 0 0
6 .0 0 0 5 .0 0 0 0 .5 5 6 8 .5 9 2 0 .6 4 4 1 .2 0 0
6 .0 0 0 1 .0 0 0 0 .9 1 4 5 .0 8 4 0 .6 8 6 1 .6 0 0

4 0 .0 0 0 8 .0 0 0 2 0 .0 0 0 0 .3 6 2 1 3 .5 1 1 0 .6 3 8 1 .0 0 0
8 .0 0 0 1 0 .0 0 0 0 .4 4 7 1 0 .8 8 1 0 .6 5 3 1 .1 0 0
8 .0 0 0 5 .0 0 0 0 .5 5 3 8 .7 4 7 0 .6 4 7 1 .2 0 0
8 .0 0 0 1 .0 0 0 0 .9 0 6 5 .2 2 3 0 .6 9 4 1 .6 0 0

5 0 .0 0 0 1 0 .0 0 0 2 0 .0 0 0 0 .3 6 1 1 3 .6 1 3 0 .6 3 9 1 .0 0 0
1 0 .0 0 0 1 0 .0 0 0 0 .4 4 5 1 0 .9 8 0 0 .6 5 5 1 .1 0 0
1 0 .0 0 0 5 .0 0 0 0 .5 5 0 8 .8 4 4 0 .6 5 0 1 .2 0 0
1 0 .0 0 0 1 .0 0 0 0 .9 0 1 5 .3 1 2 0 .6 9 9 1 .6 0 0

Energy Dissipater (Stilling Basin)
Discharge Channel width Slope of steep Depth before Velocity Froude number Depth after Freeboard Length Channel Depth
(m^3/s) B (m) channel % jump D1 (m) V1 (m/s) Fr jump D2(m) Fb (m) L(m) CD (m)

1.000 1.000 20.000 0.141 6.609 5.622 1.053 0.766 6.317 1.819
1.000 10.000 0.175 5.249 4.008 0.908 0.616 5.450 1.524
1.000 5.000 0.217 4.154 2.849 0.772 0.493 3.090 1.265
1.000 1.000 0.357 2.374 1.269 0.487 0.286 1.947 0.773

5.000 1.000 20.000 0.383 10.965 5.660 2.880 1.385 17.280 4.265
1.000 10.000 0.473 8.545 3.969 2.429 1.097 9.716 3.526
1.000 5.000 0.583 6.634 2.775 2.015 0.865 8.061 2.880
1.000 1.000 0.936 3.639 1.202 1.190 0.483 4.760 1.673

10.000 2.000 20.000 0.374 12.209 6.377 3.191 1.540 19.147 4.731
2.000 10.000 0.464 9.649 4.525 2.746 1.240 16.478 3.986
2.000 5.000 0.576 7.595 3.197 2.332 0.993 9.328 3.325
2.000 1.000 0.944 4.285 1.409 1.467 0.575 5.868 2.042

15.000 3.000 20.000 0.370 12.739 6.690 3.320 1.606 19.923 4.926
3.000 10.000 0.458 10.141 4.787 2.880 1.302 17.279 4.182
3.000 5.000 0.568 8.044 3.409 2.469 1.051 9.878 3.521
3.000 1.000 0.935 4.626 1.528 1.607 0.623 6.427 2.230

20.000 4.000 20.000 0.367 13.032 6.872 3.388 1.642 20.326 5.030
4.000 10.000 0.454 10.419 4.940 2.953 1.337 17.715 4.290
4.000 5.000 0.563 8.304 3.535 2.547 1.085 10.189 3.632
4.000 1.000 0.926 4.838 1.606 1.691 0.653 6.762 2.343

30.000 6.000 20.000 0.364 13.346 7.066 3.460 1.681 20.760 5.141
6.000 10.000 0.450 10.720 5.105 3.031 1.375 18.189 4.407
6.000 5.000 0.556 8.592 3.681 2.630 1.122 10.518 3.752
6.000 1.000 0.914 5.084 1.699 1.786 0.687 7.143 2.473

40.000 8.000 20.000 0.362 13.511 7.173 3.496 1.701 20.975 5.196
8.000 10.000 0.447 10.881 5.199 3.071 1.395 18.423 4.466
8.000 5.000 0.553 8.747 3.757 2.675 1.142 10.700 3.817
8.000 1.000 0.906 5.223 1.753 1.838 0.706 7.352 2.544

50.000 10.000 20.000 0.361 13.613 7.237 3.519 1.713 21.113 5.232
10.000 10.000 0.445 10.980 5.258 3.094 1.407 18.563 4.501
10.000 5.000 0.550 8.844 3.809 2.701 1.154 10.803 3.855
10.000 1.000 0.901 5.312 1.788 1.871 0.718 7.486 2.590

Fr = V1/(gxD1)^0.5
D2 = 1/2x((1+8Fr^2)^0.5-1)xD1
Fb = 0.1x(V1+D2)
L = 6xD2 (Fr>4),  4xD2 (Fr<4)
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The larger the over flow depth is, the higher the embankment is required, and the smaller the overflow 
depth is, the larger the channel. The flow velocity at inlet channel should be less than 4.0 m/sec to 
ensure gentle flow with small fluctuation of water surface. In case that driftwood and trash is expected 
to flow in, the depth should be not less than 0.4 m. The over flow depth at the spillway: 0.4~1.0 m. 
The flow velocity at inlet channel: less than 4.0 m/sec. The slope of spillway downstream channel: 
steeper than 1%. 

From above hydraulic analysis, recommended dimensions of spillway are shown in the Table 2-19. 

Table 2-19 Standard Dimensions of Spillway 

Flood Discharge 
(m3/sec) 

~5.0 m3 5.0 ~ 
10.0 m3 

10.0~ 
20.0 m3 

20.0~ 
30.0 m3 

30.0 ~ 
40.0 m3 

40.0~ 
50.0 m3 

Inlet Culvert Channel Width (m) 7.5 - - - - - 
Inlet Culvert Channel Depth (m) 1.9 - - - - - 
Inlet Open Channel Width (m) 3.0 6.0 12.0 18.0 24.0 30.0 
Inlet Open Channel Depth (m) 2.0 2.0 2.0 2.0 2.0 2.0 
Spillway Downstream Channel 
Width, End Point (m) 

2.0 2.0 4.0 6.0 8.0 10.0 

Spillway Downstream Channel 
Depth, End Point (m) 

1.5 1.9 1.9 2.0 2.0 2.0 

Steep Channel width (m)       
 Slope 20% 1.0 2.0 4.0 6.0 8.0 10.0 
 Slope 10% 1.0 2.0 4.0 6.0 8.0 10.0 
 Slope 5% 1.0 2.0 4.0 6.0 8.0 10.0 
 Slope 1% 1.0 2.0 4.0 6.0 8.0 10.0 
Steep Channel Depth (m)       
 Slope 20% 1.0 1.0 1.0 1.0 1.0 1.0 
 Slope 10% 1.1 1.1 1.1 1.1 1.1 1.1 
 Slope 5% 1.2 1.2 1.2 1.2 1.2 1.2 
 Slope 1% 1.6 1.6 1.6 1.6 1.6 1.6 
Stilling Basin Length (m)       
 Slope of steep channel 20% 17.3 19.2 20.4 20.8 21.0 21.2 
 Slope of steep channel 10% 9.8 16.5 17.8 18.2 18.5 18.6 
 Slope of steep channel 5% 8.1 9.4 10.2 10.6 10.7 10.9 
 Slope of steep channel 1% 4.8 5.9 6.8 7.2 7.4 7.5 
Stilling Basin Width (m)       
 Slope of steep channel 20% 1.0 2.0 4.0 6.0 8.0 10.0 
 Slope of steep channel 10% 1.0 2.0 4.0 6.0 8.0 10.0 
 Slope of steep channel 5% 1.0 2.0 4.0 6.0 8.0 10.0 
 Slope of steep channel 1% 1.0 2.0 4.0 6.0 8.0 10.0 
Stilling Basin Depth (m)       
 Slope of steep channel 20% 4.3 4.8 5.1 5.2 5.2 5.3 
 Slope of steep channel 10% 3.6 4.0 4.3 4.5 4.5 4.6 
 Slope of steep channel 5% 2.9 3.4 3.7 3.8 3.9 3.9 
 Slope of steep channel 1% 1.7 2.1 2.4 2.5 2.6 2.6 

5) Intake and outlet 

The structures of intake facilities and outlet works should safely intake maximum intake volume or to 
safely release maximum outlet discharge. The structures should not to produce any adverse effects on 
dam body, foundation and reservoir. In this guideline, intake and outlet facilities should be composed 
of intake pit, sluice gate, bottom conduit, discharge pipe, valve and outlet box. 
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(i) Intake pit 
Intake pit should be made of concrete or bricks. It is desirable that a screen is installed not to 
make trash inflow the bottom conduit. Broken part should be repaired with mortar. Sediment 
inside and around the pit should be removed every year  
 
ii) Bottom conduit 
Diameter of bottom conduit should be not be less than 0.45m considering maintenance. Bottom 
conduit should have enough strength against soil pressure. Bottom conduit should be 
constructed in the foundation with smooth contact between conduit and dam body, and safe 
design against external pressure and seepage. Cut-off wall should be provided to prevent 
leakage and piping. Specialist should be engaged when assessing whether a structure needs 
repair or not.    
 
iii) Valve and gate 
Valve and gate should have necessary water tightness, durability and operational performance. 
In the case these are not functional; they should be repaired or replaced.  
 
iv) Discharge Pipe 
Discharge Pipe conveys water to outlet pit. PVC discharge pipes are recommended.  
 
v) Outlet box 
Water is released in discharge box and flow into main canal. Discharge box should be a 
structure, which dissipate water energy. Broken part should be repaired with mortar.  

The hydraulic analysis of intake system is shown in Figure 2-12 and is carried out as follows. Table of 
coefficients from Table 2-20 ~Table 2-25 are used in the process of the Analysis. 

 

 

 

 

 

 

 

Figure 2-12 Standard Intake System 

he: inflow head loss (m) 
he = fe x V2/2g 
fe: coefficient of inflow head loss 

Table 2-20 Coefficient of Inflow Head Loss 

Shape of inlet Square Cutting corner Circular corner Bellmouse 
Fe 0.5 0.25 0.1~0.2 0.01~0.05 

V: mean velocity after inflow (m/s) 
g: acceleration of gravity (m/s2) 
hf1: friction head loss of intake conduit 
hf1 = f x L/D x V2/2g (m) 
L: length of the pipe (m) 
D: Diameter of the pipe (m) 
f: coefficient of friction head loss 

H

he hf1 
hv 

hsc 

hf2 

hou

hbe 
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f = 133.7/(C1.85 x D0.167 x V0.148) 
C: coefficient of velocity 

Table 2-21 Coefficient of Velocity 

Coefficient of velocity Pipe (inside condition) Maximum value Minimum value Standard value 
Cast iron pipe (not painted) 
Steel pipe (not painted) 
Coal-tar painted pipe (Cast iron) 
Tar epoxy painted pipe (Steel) 

φ800~ 
   φ700~600 
   φ500~350 
   φ300~ 
Mortar lining pipe (Steel, Cast iron) 
Reinforced concrete pipe 
Prestressed concrete pipe 
Chloride vinyl pipe * 
Polyethylene pipe * 
Reinforced plastic pipe * 

150 
150 
145 

 
- 
- 
- 
- 

150 
140 
140 
160 
170 
160 

80 
90 
80 

 
- 
- 
- 
- 

120 
120 
120 
140 
130 

- 

100 
100 
100 

 
130 
120 
110 
100 
130 
130 
130 
150 
150 
150 

* C=140 is adopted as standard value for the pipes having diameter less than 150mm. 
hv: valve head loss 
hv = fv x V2/2g (m) 
fv: coefficient of valve head loss 

Table 2-22 Coefficient of Valve Head Loss by Weisbach 

Gate valve, circular pipe (D=610, 762mm) 
S: opening of valve, D: diameter, a: area of opening, A: area of full opening 
S/D =  
a/A =  
fv (D-610mm) =  
fv (D-762mm) =  

0.05 
0.05 
235 
333 

0.10 
0.10
100 
111 

0.20 
0.23
28 
23 

0.30 
0.36 
11 
9.4 

0.40 
0.48 
5.6 
5.2 

0.50 
0.60 
3.2 
3.1 

0.60
0.71
1.7 
1.9 

0.70 
0.81 
0.95 
1.13 

0.80 
0.89 

- 
0.60 

Butterfly valve, (full open:θ=0°, close:θ=90°) 
a: area of opening, A: area of full opening, θ: opening angle 
θ= 
a/A =  
fv = 

5 
0.91 
0.24 

10 
0.83 
0.52 

15 
0.74 
0.90 

20 
0.66 
1.54 

25 
0.58
2.51

30 
0.50
3.91

35 
0.43
6.22

40 
0.36
10.8

45 
0.29
18.7

50 
0.23
32.6

60 
0.13
118

70 
0.06
751

90 
0.0
∞ 

hsc: sudden contraction head loss 
hsc = fsc x V22/2g 
V2: mean velocity after sudden contraction (m/s) 
fsc: coefficient of sudden contraction head loss 

Table 2-23 Coefficient of Sudden Contraction Head Loss 

D2/D1 0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 
fsc 0.50 0.50 0.49 0.49 0.46 0.43 0.38 0.29 0.18 0.07 
D2: Diameter after sudden contraction 
D1: Diameter before sudden contraction 
hse: sudden enlargement head loss 
hse = fse x V12/2g 
V1: mean velocity before sudden enlargement (m/s) 
fse: coefficient of sudden enlargement head loss 
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Table 2-24 Coefficient of Sudden Enlargement Head Loss 

D1/D2 0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 
fse 1.0 0.98 0.92 0.82 0.70 0.56 0.41 0.26 0.13 0.04 
D2: Diameter after sudden enlargement 
D1: Diameter before sudden enlargement 
hf2: friction head loss of discharge pipeline 
hf1 = f x L/D x V2/2g (m) 
L: length of the pipe (m) 
D: Diameter of the pipe (m) 
f: coefficient of friction head loss 
f = 133.7/ (C1.85 x D0.167 x V0.148) 
C: coefficient of velocity 
hbe: bend head loss 
hbe = fbe x  V2/2g (m) 
fbe: coefficient of bend pipe head loss 

Table 2-25 Coefficient of Bend Pipe Head Loss by Weisbach 

θ 15 30 45 60 90 120 
Fbe 0.022 0.073 0.183 0.365 0.99 1.86 

θ=: bend angle ° 
hou: outflow head loss 
hou = fou x V2/2g, fou = 1.0 
H = he + hf1 + hv + hsc + hf2 + hbe + hou 

Table 2-26 shows example of hydraulic analysis of intake system. 

The condition of analysis; 
D1: 0.45 m, 0.60 m, 0.90 m 
D2: 0.11 m, 0.14 m,  
L1: 25 m 
L2: 100 m 
fe = 0.5 
fv = 0 (full open) 
fbe = 0.073 (θ= 30°) 
fou = 1.0 

(Ref. Design Standard of Pipeline, Ministry of Agriculture and Fishery, Japan, 1998) 

(4) Rehabilitation plan 

Rehabilitation plan should be made based on investigation result. From the investigation result, 
rehabilitation items are studied and rehabilitation work is planned. Rehabilitation work should be 
planned to make the dam and facilities functional and safe to meet the condition and standard 
described in this guideline.  
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Table 2-26 Hydraulic Analysis of Intake System (Example) 

 

2.3 Motorized Pump   

Motorized pump system had been introduced in the country sometime back but many of them are not 
functioning due to lack of maintenance technical capacity and lack of finances for operation and 
maintenance of the structures. Sprinkler system with motorized pump had been tried and abandoned 
due maintenance difficulties. Since many of farmers prefer surface irrigation to sprinkler irrigation, the 
guideline concentrates on the surface irrigation with motorized pump system. The system consists of 
pump, discharge pipe, discharge box, main canal and division box. 

(1) Rehabilitation/Construction Criteria 

1) Material  

Most of materials for rehabilitation work are sourced/procured locally and input from outside are 
minimized. Local materials include sand, stone, bricks and cement, gabion, tools are outside materials.  

2) Labor  

The rehabilitation work is recommended to be done by the farmers under supervision of AEDO and 
IOs. Labor force should be provided by the farmers association. Only transportation for materials (if 
necessary) could be provided from outside. 

(2) Investigation 

Field investigations should be carried out at and around the site on necessary items for design, 
construction, rehabilitation and O&M. Prior to the investigations selecting necessary items for 
investigation, the appropriate investigation plan should be put in practice. The results of investigation 
are necessary for design of pump system and canal system. 

1) Meteorological and hydrological investigations 

Meteorological and hydrological conditions of the site should be investigated through data collection 
and observation. Items for meteorological and hydrological investigation include temperature, 

Hydrulic Analysis of Intake System (Example)
Q D1 V1 he hf1 D2 fsc V2 hsc hbe f2 hf2 hou H
0.005 0.450 0.031 0.000 0.000 0.110 0.490 0.526 0.007 0.002 0.023 0.292 0.014 0.315
0.005 0.600 0.018 0.000 0.000 0.110 0.490 0.526 0.007 0.002 0.023 0.292 0.014 0.315
0.005 0.900 0.008 0.000 0.000 0.110 0.500 0.526 0.007 0.002 0.023 0.292 0.014 0.315
0.010 0.450 0.063 0.000 0.000 0.110 0.490 1.052 0.028 0.008 0.021 1.055 0.056 1.148
0.010 0.600 0.035 0.000 0.000 0.110 0.490 1.052 0.028 0.008 0.021 1.055 0.056 1.147
0.010 0.900 0.016 0.000 0.000 0.110 0.500 1.052 0.028 0.008 0.021 1.055 0.056 1.148
0.015 0.450 0.094 0.000 0.001 0.110 0.490 1.578 0.062 0.019 0.019 2.235 0.127 2.444
0.015 0.600 0.053 0.000 0.000 0.110 0.490 1.578 0.062 0.019 0.019 2.235 0.127 2.443
0.015 0.900 0.024 0.000 0.000 0.110 0.500 1.578 0.064 0.019 0.019 2.235 0.127 2.445
0.020 0.450 0.126 0.000 0.001 0.110 0.490 2.105 0.111 0.033 0.019 3.808 0.226 4.179
0.020 0.600 0.071 0.000 0.000 0.110 0.490 2.105 0.111 0.033 0.019 3.808 0.226 4.178
0.020 0.900 0.031 0.000 0.000 0.110 0.500 2.105 0.113 0.033 0.019 3.808 0.226 4.180
0.030 0.450 0.189 0.001 0.002 0.110 0.490 3.157 0.249 0.074 0.017 8.069 0.508 8.904
0.030 0.600 0.106 0.000 0.001 0.110 0.490 3.157 0.249 0.074 0.017 8.069 0.508 8.902
0.030 0.900 0.047 0.000 0.000 0.110 0.500 3.157 0.254 0.074 0.017 8.069 0.508 8.906
0.040 0.450 0.252 0.002 0.004 0.110 0.490 4.209 0.443 0.132 0.017 13.747 0.904 15.232
0.040 0.600 0.141 0.001 0.001 0.110 0.490 4.209 0.443 0.132 0.017 13.747 0.904 15.228
0.040 0.900 0.063 0.000 0.000 0.110 0.500 4.209 0.452 0.132 0.017 13.747 0.904 15.236

0.005 0.450 0.031 0.000 0.000 0.140 0.490 0.325 0.003 0.001 0.023 0.090 0.005 0.099
0.005 0.600 0.018 0.000 0.000 0.140 0.490 0.325 0.003 0.001 0.023 0.090 0.005 0.099
0.005 0.900 0.008 0.000 0.000 0.140 0.490 0.325 0.003 0.001 0.023 0.090 0.005 0.099
0.010 0.450 0.063 0.000 0.000 0.140 0.490 0.650 0.011 0.003 0.021 0.326 0.022 0.362
0.010 0.600 0.035 0.000 0.000 0.140 0.490 0.650 0.011 0.003 0.021 0.326 0.022 0.361
0.010 0.900 0.016 0.000 0.000 0.140 0.490 0.650 0.011 0.003 0.021 0.326 0.022 0.361
0.015 0.450 0.094 0.000 0.001 0.140 0.490 0.974 0.024 0.007 0.020 0.690 0.048 0.771
0.015 0.600 0.053 0.000 0.000 0.140 0.490 0.974 0.024 0.007 0.020 0.690 0.048 0.770
0.015 0.900 0.024 0.000 0.000 0.140 0.490 0.974 0.024 0.007 0.020 0.690 0.048 0.770
0.020 0.450 0.126 0.000 0.001 0.140 0.490 1.299 0.042 0.013 0.019 1.176 0.086 1.319
0.020 0.600 0.071 0.000 0.000 0.140 0.490 1.299 0.042 0.013 0.019 1.176 0.086 1.318
0.020 0.900 0.031 0.000 0.000 0.140 0.490 1.299 0.042 0.013 0.019 1.176 0.086 1.317
0.030 0.450 0.189 0.001 0.002 0.140 0.490 1.949 0.095 0.028 0.018 2.493 0.194 2.813
0.030 0.600 0.106 0.000 0.001 0.140 0.490 1.949 0.095 0.028 0.018 2.493 0.194 2.811
0.030 0.900 0.047 0.000 0.000 0.140 0.490 1.949 0.095 0.028 0.018 2.493 0.194 2.810
0.040 0.450 0.252 0.002 0.004 0.140 0.490 2.598 0.169 0.050 0.017 4.247 0.344 4.816
0.040 0.600 0.141 0.001 0.001 0.140 0.490 2.598 0.169 0.050 0.017 4.247 0.344 4.812
0.040 0.900 0.063 0.000 0.000 0.140 0.490 2.598 0.169 0.050 0.017 4.247 0.344 4.811
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precipitation, evaporation, wind direction, wind velocity.  

2) Investigation for water source conditions 

This investigation is performed to clarify the present water source (river or pond) conditions. 
Investigation items include flow quantity, water level, available storage capacity of the pond, water 
temperature, water quality, riverbed conditions etc.  

3) Topographic investigations 

Topography of the site and surrounding area should be clarified through data collection and 
topographic survey. Topographic investigations are important to determine the location of the pump 
and canal system. 

4) Investigation for Operation and maintenance 

Investigation for operation and maintenance should be executed on following items; 

i) Meteorology, hydrology 
ii) Water source conditions 
iii) Condition of existing pump system 
iv) Data on water use management of existing pump 
v) Operation and maintenance system of existing pump 

5) Investigation for construction works 

Investigation for construction works should be conducted on the following items, which are necessary 
for construction planning. 

(i) Meteorology, surface water, ground water 
Meteorology and surface water should be thoroughly investigated because of their utmost 
importance for deciding the construction schedule. Especially, temperature is important for 
planning concrete (mortar) works. 
(ii) Construction equipment and materials 
Construction materials include cement, soil, sand, gravel, stone, steel materials, bricks and 
timber etc. The supply situation of materials should be checked. Availability of local materials, 
necessity of transportation, availability of transportation and availability of tools should be 
checked. Transportation of materials should be arranged if necessary. Refer to the Table 2-27. 

Table 2-27 List of Items to be Investigated (Motorized Pump Irrigation) 

Items Description Method Outputs 
1.Meteorological and 
hydrological 
investigations 
 

- Collection of 
meteorological and 
hydrological data 
 

Data collection and site 
observation 
 
 

Annual rainfall, 
Temp., wind 
direction, wind 
velocity, etc. 

2. Water source 
conditions 
(i) Water level and 

discharge 
 
 
 
 
 
 
(ii) Stream  
 

 
 
- Highest water level and 
lowest water level 
- Representative water 
level and flow velocity in 
each month 
- Capacity of the pond 
- Stream centerline is 
stable 
- Stream at the intake 
point is stable 

 
 
Observation of past flood 
mark and villagers interview 
Observation at the river 
 
 
 
Derive from topographic 
survey 
Visual observation at the river
 

 
 
HWL = 
LWL = 
WL= 
 
 
V =  m3 

Yes or No 
 
Yes or No 
Stones, sand or silt. 
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(iii) Sedimentation 
(iv) Riverbed  
 
 
 
(v) River Utilisation 

- Sediment at the intake 
point 
- Riverbed slope 
- Materials and 
conditions of the river 
 
 
- Water Rights 

Observation of sediment 
configuration. 
 
Surveying. 20m interval, from 
100m upstream to 100m 
downstream. 
Visual observation at the river
Interview to relevant party 

A lot of or a little 
Riverbed slope = 
 
Estimated roughness 
coefficient = 
 
 
Quantity =    lit/s 
Water fee=    MK

3. Topographic 
investigations 
(i) Pump location and 

surroundings 
 
 
 
 
 
(ii) Collection of 

topographic and 
other related maps. 

 
 
- Configuration of the 
river, location of the 
pump, contour line etc. 
should be indicated. 
- Longitudinal section of 
the pipeline. 
 
- Available maps around 
the scheme 
 

 
 
Site surveying with measuring 
tape and compass. Plane table.
Site surveying with measuring 
tape and level 
 
 
 
Data collection 
 
 

 
 
Plan: scale 
1/1000~1/2000 
 
 
Longitudinal 
section: scale 
1/200~1/500 
Actual pump head=  
m 
Various maps 

4. Operation and 
maintenance 
(i) Condition of 

existing pump 
system 

 
 
 
 
 
 
 
 
(ii) Data on water use 

management 
(iii) Operation and 

maintenance of 
existing pump 

 
 
- Condition of engine 
 
- Condition of pump 
 
- Function of pump 
- Condition of suction 
pipe 
- Condition of discharge 
pipe 
- Condition of discharge 
box 
- Daily operation hour 
and intake water level 
- Fuel consumption, oil 
and spare parts 
replacement 

 
 
Trial operation, checking 
maintenance items 
Trial operation, checking 
maintenance items 
Trial operation 
Visual inspection 
 
Visual inspection 
 
Visual inspection, measuring 
tape 
Operation and maintenance 
record of the pump 
Operation and Maintenance 
record of the pump 
 

 
 
Good/bad 
Need repair or not 
Maintenance check 
list  
Good/bad 
Damage, leakage 
Damage, leakage 
Dimensions, 
material, damage, 
cracks 
 
Irrigation schedule, 
daily, Q for the 
canal 
Fuel consumption, 
necessity of 
maintenance 

5. Construction works 
(i) Meteorology 
 
 
(ii) Construction 

equipment, 
materials, 
transportation 

 
 

 
- Collection of  all 
existing meteorological 
data 
- Availability of materials
 
- Number of available 
tools  
- Available transportation 
- Labor availability 

 
Data collection and site 
observation 
 
Sand 
Cement 
Wheelbarrow 
Bucket, Shovel, Others 
Truck, tractor, oxcart 
Skilled labor 
Unskilled labor 

 
Annual rainfall, 
Stream condition, 
temp., water level 
=  km from the site
= to be procured in   
=   units 
=   pcs 
DAO, DA, ADD, 
Farmers 
=   number 
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(3) Rehabilitation/Construction Planning/Design 

1) General Layout 

General layout of pump irrigation system is shown in the Figure 2-13. 

Figure 2-13 General Lay-out of Pump Irrigation System 

Water is pumped up from water source (river or pond) and conveyed to discharge box through 
discharge pipe. Water is discharged from discharge box to secondary canal, and from secondary canal 
to farm ditch. Recommended size of one plot is 30m x 150m, 0.45 ha considering conveyance of water 
in the field.  

2) Discharge Pipe 

Discharge pipes are recommended steel, galvanized steel or PVC. Diameter of the pipe should be 
determined by hydraulic analysis. Discharge pipes should be installed under ground to the depth that 
the soil cover is more than 30 cm, refer to the Figure 2-14. In case of diameter 110 mm and 160mm, 
30 cm soil cover is enough safe for gross weight 14 ton truck load. Soil cover should be determined 
considering cultivation.  

 

 

 

 

 

 

 

Figure 2-14 Standard Installation of Discharge Pipe 

3) Discharge Box 

Discharge box should be made of concrete or bricks. Standard type of discharge box, Plan View and 
Cross Sections are shown in Figure 2-15. 

P

water receiving pit
secondary canal

farm ditch
30m

1
5
0
m

discharge pipe

water source

D≧30 cm 

30 cm 

Discharge Pipe 

Backfill and 
compaction 
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Figure 2-15 Standard Type of Discharge Box (Plan and Cross Section Views) 

4) Pump 

Pump facilities should be safely secured and economically designed for maximum discharge. It should 
be decided after thorough examination of discharge fluctuation, the relationship with other facilities, 
operation and maintenance. In designing pump facilities, the following parameters should be decided; 

(i) Number of pump facilities 
Usually, a pumping station has multiple pumps and one of them is prepared as a backup pump. 
However, in a medium scale irrigation scheme, backup pump is not prepared considering 
economical efficiency.  
 
(ii) Type of pump 
In Malawi, small scale centrifugal volute pump is common and its spare parts are available. In 
the case of no pump house, transportable type of pump is recommended considering storing in 
the rainy season. 
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(iii) Pump diameter 
Generally, diameter of small scale pump ranges from 75mm to 150mm. The diameter should be 
determined considering required pump capacity and discharge. 
 
(iv) Discharge (per unit) 
Discharge flow quantity should be determined based on maximum water requirement of the 
field. 
 
(v) Total pumping head 
Total pumping head is actual pump head + total head loss. The pump should be selected 
considering total pumping head and discharge. The pump capacity should have enough 
discharge capacity at the required total pumping head. The pump capacity is read out from the 
pump characteristic curve of each pump. 
 
vi) Type and output of engine 
A Pump is driven by motor, gasoline engine or diesel engine. In Malawi, generally electric 
power is not available at the site and many diesel engine driven pumps are used in medium 
scale schemes. The output of engine should be determined based on the characteristic curve at 
each output.   

Hydraulic Conditions of the Pump System are shown in Figure 2-16. 

 

 

 

     

 

 

Figure 2-16 Hydraulic Condition of Pump System 

H = h + Δh 
H: Total Pump Head  (m) 
h: Actual Pump Head  (m) 
Δh: Total Head Loss  (m) 
hst: strainer head loss (m) 

hst = fst x V2/2g  (m) 
f: coefficient of strainer head loss, f = 1.0 

hf1: friction head loss of suction pipe  (m) 
hbe: bend pipe head loss  (m) 

hbe = fbe x V2/2g (m) 
fbe = 0.183 (45°) 

hf2: friction head loss of discharge pipe  (m) 
hou: out flow head loss  (m) 

hou = fou x V2/2g  (m) 
f: coefficient of strainer head loss, f = 1.0 

P h 

hst hf1 

hbe 

hf2 hou 

Δｈ 

H 
pump 
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Hydraulic analysis is carried out as same as 2.2 (3) 5). Table 2-28 shows example of hydraulic 
analysis of pipeline system. The condition of analysis; 

Suction pipe: Polyethylene hose, Diameter D1 = 100 mm, 140 mm, Length L1 = 10m 
Discharge pipe: PVC, Diameter D2 = 110 mm, 140 mm, 200 mm, Length L2 = 200 m, 300 m, 
400m 
Discharge: 5, 10, 15, 20 lit/sec 

 

Table 2-28 Hydraulic Analysis of Pipeline System (Example) 

D1=0.1m, L1=10.0m D2=0.11m, L2=200.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.110 0.526 0.023 0.584 0.014 0.669
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.110 1.052 0.021 2.110 0.056 2.432
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.110 1.578 0.019 4.471 0.127 5.173
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.110 2.105 0.019 7.616 0.226 8.840

D1=0.1m, L1=10.0m D2=0.11m, L2=300.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.110 0.526 0.023 0.877 0.014 0.962
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.110 1.052 0.021 3.165 0.056 3.487
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.110 1.578 0.019 6.706 0.127 7.409
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.110 2.105 0.019 11.424 0.226 12.648

D1=0.1m, L1=10.0m D2=0.11m, L2=400.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.110 0.526 0.023 1.169 0.014 1.254
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.110 1.052 0.021 4.220 0.056 4.542
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.110 1.578 0.019 8.941 0.127 9.644
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.110 2.105 0.019 15.233 0.226 16.456

D1=0.1m, L1=10.0m D2=0.14m, L2=200.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.140 0.325 0.023 0.181 0.005 0.257
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.140 0.650 0.021 0.652 0.022 0.939
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.140 0.974 0.020 1.381 0.048 2.005
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.140 1.299 0.019 2.353 0.086 3.436

D1=0.1m, L1=10.0m D2=0.14m, L2=300.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.140 0.325 0.023 0.271 0.005 0.347
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.140 0.650 0.021 0.978 0.022 1.265
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.140 0.974 0.020 2.071 0.048 2.696
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.140 1.299 0.019 3.529 0.086 4.612
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Since when the flow velocity exceeds 1.0 m/sec, head loss becomes large, the pump is required of 
large capacity. It is recommended that the pipe diameter should be determined and that the flow 
velocity is less than 1.0 m/sec. 

D1=0.1m, L1=10.0m D2=0.14m, L2=400.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.140 0.325 0.023 0.361 0.005 0.437
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.140 0.650 0.021 1.303 0.022 1.591
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.140 0.974 0.020 2.762 0.048 3.386
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.140 1.299 0.019 4.706 0.086 5.789

D1=0.1m, L1=10.0m D2=0.20m, L2=200.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.200 0.159 0.025 0.032 0.001 0.104
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.200 0.318 0.022 0.115 0.005 0.386
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.200 0.477 0.021 0.243 0.012 0.830
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.200 0.637 0.020 0.414 0.021 1.432

D1=0.1m, L1=10.0m D2=0.20m, L2=300.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.200 0.159 0.025 0.048 0.001 0.120
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.200 0.318 0.022 0.172 0.005 0.443
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.200 0.477 0.021 0.365 0.012 0.952
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.200 0.637 0.020 0.621 0.021 1.639

D1=0.1m, L1=10.0m D2=0.20m, L2=400.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.100 0.637 0.021 0.022 0.046 0.004 0.200 0.159 0.025 0.064 0.001 0.136
0.010 0.100 1.273 0.083 0.020 0.168 0.015 0.200 0.318 0.022 0.229 0.005 0.500
0.015 0.100 1.910 0.186 0.019 0.356 0.034 0.200 0.477 0.021 0.486 0.012 1.073
0.020 0.100 2.546 0.331 0.018 0.606 0.061 0.200 0.637 0.020 0.828 0.021 1.846

D1=0.14m, L1=10.0m D2=0.14m, L2=200.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.140 0.325 0.005 0.023 0.009 0.001 0.140 0.325 0.023 0.181 0.005 0.201
0.010 0.140 0.650 0.022 0.021 0.033 0.004 0.140 0.650 0.021 0.652 0.022 0.731
0.015 0.140 0.974 0.048 0.020 0.069 0.009 0.140 0.974 0.020 1.381 0.048 1.556
0.020 0.140 1.299 0.086 0.019 0.118 0.016 0.140 1.299 0.019 2.353 0.086 2.658

D1=0.14m, L1=10.0m D2=0.14m, L2=300.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.140 0.325 0.005 0.023 0.009 0.001 0.140 0.325 0.023 0.271 0.005 0.292
0.010 0.140 0.650 0.022 0.021 0.033 0.004 0.140 0.650 0.021 0.978 0.022 1.057
0.015 0.140 0.974 0.048 0.020 0.069 0.009 0.140 0.974 0.020 2.071 0.048 2.246
0.020 0.140 1.299 0.086 0.019 0.118 0.016 0.140 1.299 0.019 3.529 0.086 3.835

D1=0.14m, L1=10.0m D2=0.14m, L2=400.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.140 0.325 0.005 0.023 0.009 0.001 0.140 0.325 0.023 0.361 0.005 0.382
0.010 0.140 0.650 0.022 0.021 0.033 0.004 0.140 0.650 0.021 1.303 0.022 1.383
0.015 0.140 0.974 0.048 0.020 0.069 0.009 0.140 0.974 0.020 2.762 0.048 2.937
0.020 0.140 1.299 0.086 0.019 0.118 0.016 0.140 1.299 0.019 4.706 0.086 5.011

D1=0.14m, L1=10.0m D2=0.20 m, L2=200.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.140 0.325 0.005 0.023 0.009 0.001 0.200 0.159 0.025 0.032 0.001 0.048
0.010 0.140 0.650 0.022 0.021 0.033 0.004 0.200 0.318 0.022 0.115 0.005 0.178
0.015 0.140 0.974 0.048 0.020 0.069 0.009 0.200 0.477 0.021 0.243 0.012 0.381
0.020 0.140 1.299 0.086 0.019 0.118 0.016 0.200 0.637 0.020 0.414 0.021 0.654

D1=0.14m, L1=10.0m D2=0.20m, L2=300.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.140 0.325 0.005 0.023 0.009 0.001 0.200 0.159 0.025 0.048 0.001 0.064
0.010 0.140 0.650 0.022 0.021 0.033 0.004 0.200 0.318 0.022 0.172 0.005 0.235
0.015 0.140 0.974 0.048 0.020 0.069 0.009 0.200 0.477 0.021 0.365 0.012 0.503
0.020 0.140 1.299 0.086 0.019 0.118 0.016 0.200 0.637 0.020 0.621 0.021 0.861

D1=0.14m, L1=10.0m D2=0.20m, L2=400.0m
Q m^3 D1 m V1 m/s hst m f1 hf1 m hbe m D2 m V2 m/s f2 hf2 m hou m Δh m

0.005 0.140 0.325 0.005 0.023 0.009 0.001 0.200 0.159 0.025 0.064 0.001 0.080
0.010 0.140 0.650 0.022 0.021 0.033 0.004 0.200 0.318 0.022 0.229 0.005 0.293
0.015 0.140 0.974 0.048 0.020 0.069 0.009 0.200 0.477 0.021 0.486 0.012 0.624
0.020 0.140 1.299 0.086 0.019 0.118 0.016 0.200 0.637 0.020 0.828 0.021 1.068
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4) Main and Secondary Canal 

Main canal and secondary canal should be developed as described in “2.4 Main Canal and Secondary 
Canal”. 

2.4 Main Canal and Secondary Canal 

Main canal conveys the diverted water from the intake point to the farming land. An associated 
problem with main canal is how to align structures according to the topographic condition without 
using sophisticated survey equipment. Construction, on the other hand, is not so difficult since most of 
the work required could be done with simple tools such as hoe, shovel, trowel etc. It is desirable that 
brick masonry canal should be used for main canal due to its easiness on maintenance and better water 
flow capacity than earth canal. 

(1) Rehabilitation/Construction Criteria 

1) Material  

Most of materials for rehabilitation work should be locally sourced with minimum use of outside 
materials. Local materials include; sand, stone, bricks, soil etc. and cement, pipes and tools are inputs 
from outside.  

2) Labor  

The rehabilitation work should be done by the farmers under supervision of AEDOs and IOs. Labor 
force should be provided by the farmers association. Only transportation for materials (if necessary) 
should be provided from outside. 

(2) Investigation 

Field investigations should be carried out at and around the site on necessary items for design, 
construction, rehabilitation and O&M. Prior to the investigations selecting necessary items for 
investigation, the appropriate investigation plan should be put in practice. The results of investigation 
are essential for design of canal system. 

1) Meteorological and hydrological investigations 

Meteorological and hydrological conditions of the site should be investigated through data collection 
and observation. Items for meteorological and hydrological investigation include temperature, 
precipitation, evaporation, wind direction, wind velocity.  

2) Soil and geological investigation 

Soil tests of geological investigations, including the collection of geological data reconnaissance are 
important to be carried out along the proposed canal route to understand the geological structure, the 
physical properties of the soil, the ground water table and other conditions. 

3) Topographic investigations 

Topography of the site and surrounding area should be clarified through data collection and 
topographic survey. Topographic investigations are important to determine the alignment of canals and 
location of gully crossing and road crossing. 

i) Plane survey 
Plane survey is necessary for design of facilities and planning of construction. The location and 
route of canals, gully and road should be indicated. It is desirable to draw contour lines on the 
map. 
 
ii) Longitudinal and cross section  
Profile and cross section of the canal are used for determining canal alignment.  
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iii) Collection of topographic and other related maps 
Prior to field investigations and surveys, topographic maps and other related maps around the 
scheme should be collected in order to prepare the investigation schedule, and to make a 
preliminary design. 

4) Investigation for construction works 

Investigation for construction works should be conducted on the following items, which are necessary 
for construction planning. 

i) Meteorology, surface water, ground water 
Meteorology and surface water should be thoroughly investigated because of their utmost 
importance for deciding the construction schedule. Especially, temperature is important for 
work plan of concrete (mortar) works. 

ii) Construction equipment and materials 
Construction materials include cement, soil, sand, gravel, stone, steel materials, bricks and 
timber etc. The supply situation of materials should be checked. Availability of local materials, 
necessity of transportation, availability of transportation and availability of tools should be 
checked. Transportation of materials should be arranged if necessary.  

5) Investigation for rehabilitation of existing facilities 

In case of rehabilitation of existing dam, following items should be investigated in addition to above 
items. (Refer to the Table 2-29) 

i) Present condition of existing facilities 
ii) Topographical survey for rehabilitation items 
iii) Data on water use management of existing facilities. 
iv) Operation and maintenance system of existing facilities 

Table 2-29 List of Items to be Investigated (Main and Secondary Canal) 

Items Description Method Outputs 
1.Meteorological and 
hydrological 
investigations 

- Collection of 
meteorological and 
hydrological data 

- Data collection and 
site observation 
 

- Annual rainfall, 
temperature, wind 
direction, wind velocity,etc.

2. Soil and geological 
investigation 
(i) Geological data 
 
 
(ii) Surface geological 
survey 

 
 
- Collection of existing 
geological data 
 
- To grasp the condition 
of the field 

 
 
- Data collection 
 
 
- Site surveying, 
observation 

 
 
Topographic map, aerial 
photographs, geological 
map, soil texture, soil map 
Ground water table =  
Soil character, unstable 
topography, gully 

3. Topographic 
investigations 
(i) Plane survey 
 
 
 
(ii) Longitudinal and 
cross section 
 
 
(iii) Collection of 
topographic and other 
related maps. 

 
 
- Land topography, 
boundaries, existing 
structures, location of 
gully, location of road 
- Longitudinal section of 
canal center line 
- Cross section of canal 
center line 
- Available maps around 
the scheme 
 

 
 
- Site surveying with 
measuring tape and 
compass. Plane table 
 
- Site survey with tape 
and level 
- ditto 
 
- Data collection 
 

 
 
Plan: scale 1/1000~1/2000 
 
 
 
Longitudinal section: scale 
1/200~1/500 
Cross section: scale 1/50 
 
Various maps 
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A

B

Aligning Canal by 

4. Construction works 
(i) Meteorology 
 
 
(ii) Construction 
equipment, materials, 
transportation 
 
 

 
- Collection of all 
existing meteorological 
data 
- Availability of materials 
 
- Number of available 
tools  
- Available transportation 
- Number of available 
labor 

 
- Data collection and 
site observation 
 
- Sand, Bricks, 
Cement 
- Wheelbarrow, 
Bucket, Shovel 
- Truck, tractor, oxcart
- Skilled labor, 
Unskilled labor 

 
Annual rainfall, Stream 
condition, temperature, 
water level 
= km from the site, = to be 
procured in    
=  units, =  pcs 
 
DAO, DA, ADD, Farmers 
=  number 

5. Rehabilitation of 
existing facilities 
(i) Present condition of 
existing facilities 
 
 
 
 
 
 
 
 
 
 
(ii) Topographical 
survey for rehabilitation 
items 
 
 
 
(iii) Investigation on 
water use management 
of existing canals 
(iv) Operation and 
maintenance system of 
existing canals 

 
 
-Dimensions of existing 
structures 
 
- Cracks   
- Damage of structures 
- Water leakage  
- Freeboard  
- Water flow condition 
- Function, capacity of 
canals 
- Sediment 
- Safety 
- Longitudinal section of 
the structures to be 
rehabilitated. 
- Cross section of the 
structures to be 
rehabilitated. 
- Discharge  
- Irrigation schedule 
- Water flow depth 
- Operation and 
maintenance 
 

 
 
- Site investigation, 
observation, 
measuring tape. 
- ditto 
- ditto 
- ditto 
- ditto 
- ditto 
- ditto 
 
- ditto 
- ditto 
- Site surveying with 
measuring tape and 
compass. Plane table. 
 
 
 
- Daily operation 
record 
 
- Operation and 
maintenance record 
 

 
 
Length=  m, width =  m 
Depth=  m, Elevation 
 
Location, length, width 
Location, situation 
Location, quantity = lit/min
Fb=  m 
Stable or not 
Enough or not 
 
Configuration and depth 
Good or bad 
Longitudinal section: scale 
1/200~1/500 
Cross section: scale 1/50 
 
 
 
Daily discharge for the 
canal. 
Depth =  
Operation and maintenance 
record. 
 

(3) Rehabilitation/Construction Planning/Design 

1) Canal Alignment 

Recommended way of canal alignment 
is to use line level.  Interval of the 
two poles should preferably be 5 meter, 
and one side of the tied points should 
be 0.5 – 1 cm higher than the other.  
Pole with higher tied point should 
always be placed foreside, not like 
conventional alternate placing.  0.5 
cm difference in 5 meter gives 1:1000 
gradient suitable for gentle topography, 
and 1 cm gives 1:500 gradient 
adaptable for sloped topography. 
Figure 2-17 shows the process of 
canal alignment. 

Figure 2-17 Illustration of Canal Alignment Procedure 
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2) Canal Lining  

Canal is categorized into two; either non-lining or lined. Lining is made of brick or stone masonry 
(concrete lining is sometimes seen but the cost beyond farmers’ affordability excludes this option). 

Earth canal is the most simple and economical. With simple tools such as hoe, hand shovel, and 
wheelbarrow, construction is very easy and cheap. However, since this is non-lining, water conveyance 
loss is high due to seepage/leakage and much maintenance works such as grass cutting, de-silting, 
reshaping of cross section and so on are needed in every season.  

Lining can be done with clay soil, plastic paper, stone, brick, or masonry. These canals reduce the 
canal conveyance loss and also minimize maintenance works as compared to earth canal. In particular, 
reducing the canal conveyance loss becomes very important when diversion water is not enough to 
cover all the prospective service area. Lining can also prevent the canal from being eroded, which in 
turn minimizes the maintenance work and makes canal life longer. 

Investment for lining, on the other hand, is higher than earth canal except for clay, stone and recycled 
plastic paper linings. Farmers in rural area make bricks by themselves. Therefore, brick lining is 
cheaper than stone masonry, and damaged parts or bricks can easily be replaced by the farmers. Stone 
masonry lining is more durable than brick, but requires much cement, which may go beyond the 
farmers’ affordability. 

Considering medium scale irrigation water discharge, there are not so many lined, and in case of earth 
lining, leakages might happen and maintenance work is be required. Therefore, brick masonry should 
be used for main and secondary canal. 

3) Canal Design 

i) Cross-section and side-slopes 
For earth canals, standard trapezoidal shape is commonly used. Required slope depends on the 
stability of the soil. Recommendable side slopes for different soils are given in Table 2-30 
below: 

Table 2-30 Recommended Side Slopes for Different Types of Soils 
 
 
 
 
 
 

Generally, rectangular cross section requires less excavation and less quantity of bricks. 
Considering safety of structure, it is recommendable to adopt trapezoid cross section. However, 
rectangular cross section may be adopted in case that the depth is less than 0.6 m, due to small 
soil pressure. 

ii) Freeboard 
Freeboard acts as a reserve depth in a canal to allow some variations in water flow. The 
freeboard is decided according to the planned discharge; more discharge, higher free board and 
less discharge, smaller free board. Irrigation schemes undertaken in this Guideline are 
medium-scale, therefore a minimum 10 cm to maximum of about 20 cm freeboard is 
recommended.  
iii) Allowable flow velocity 
The design velocity of canals must be determined within the limits of two factors; namely, 1) 
the minimum allowable velocity that causes neither accumulation of sediment of soils nor 
growth of waterweeds, and 2) the maximum allowable velocity that does not produce erosion 
of canal materials by the flow. Refer Table 2-31 for Maximum allowable velocities of different 
types of canals. 

Type of Soils 
Recommendable Side 

Slope 
(Ver.) : (Hor.) 

Clay 2 : 1 
All other soils 2 : 1 
Sand 1 : 1 

 
                          

Ver. 
                           

Hor. 
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The minimum allowable velocity: 0.45 – 0.90 m/sec 
 
Within this range of mean velocity, soil sediments are not accumulated in a canal where the 
particle size of suspended sediment is not larger than silt. Waterweeds hindering the flow 
capacity of the canal do not grow when the mean velocity is more than 0.7 m/sec. 

Table 2-31 Maximum Allowable Velocity 

 
 
 
 
 
 
 

Table 2-32 Value of Roughness Coefficient 

Roughness Coefficient Materials and conditions of canals 
Minimum value Standard value Maximum value 

Concrete (cast-in-place flume, culvert, etc.) 
Concrete (shotcrete) 
Concrete (with precast flume, pipe, etc.) 
Concrete (reinforced concrete pipe) 
Concrete block masonry 
Cement (mortar) 
Asbestos cement pipe 
Steel (locked bar or welded) 
Steel (revet) 
Smooth steel surface (not painted) 
Smooth steel surface and pipe (painted) 
Corrugated surface (steel sheet) 
Cast iron (not painted) 
Cast iron sheet and pipe (painted) 
Chloride vinyl pipe 
Reinforced plastic 
Ceramic pipe 
Earth lining 
Asphalt (smooth surface) 
Asphalt (rough stone) 
Masonry (rough stone wet masonry) 
Masonry (rough stone dry masonry) 
Wood (wooden gutter) 
Wood (lined in thin layer, treated with creosote) 
Rock tunnel with no lining on overall 
cross-sectional area 
Rock tunnel with no lining except concrete placed 
on the bottom 
Vegetation coverage (turfing) 

0.012 
0.016 
0.012 
0.011 
0.014 
0.011 
0.011 
0.010 
0.013 
0.011 
0.012 
0.021 
0.011 
0.010 

 
 

0.011 
 
 
 

0.017 
0.023 
0.010 
0.015 

 
0.030 

 
0.020 
0.030 

0.015 
0.019 
0.014 
0.013 
0.016 
0.013 
0.013 
0.012 
0.016 
0.012 
0.013 
0.025 
0.014 
0.013 
0.012 
0.012 
0.014 
0.025 
0.014 
0.017 
0.025 
0.032 
0.012 
0.017 

 
0.035 

 
0.025 
0.04 

0.016 
0.023 
0.016 
0.014 
0.017 
0.015 
0.014 
0.014 
0.017 
0.014 
0.017 
0.030 
0.016 
0.014 

 
 

0.017 
 
 
 

0.030 
0.035 
0.014 
0.020 

 
0.040 

 
0.030 
0.050 

Source: Engineering Manual for Irrigation and Drainage Canal Works, The Japanese Institute of 
Irrigation and Drainage 1987. 

4) Canal slope (earth) 

Steep canal slope creates erosion due to its high flow velocity though it. On the other hand, too gentle 

Type of Canal 
Material 

Maximum Allowable 
Velocity, (m/s) 

Type of Canal 
Material 

Maximum Allowable 
Velocity, (m/s) 

Sandy soil 0.4 - 0.6 
Sand-loam   0.5 - 0.7 

Thin concrete 
(approx.10cm) 1.5 - 2.5 

Clay-loam 0.6 - 0.9 
Clay   0.9 - 1.5 
Rock 1.0 - 2.0 

Brick masonry with 
mortar filled 2.50 
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slope cause heavy silting in the canal and also enlarges canal section to accommodate the required 
flow. Canal slope depends on the difference between the elevation at intake and farmland. If the slope 
is too steep and the water velocity is too high, the slope should be made gentler by setting a drop. If 
the slope can not be made steeper, frequent maintenance of de-silting should be required. 

5) Canal dimension (brick) 

The minimum canal bed width should be 0.23m considering size of brick and maintenance work. 
Standard cross section of canal is shown in Figure 2-18 and 2-19. 

Figure 2-18 Standard Cross Section of Canal (B=0.34m, Rectangular) 

 

Figure 2-19 Standard Cross Section of Canal (B=0.34m, Trapezoid) 

 

The recommended canal dimension; bottom width, water depth and total depth (= water depth + 
freeboard) for different design discharges and canal slopes and are presented in Table 2-33 below: 

 

 

 

 

 

     Main Canal (Rectangular)

100mm
360m

H

8
0
m

m

brick 220x100x80mm

mortar t=15mm

brick

360mm

H1
.0

0.5

mortar t=15mm
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Table 2-33 Recommended Canal Dimension for Various Discharges 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     S id e  S lo p e  0 .5  : 1 .0
Q = 5  lit / s B e d  W id th C a n a l S lo p e S id e  S lo p e W a te r  D e p th V e lo c it y F re e b o a rd C a n a l D e p th

(m ) (% ) V e r  : H o r (m ) (m / s ) (m ) (m )
0 .2 3 0 .0 2 0 0 .5  : 1 .0 0 .1 1 7 0 .1 4 8 0 .1 3 3 0 .2 5 0
0 .2 3 0 .0 2 5 0 .5  : 1 .0 0 .1 0 9 0 .1 6 1 0 .1 4 1 0 .2 5 0
0 .2 3 0 .0 3 3 0 .5  : 1 .0 0 .1 0 0 0 .1 7 8 0 .1 5 0 0 .2 5 0
0 .2 3 0 .0 4 0 0 .5  : 1 .0 0 .0 9 5 0 .1 9 0 0 .1 5 5 0 .2 5 0
0 .2 3 0 .0 5 0 0 .5  : 1 .0 0 .0 8 8 0 .2 0 6 0 .1 6 2 0 .2 5 0
0 .2 3 0 .1 0 0 0 .5  : 1 .0 0 .0 7 1 0 .2 6 4 0 .1 7 9 0 .2 5 0
0 .2 3 0 .2 0 0 0 .5  : 1 .0 0 .0 5 8 0 .3 3 5 0 .1 9 2 0 .2 5 0
0 .2 3 0 .3 3 3 0 .5  : 1 .0 0 .0 4 9 0 .3 9 9 0 .2 0 1 0 .2 5 0
0 .2 3 0 .5 0 0 0 .5  : 1 .0 0 .0 4 3 0 .4 5 8 0 .2 0 7 0 .2 5 0

    S id e  S lo p e  0 .0  : 1 .0
Q = 5  lit / s B e d  W id th C a n a l S lo p e S id e  S lo p e W a te r  D e p th V e lo c it y F re e b o a rd C a n a l D e p th

(m ) (% ) V e r  : H o r (m ) (m / s ) (m ) (m )
0 .2 3 0 .0 2 0 0 .0  : 1 .0 0 .1 5 2 0 .1 4 3 0 .1 4 8 0 .3 0 0
0 .2 3 0 .0 2 5 0 .0  : 1 .0 0 .1 3 9 0 .1 5 6 0 .1 1 1 0 .2 5 0
0 .2 3 0 .0 3 3 0 .0  : 1 .0 0 .1 2 5 0 .1 7 4 0 .1 2 5 0 .2 5 0
0 .2 3 0 .0 4 0 0 .0  : 1 .0 0 .1 1 6 0 .1 8 7 0 .1 3 4 0 .2 5 0
0 .2 3 0 .0 5 0 0 .0  : 1 .0 0 .1 0 7 0 .2 0 3 0 .1 4 3 0 .2 5 0
0 .2 3 0 .1 0 0 0 .0  : 1 .0 0 .0 8 3 0 .2 6 2 0 .1 6 7 0 .2 5 0
0 .2 3 0 .2 0 0 0 .0  : 1 .0 0 .0 6 5 0 .3 3 5 0 .1 8 5 0 .2 5 0
0 .2 3 0 .3 3 3 0 .0  : 1 .0 0 .0 5 4 0 .4 0 0 0 .1 9 6 0 .2 5 0
0 .2 3 0 .5 0 0 0 .0  : 1 .0 0 .0 4 7 0 .4 5 9 0 .2 0 3 0 .2 5 0

     S id e  S lo p e  0 .5  :  1 .0
Q = 1 5  l it / s B e d  W id t h C a n a l S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c it y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) (m ) ( m )
0 .3 4 0 .0 2 0 0 .5  :  1 .0 0 .1 7 9 0 .1 9 5 0 .1 2 1 0 .3 0 0
0 .3 4 0 .0 2 5 0 .5  :  1 .0 0 .1 6 7 0 .2 1 2 0 .1 3 3 0 .3 0 0
0 .2 3 0 .0 3 3 0 .5  :  1 .0 0 .1 9 3 0 .2 3 8 0 .1 0 7 0 .3 0 0
0 .2 3 0 .0 4 0 0 .5  :  1 .0 0 .1 8 3 0 .2 5 5 0 .1 1 7 0 .3 0 0
0 .2 3 0 .0 5 0 0 .5  :  1 .0 0 .1 7 1 0 .2 7 7 0 .1 2 9 0 .3 0 0
0 .2 3 0 .1 0 0 0 .5  :  1 .0 0 .1 4 0 0 .3 5 8 0 .1 1 0 0 .2 5 0
0 .2 3 0 .2 0 0 0 .5  :  1 .0 0 .1 1 3 0 .4 6 2 0 .1 3 7 0 .2 5 0
0 .2 3 0 .3 3 3 0 .5  :  1 .0 0 .0 9 7 0 .5 5 6 0 .1 5 3 0 .2 5 0
0 .2 3 0 .5 0 0 0 .5  :  1 .0 0 .0 8 6 0 .6 4 2 0 .1 6 4 0 .2 5 0

    S id e  S lo p e  0 .0  :  1 .0
Q = 1 5  l it / s B e d  W id t h C a n a l S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c it y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) (m ) ( m )
0 .3 4 0 .0 2 0 0 .0  :  1 .0 0 .2 3 4 0 .1 8 8 0 .1 1 6 0 .3 5 0
0 .3 4 0 .0 2 5 0 .0  :  1 .0 0 .2 1 5 0 .2 0 6 0 .1 3 5 0 .3 5 0
0 .3 4 0 .0 3 3 0 .0  :  1 .0 0 .1 9 2 0 .2 3 0 0 .1 0 8 0 .3 0 0
0 .3 4 0 .0 4 0 0 .0  :  1 .0 0 .1 7 9 0 .2 4 6 0 .1 2 1 0 .3 0 0
0 .3 4 0 .0 5 0 0 .0  :  1 .0 0 .1 6 5 0 .2 6 7 0 .1 3 5 0 .3 0 0
0 .2 3 0 .1 0 0 0 .0  :  1 .0 0 .1 9 1 0 .3 4 1 0 .1 0 9 0 .3 0 0
0 .2 3 0 .2 0 0 0 .0  :  1 .0 0 .1 4 5 0 .4 4 8 0 .1 0 5 0 .2 5 0
0 .2 3 0 .3 3 3 0 .0  :  1 .0 0 .1 2 0 0 .5 4 5 0 .1 3 0 0 .2 5 0
0 .2 3 0 .5 0 0 0 .0  :  1 .0 0 .1 0 3 0 .6 3 4 0 .1 4 7 0 .2 5 0

     S id e  S lo p e  0 .5  :  1 .0
Q = 1 0  l it / s B e d  W id t h C a n a l S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c it y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) (m ) ( m )
0 .2 3 0 .0 2 0 0 .5  :  1 .0 0 .1 7 7 0 .1 7 8 0 .1 2 3 0 .3 0 0
0 .2 3 0 .0 2 5 0 .5  :  1 .0 0 .1 6 6 0 .1 9 3 0 .1 3 4 0 .3 0 0
0 .2 3 0 .0 3 3 0 .5  :  1 .0 0 .1 5 2 0 .2 1 5 0 .1 4 8 0 .3 0 0
0 .2 3 0 .0 4 0 0 .5  :  1 .0 0 .1 4 4 0 .2 3 0 0 .1 0 6 0 .2 5 0
0 .2 3 0 .0 5 0 0 .5  :  1 .0 0 .1 3 5 0 .2 4 9 0 .1 1 5 0 .2 5 0
0 .2 3 0 .1 0 0 0 .5  :  1 .0 0 .1 0 9 0 .3 2 1 0 .1 4 1 0 .2 5 0
0 .2 3 0 .2 0 0 0 .5  :  1 .0 0 .0 8 8 0 .4 1 2 0 .1 6 2 0 .2 5 0
0 .2 3 0 .3 3 3 0 .5  :  1 .0 0 .0 7 6 0 .4 9 4 0 .1 7 4 0 .2 5 0
0 .2 3 0 .5 0 0 0 .5  :  1 .0 0 .0 6 7 0 .5 7 0 0 .1 8 3 0 .2 5 0

    S id e  S lo p e  0 .0  :  1 .0
Q = 1 0  l it / s B e d  W id t h C a n a l S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c it y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) (m ) ( m )
0 .3 4 0 .0 2 0 0 .0  :  1 .0 0 .1 7 2 0 .1 7 1 0 .1 2 8 0 .3 0 0
0 .3 4 0 .0 2 5 0 .0  :  1 .0 0 .1 5 8 0 .1 8 6 0 .1 4 2 0 .3 0 0
0 .3 4 0 .0 3 3 0 .0  :  1 .0 0 .1 4 2 0 .2 0 7 0 .1 5 8 0 .3 0 0
0 .2 3 0 .0 4 0 0 .0  :  1 .0 0 .1 9 9 0 .2 1 8 0 .1 0 1 0 .3 0 0
0 .2 3 0 .0 5 0 0 .0  :  1 .0 0 .1 8 2 0 .2 3 9 0 .1 1 8 0 .3 0 0
0 .2 3 0 .1 0 0 0 .0  :  1 .0 0 .1 3 9 0 .3 1 3 0 .1 1 1 0 .2 5 0
0 .2 3 0 .2 0 0 0 .0  :  1 .0 0 .1 0 7 0 .4 0 6 0 .1 4 3 0 .2 5 0
0 .2 3 0 .3 3 3 0 .0  :  1 .0 0 .0 8 9 0 .4 9 0 0 .1 6 1 0 .2 5 0
0 .2 3 0 .5 0 0 0 .0  :  1 .0 0 .0 7 7 0 .5 6 7 0 .1 7 3 0 .2 5 0
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     S id e  S lo p e  0 . 5  :  1 . 0
Q = 2 0  l i t / s B e d  W i d t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 3 4 0 . 0 2 0 0 .5  :  1 . 0 0 . 2 1 3 0 .2 1 1 0 .1 3 7 0 .3 5 0
0 .3 4 0 . 0 2 5 0 .5  :  1 . 0 0 . 1 9 9 0 .2 2 9 0 .1 5 1 0 .3 5 0
0 .3 4 0 . 0 3 3 0 .5  :  1 . 0 0 . 1 8 2 0 .2 5 4 0 .1 1 8 0 .3 0 0
0 .3 4 0 . 0 4 0 0 .5  :  1 . 0 0 . 1 7 3 0 .2 7 2 0 .1 2 7 0 .3 0 0
0 .3 4 0 . 0 5 0 0 .5  :  1 . 0 0 . 1 6 1 0 .2 9 5 0 .1 3 9 0 .3 0 0
0 .2 3 0 . 1 0 0 0 .5  :  1 . 0 0 . 1 6 6 0 .3 8 6 0 .1 3 4 0 .3 0 0
0 .2 3 0 . 2 0 0 0 .5  :  1 . 0 0 . 1 3 5 0 .4 9 9 0 .1 1 5 0 .2 5 0
0 .2 3 0 . 3 3 3 0 .5  :  1 . 0 0 . 1 1 6 0 .6 0 2 0 .1 3 4 0 .2 5 0
0 .2 3 0 . 5 0 0 0 .5  :  1 . 0 0 . 1 0 2 0 .6 9 7 0 .1 4 8 0 .2 5 0

    S id e  S lo p e  0 . 0  :  1 . 0
Q = 2 0  l i t / s B e d  W i d t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 3 4 0 . 0 2 0 0 .0  :  1 . 0 0 . 2 9 4 0 .2 0 0 0 .1 0 6 0 .4 0 0
0 .3 4 0 . 0 2 5 0 .0  :  1 . 0 0 . 2 6 9 0 .2 1 9 0 .1 3 1 0 .4 0 0
0 .3 4 0 . 0 3 3 0 .0  :  1 . 0 0 . 2 4 0 0 .2 4 5 0 .1 1 0 0 .3 5 0
0 .3 4 0 . 0 4 0 0 .0  :  1 . 0 0 . 2 2 4 0 .2 6 3 0 .1 2 6 0 .3 5 0
0 .3 4 0 . 0 5 0 0 .0  :  1 . 0 0 . 2 0 5 0 .2 8 7 0 .1 4 5 0 .3 5 0
0 .3 4 0 . 1 0 0 0 .0  :  1 . 0 0 . 1 5 8 0 .3 7 3 0 .1 4 2 0 .3 0 0
0 .2 3 0 . 2 0 0 0 .0  :  1 . 0 0 . 1 8 2 0 .4 7 7 0 .1 1 8 0 .3 0 0
0 .2 3 0 . 3 3 3 0 .0  :  1 . 0 0 . 1 4 9 0 .5 8 3 0 .1 0 1 0 .2 5 0
0 .2 3 0 . 5 0 0 0 .0  :  1 . 0 0 . 1 2 8 0 .6 8 1 0 .1 2 2 0 .2 5 0

     S id e  S lo p e  0 . 5  :  1 . 0
Q = 3 0  l i t / s B e d  W i d t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 3 4 0 . 0 2 0 0 .5  :  1 . 0 0 . 2 7 0 0 .2 3 4 0 .1 3 0 0 .4 0 0
0 .3 4 0 . 0 2 5 0 .5  :  1 . 0 0 . 2 5 3 0 .2 5 4 0 .1 4 7 0 .4 0 0
0 .3 4 0 . 0 3 3 0 .5  :  1 . 0 0 . 2 3 3 0 .2 8 3 0 .1 1 7 0 .3 5 0
0 .3 4 0 . 0 4 0 0 .5  :  1 . 0 0 . 2 2 0 0 .3 0 3 0 .1 3 0 0 .3 5 0
0 .3 4 0 . 0 5 0 0 .5  :  1 . 0 0 . 2 0 6 0 .3 2 9 0 .1 4 4 0 .3 5 0
0 .2 3 0 . 1 0 0 0 .5  :  1 . 0 0 . 2 1 0 0 .4 2 7 0 .1 4 0 0 .3 5 0
0 .2 3 0 . 2 0 0 0 .5  :  1 . 0 0 . 1 7 1 0 .5 5 4 0 .1 2 9 0 .3 0 0
0 .2 3 0 . 3 3 3 0 .5  :  1 . 0 0 . 1 4 7 0 .6 7 0 0 .1 0 3 0 .2 5 0
0 .2 3 0 . 5 0 0 0 .5  :  1 . 0 0 . 1 3 1 0 .7 7 8 0 .1 1 9 0 .2 5 0

    S id e  S lo p e  0 . 0  :  1 . 0
Q = 3 0  l i t / s B e d  W i d t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 .0  :  1 . 0 0 . 2 9 7 0 .2 2 5 0 .1 5 3 0 .4 5 0
0 .4 5 0 . 0 2 5 0 .0  :  1 . 0 0 . 2 7 2 0 .2 4 5 0 .1 2 8 0 .4 0 0
0 .3 4 0 . 0 3 3 0 .0  :  1 . 0 0 . 3 3 2 0 .2 6 6 0 .1 1 8 0 .4 5 0
0 .3 4 0 . 0 4 0 0 .0  :  1 . 0 0 . 3 0 8 0 .2 8 6 0 .1 4 2 0 .4 5 0
0 .3 4 0 . 0 5 0 0 .0  :  1 . 0 0 . 2 8 2 0 .3 1 3 0 .1 1 8 0 .4 0 0
0 .3 4 0 . 1 0 0 0 .0  :  1 . 0 0 . 2 1 5 0 .4 1 1 0 .1 3 5 0 .3 5 0
0 .3 4 0 . 2 0 0 0 .0  :  1 . 0 0 . 1 6 5 0 .5 3 5 0 .1 3 5 0 .3 0 0
0 .2 3 0 . 3 3 3 0 .0  :  1 . 0 0 . 2 0 6 0 .6 3 5 0 .1 4 4 0 .3 5 0
0 .2 3 0 . 5 0 0 0 .0  :  1 . 0 0 . 1 7 5 0 .7 4 6 0 .1 2 5 0 .3 0 0

     S i d e  S l o p e  0 . 5  :  1 . 0
Q = 4 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 3 4 0 . 0 2 0 0 . 5  :  1 . 0 0 . 3 1 9 0 . 2 5 1 0 . 1 3 1 0 . 4 5 0
0 . 3 4 0 . 0 2 5 0 . 5  :  1 . 0 0 . 2 9 9 0 . 2 7 3 0 . 1 5 1 0 . 4 5 0
0 . 3 4 0 . 0 3 3 0 . 5  :  1 . 0 0 . 2 7 5 0 . 3 0 4 0 . 1 2 5 0 . 4 0 0
0 . 3 4 0 . 0 4 0 0 . 5  :  1 . 0 0 . 2 6 1 0 . 3 2 6 0 . 1 3 9 0 . 4 0 0
0 . 3 4 0 . 0 5 0 0 . 5  :  1 . 0 0 . 2 4 4 0 . 3 5 4 0 . 1 5 6 0 . 4 0 0
0 . 2 3 0 . 1 0 0 0 . 5  :  1 . 0 0 . 2 4 7 0 . 4 5 8 0 . 1 0 3 0 . 3 5 0
0 . 2 3 0 . 2 0 0 0 . 5  :  1 . 0 0 . 2 0 3 0 . 5 9 5 0 . 1 4 7 0 . 3 5 0
0 . 2 3 0 . 3 3 3 0 . 5  :  1 . 0 0 . 1 7 5 0 . 7 2 1 0 . 1 2 5 0 . 3 0 0
0 . 2 3 0 . 5 0 0 0 . 5  :  1 . 0 0 . 1 5 5 0 . 8 3 9 0 . 1 4 5 0 . 3 0 0

    S i d e  S l o p e  0 . 0  :  1 . 0
Q = 4 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 . 0  :  1 . 0 0 . 3 7 3 0 . 2 3 9 0 . 1 2 7 0 . 5 0 0
0 . 4 5 0 . 0 2 5 0 . 0  :  1 . 0 0 . 3 4 1 0 . 2 6 1 0 . 1 0 9 0 . 4 5 0
0 . 3 4 0 . 0 3 3 0 . 0  :  1 . 0 0 . 4 2 1 0 . 2 7 9 0 . 1 2 9 0 . 5 5 0
0 . 3 4 0 . 0 4 0 0 . 0  :  1 . 0 0 . 3 9 0 0 . 3 0 1 0 . 1 1 0 0 . 5 0 0
0 . 3 4 0 . 0 5 0 0 . 0  :  1 . 0 0 . 3 5 6 0 . 3 3 1 0 . 1 4 4 0 . 5 0 0
0 . 3 4 0 . 1 0 0 0 . 0  :  1 . 0 0 . 2 6 9 0 . 4 3 8 0 . 1 3 1 0 . 4 0 0
0 . 3 4 0 . 2 0 0 0 . 0  :  1 . 0 0 . 2 0 5 0 . 5 7 4 0 . 1 4 5 0 . 3 5 0
0 . 2 3 0 . 3 3 3 0 . 0  :  1 . 0 0 . 2 6 0 0 . 6 6 9 0 . 1 4 0 0 . 4 0 0
0 . 2 3 0 . 5 0 0 0 . 0  :  1 . 0 0 . 2 2 0 0 . 7 9 0 0 . 1 3 0 0 . 3 5 0

     S i d e  S l o p e  0 . 5  :  1 . 0
Q = 5 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 3 4 0 . 0 2 0 0 . 5  :  1 . 0 0 . 3 6 2 0 . 2 6 5 0 . 1 3 8 0 . 5 0 0
0 . 3 4 0 . 0 2 5 0 . 5  :  1 . 0 0 . 3 4 0 0 . 2 8 8 0 . 1 1 0 0 . 4 5 0
0 . 3 4 0 . 0 3 3 0 . 5  :  1 . 0 0 . 3 1 3 0 . 3 2 1 0 . 1 3 7 0 . 4 5 0
0 . 3 4 0 . 0 4 0 0 . 5  :  1 . 0 0 . 2 9 7 0 . 3 4 4 0 . 1 0 3 0 . 4 0 0
0 . 3 4 0 . 0 5 0 0 . 5  :  1 . 0 0 . 2 7 9 0 . 3 7 4 0 . 1 2 1 0 . 4 0 0
0 . 2 3 0 . 1 0 0 0 . 5  :  1 . 0 0 . 2 8 0 0 . 4 8 3 0 . 1 2 0 0 . 4 0 0
0 . 2 3 0 . 2 0 0 0 . 5  :  1 . 0 0 . 2 3 0 0 . 6 2 9 0 . 1 2 0 0 . 3 5 0
0 . 2 3 0 . 3 3 3 0 . 5  :  1 . 0 0 . 1 9 9 0 . 7 6 3 0 . 1 5 1 0 . 3 5 0
0 . 2 3 0 . 5 0 0 0 . 5  :  1 . 0 0 . 1 7 7 0 . 8 8 8 0 . 1 2 3 0 . 3 0 0

    S i d e  S l o p e  0 . 0  :  1 . 0
Q = 5 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 . 0  :  1 . 0 0 . 4 4 6 0 . 2 4 9 0 . 1 0 4 0 . 5 5 0
0 . 4 5 0 . 0 2 5 0 . 0  :  1 . 0 0 . 4 0 7 0 . 2 7 3 0 . 1 4 3 0 . 5 5 0
0 . 4 5 0 . 0 3 3 0 . 0  :  1 . 0 0 . 3 6 3 0 . 3 0 6 0 . 1 3 7 0 . 5 0 0
0 . 4 5 0 . 0 4 0 0 . 0  :  1 . 0 0 . 3 3 8 0 . 3 2 9 0 . 1 6 2 0 . 5 0 0
0 . 4 5 0 . 0 5 0 0 . 0  :  1 . 0 0 . 3 0 9 0 . 3 5 9 0 . 1 4 1 0 . 4 5 0
0 . 3 4 0 . 1 0 0 0 . 0  :  1 . 0 0 . 3 2 2 0 . 4 5 7 0 . 1 2 8 0 . 4 5 0
0 . 2 3 0 . 2 0 0 0 . 0  :  1 . 0 0 . 2 4 4 0 . 6 0 3 0 . 1 0 6 0 . 3 5 0
0 . 2 3 0 . 3 3 3 0 . 0  :  1 . 0 0 . 2 0 0 0 . 7 3 5 0 . 1 5 0 0 . 3 5 0
0 . 2 3 0 . 5 0 0 0 . 0  :  1 . 0 0 . 1 7 2 0 . 8 5 7 0 . 1 2 8 0 . 3 0 0
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     S id e  S lo p e  0 . 5  :  1 . 0
Q = 6 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 3 4 0 . 0 2 0 0 .5  :  1 . 0 0 . 4 0 1 0 .2 7 7 0 .1 4 9 0 .5 5 0
0 .3 4 0 . 0 2 5 0 .5  :  1 . 0 0 . 3 7 7 0 .3 0 1 0 .1 2 3 0 .5 0 0
0 .3 4 0 . 0 3 3 0 .5  :  1 . 0 0 . 3 4 8 0 .3 3 6 0 .1 0 2 0 .4 5 0
0 .3 4 0 . 0 4 0 0 .5  :  1 . 0 0 . 3 3 0 0 .3 6 0 0 .1 2 0 0 .4 5 0
0 .3 4 0 . 0 5 0 0 .5  :  1 . 0 0 . 3 1 0 0 .3 9 2 0 .1 4 0 0 .4 5 0
0 .3 4 0 . 1 0 0 0 .5  :  1 . 0 0 . 2 5 3 0 .5 0 8 0 .1 4 7 0 .4 0 0
0 .3 4 0 . 2 0 0 0 .5  :  1 . 0 0 . 2 0 6 0 .6 5 7 0 .1 4 4 0 .3 5 0
0 .2 3 0 . 3 3 3 0 .5  :  1 . 0 0 . 2 2 1 0 .7 9 8 0 .1 2 9 0 .3 5 0
0 .2 3 0 . 5 0 0 0 .5  :  1 . 0 0 . 1 9 7 0 .9 2 9 0 .1 0 3 0 .3 0 0

    S id e  S lo p e  0 . 0  :  1 . 0
Q = 6 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 5 6 0 . 0 2 0 0 .0  :  1 . 0 0 . 4 0 3 0 .2 6 6 0 .1 4 7 0 .5 5 0
0 .4 5 0 . 0 2 5 0 .0  :  1 . 0 0 . 4 7 3 0 .2 8 2 0 .1 2 7 0 .6 0 0
0 .4 5 0 . 0 3 3 0 .0  :  1 . 0 0 . 4 2 0 0 .3 1 7 0 .1 3 0 0 .5 5 0
0 .4 5 0 . 0 4 0 0 .0  :  1 . 0 0 . 3 9 1 0 .3 4 1 0 .1 0 9 0 .5 0 0
0 .4 5 0 . 0 5 0 0 .0  :  1 . 0 0 . 3 5 7 0 .3 7 3 0 .1 4 3 0 .5 0 0
0 .3 4 0 . 1 0 0 0 .0  :  1 . 0 0 . 3 7 4 0 .4 7 2 0 .1 2 6 0 .5 0 0
0 .3 4 0 . 2 0 0 0 .0  :  1 . 0 0 . 2 8 2 0 .6 2 6 0 .1 1 8 0 .4 0 0
0 .3 4 0 . 3 3 3 0 .0  :  1 . 0 0 . 2 3 0 0 .7 6 6 0 .1 2 0 0 .3 5 0
0 .3 4 0 . 5 0 0 0 .0  :  1 . 0 0 . 1 9 7 0 .8 9 6 0 .1 0 3 0 .3 0 0

     S id e  S lo p e  0 . 5  :  1 . 0
Q = 7 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 .5  :  1 . 0 0 . 3 7 9 0 .2 8 9 0 .1 2 1 0 .5 0 0
0 .4 5 0 . 0 2 5 0 .5  :  1 . 0 0 . 3 5 5 0 .3 1 4 0 .1 4 5 0 .5 0 0
0 .3 4 0 . 0 3 3 0 .5  :  1 . 0 0 . 3 7 9 0 .3 4 9 0 .1 2 1 0 .5 0 0
0 .3 4 0 . 0 4 0 0 .5  :  1 . 0 0 . 3 6 0 0 .3 7 4 0 .1 4 0 0 .5 0 0
0 .3 4 0 . 0 5 0 0 .5  :  1 . 0 0 . 3 3 8 0 .4 0 7 0 .1 1 2 0 .4 5 0
0 .3 4 0 . 1 0 0 0 .5  :  1 . 0 0 . 2 7 7 0 .5 2 8 0 .1 2 3 0 .4 0 0
0 .3 4 0 . 2 0 0 0 .5  :  1 . 0 0 . 2 2 6 0 .6 8 4 0 .1 2 4 0 .3 5 0
0 .2 3 0 . 3 3 3 0 .5  :  1 . 0 0 . 2 4 1 0 .8 2 8 0 .1 0 9 0 .3 5 0
0 .2 3 0 . 5 0 0 0 .5  :  1 . 0 0 . 2 1 5 0 .9 6 5 0 .1 3 5 0 .3 5 0

    S id e  S lo p e  0 . 0  :  1 . 0
Q = 7 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 5 6 0 . 0 2 0 0 .0  :  1 . 0 0 . 4 5 5 0 .2 7 5 0 .1 4 5 0 .6 0 0
0 .5 6 0 . 0 2 5 0 .0  :  1 . 0 0 . 4 1 6 0 .3 0 0 0 .1 3 4 0 .5 5 0
0 .4 5 0 . 0 3 3 0 .0  :  1 . 0 0 . 4 7 7 0 .3 2 6 0 .1 2 3 0 .6 0 0
0 .4 5 0 . 0 4 0 0 .0  :  1 . 0 0 . 4 4 2 0 .3 5 2 0 .1 0 8 0 .5 5 0
0 .4 5 0 . 0 5 0 0 .0  :  1 . 0 0 . 4 0 4 0 .3 8 5 0 .1 4 6 0 .5 5 0
0 .3 4 0 . 1 0 0 0 .0  :  1 . 0 0 . 4 2 5 0 .4 8 5 0 .1 2 5 0 .5 5 0
0 .3 4 0 . 2 0 0 0 .0  :  1 . 0 0 . 3 1 9 0 .6 4 5 0 .1 3 1 0 .4 5 0
0 .3 4 0 . 3 3 3 0 .0  :  1 . 0 0 . 2 6 0 0 .7 9 2 0 .1 4 0 0 .4 0 0
0 .3 4 0 . 5 0 0 0 .0  :  1 . 0 0 . 2 2 2 0 .9 2 8 0 .1 2 8 0 .3 5 0

     S i d e  S l o p e  0 . 5  :  1 . 0
Q = 8 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 . 5  :  1 . 0 0 . 4 0 9 0 . 2 9 9 0 . 1 4 1 0 . 5 5 0
0 . 4 5 0 . 0 2 5 0 . 5  :  1 . 0 0 . 3 8 4 0 . 3 2 5 0 . 1 1 6 0 . 5 0 0
0 . 4 5 0 . 0 3 3 0 . 5  :  1 . 0 0 . 3 5 3 0 . 3 6 2 0 . 1 4 7 0 . 5 0 0
0 . 3 4 0 . 0 4 0 0 . 5  :  1 . 0 0 . 3 8 8 0 . 3 8 6 0 . 1 1 2 0 . 5 0 0
0 . 3 4 0 . 0 5 0 0 . 5  :  1 . 0 0 . 3 6 5 0 . 4 2 0 0 . 1 3 5 0 . 5 0 0
0 . 3 4 0 . 1 0 0 0 . 5  :  1 . 0 0 . 2 9 9 0 . 5 4 6 0 . 1 0 1 0 . 4 0 0
0 . 3 4 0 . 2 0 0 0 . 5  :  1 . 0 0 . 2 4 4 0 . 7 0 8 0 . 1 5 6 0 . 4 0 0
0 . 2 3 0 . 3 3 3 0 . 5  :  1 . 0 0 . 2 6 0 0 . 8 5 5 0 . 1 4 0 0 . 4 0 0
0 . 2 3 0 . 5 0 0 0 . 5  :  1 . 0 0 . 2 3 2 0 . 9 9 7 0 . 1 1 8 0 . 3 5 0

    S i d e  S l o p e  0 . 0  :  1 . 0
Q = 8 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 6 7 0 . 0 2 0 0 . 0  :  1 . 0 0 . 4 1 5 0 . 2 8 7 0 . 1 3 5 0 . 5 5 0
0 . 5 6 0 . 0 2 5 0 . 0  :  1 . 0 0 . 4 6 3 0 . 3 0 9 0 . 1 3 7 0 . 6 0 0
0 . 5 6 0 . 0 3 3 0 . 0  :  1 . 0 0 . 4 1 3 0 . 3 4 6 0 . 1 3 7 0 . 5 5 0
0 . 4 5 0 . 0 4 0 0 . 0  :  1 . 0 0 . 4 9 4 0 . 3 6 0 0 . 1 0 6 0 . 6 0 0
0 . 4 5 0 . 0 5 0 0 . 0  :  1 . 0 0 . 4 5 0 0 . 3 9 5 0 . 1 5 0 0 . 6 0 0
0 . 4 5 0 . 1 0 0 0 . 0  :  1 . 0 0 . 3 4 1 0 . 5 2 2 0 . 1 0 9 0 . 4 5 0
0 . 4 5 0 . 2 0 0 0 . 0  :  1 . 0 0 . 2 6 0 0 . 6 8 3 0 . 1 4 0 0 . 4 0 0
0 . 3 4 0 . 3 3 3 0 . 0  :  1 . 0 0 . 2 8 9 0 . 8 1 4 0 . 1 1 1 0 . 4 0 0
0 . 3 4 0 . 5 0 0 0 . 0  :  1 . 0 0 . 2 4 6 0 . 9 5 6 0 . 1 0 4 0 . 3 5 0

     S i d e  S l o p e  0 . 5  :  1 . 0
Q = 9 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 . 5  :  1 . 0 0 . 4 3 8 0 . 3 0 7 0 . 1 1 2 0 . 5 5 0
0 . 4 5 0 . 0 2 5 0 . 5  :  1 . 0 0 . 4 1 1 0 . 3 3 4 0 . 1 3 9 0 . 5 5 0
0 . 4 5 0 . 0 3 3 0 . 5  :  1 . 0 0 . 3 7 8 0 . 3 7 2 0 . 1 2 2 0 . 5 0 0
0 . 4 5 0 . 0 4 0 0 . 5  :  1 . 0 0 . 3 5 9 0 . 3 9 9 0 . 1 4 1 0 . 5 0 0
0 . 3 4 0 . 0 5 0 0 . 5  :  1 . 0 0 . 3 8 9 0 . 4 3 2 0 . 1 1 1 0 . 5 0 0
0 . 3 4 0 . 1 0 0 0 . 5  :  1 . 0 0 . 3 2 0 0 . 5 6 2 0 . 1 3 0 0 . 4 5 0
0 . 3 4 0 . 2 0 0 0 . 5  :  1 . 0 0 . 2 6 2 0 . 7 2 9 0 . 1 3 8 0 . 4 0 0
0 . 2 3 0 . 3 3 3 0 . 5  :  1 . 0 0 . 2 7 8 0 . 8 7 9 0 . 1 2 2 0 . 4 0 0
0 . 2 3 0 . 5 0 0 0 . 5  :  1 . 0 0 . 2 4 8 1 . 0 2 6 0 . 1 0 2 0 . 3 5 0

    S i d e  S l o p e  0 . 0  :  1 . 0
Q = 9 0  l i t / s B e d  W i d t h C a n a l  S l o p e S i d e  S l o p e W a t e r  D e p t h V e l o c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 6 7 0 . 0 2 0 0 . 0  :  1 . 0 0 . 4 5 5 0 . 2 9 5 0 . 1 4 5 0 . 6 0 0
0 . 6 7 0 . 0 2 5 0 . 0  :  1 . 0 0 . 4 1 7 0 . 3 2 2 0 . 1 3 3 0 . 5 5 0
0 . 5 6 0 . 0 3 3 0 . 0  :  1 . 0 0 . 4 5 3 0 . 3 5 4 0 . 1 4 7 0 . 6 0 0
0 . 5 6 0 . 0 4 0 0 . 0  :  1 . 0 0 . 4 2 2 0 . 3 8 1 0 . 1 2 8 0 . 5 5 0
0 . 4 5 0 . 0 5 0 0 . 0  :  1 . 0 0 . 4 9 6 0 . 4 0 3 0 . 1 0 4 0 . 6 0 0
0 . 4 5 0 . 1 0 0 0 . 0  :  1 . 0 0 . 3 7 4 0 . 5 3 4 0 . 1 2 6 0 . 5 0 0
0 . 3 4 0 . 2 0 0 0 . 0  :  1 . 0 0 . 3 9 2 0 . 6 7 5 0 . 1 0 8 0 . 5 0 0
0 . 3 4 0 . 3 3 3 0 . 0  :  1 . 0 0 . 3 1 8 0 . 8 3 2 0 . 1 3 2 0 . 4 5 0
0 . 3 4 0 . 5 0 0 0 . 0  :  1 . 0 0 . 2 7 0 0 . 9 8 0 0 . 1 3 0 0 . 4 0 0
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6) Turnout 

Turnouts are made to distribute water to secondary and tertiary canals. Turnouts are opened and closed 
following rotational irrigation schedule. Stop logs are recommended for closing turnout however sand 
bags or bricks and banana leaves are also acceptable. Interval of turnout depends on a number of 
factors and should lead water to secondary canal. They are mostly spaced at 40m to 60m.  

7) Stream/Gully Crossing 

Stream/Gully crossing should consist of brick made boxes and pipe. Boxes should be constructed at 
each side of stream or gully and connected with a pipe. It is possible to make stream/gully crossing 
with tree bark, logs, bamboo and plastic paper supported by logs but it should be removed during flood 
season. Therefore, adoption of stream/gully crossing made of bricks and pipe is recommendable for a 
medium scale irrigation scheme. The length of stream/gully crossing should be less than 6m 
considering the length and strength of pipe. If the length of stream/gully crossing exceeds 6m, it 
should be supported. Since the support should be enough strong and durable in order not to be washed 
away by a flash water, it is costly and requires technical consideration. The location of stream/gully 
crossing should be determined to make the length as shorter as possible (less than 6m). The flow 
capacity of pipes is shown Table 2-34 below.  

Table 2-34 Maximum Pipe Flow Quantity of Uniform Flow 
Pipe Diameter (Nom. Size) Gradient 1/300 Gradient 1/500 

φ 100 3.9 lit/s 3.1 lit/s 
φ 125 6.7 lit/s 5.2 lit/s 
φ 150 9.6 lit/s 7.5 lit/s 
φ 200 24.4 lit/s 18.9 lit/s 
φ 225 32.3 lit/s 25.1 lit/s 

 

     S id e  S lo p e  0 . 5  :  1 . 0
Q = 1 0 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 4 5 0 . 0 2 0 0 .5  :  1 . 0 0 . 4 6 5 0 .3 1 5 0 .1 3 5 0 .6 0 0
0 .4 5 0 . 0 2 5 0 .5  :  1 . 0 0 . 4 3 6 0 .3 4 3 0 .1 1 4 0 .5 5 0
0 .4 5 0 . 0 3 3 0 .5  :  1 . 0 0 . 4 0 2 0 .3 8 2 0 .1 4 8 0 .5 5 0
0 .4 5 0 . 0 4 0 0 .5  :  1 . 0 0 . 3 8 1 0 .4 0 9 0 .1 1 9 0 .5 0 0
0 .4 5 0 . 0 5 0 0 .5  :  1 . 0 0 . 3 5 7 0 .4 4 5 0 .1 4 3 0 .5 0 0
0 .3 4 0 . 1 0 0 0 .5  :  1 . 0 0 . 3 4 0 0 .5 7 7 0 .1 1 0 0 .4 5 0
0 .3 4 0 . 2 0 0 0 .5  :  1 . 0 0 . 2 7 9 0 .7 4 9 0 .1 2 1 0 .4 0 0
0 .2 3 0 . 3 3 3 0 .5  :  1 . 0 0 . 2 9 4 0 .9 0 2 0 .1 0 6 0 .4 0 0
0 .2 3 0 . 5 0 0 0 .5  :  1 . 0 0 . 2 6 3 1 .0 5 2 0 .1 3 7 0 .4 0 0

    S id e  S lo p e  0 . 0  :  1 . 0
Q = 1 0 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 6 7 0 . 0 2 0 0 .0  :  1 . 0 0 . 4 9 4 0 .3 0 2 0 .1 0 6 0 .6 0 0
0 .6 7 0 . 0 2 5 0 .0  :  1 . 0 0 . 4 5 3 0 .3 3 0 0 .1 4 7 0 .6 0 0
0 .5 6 0 . 0 3 3 0 .0  :  1 . 0 0 . 4 9 3 0 .3 6 2 0 .1 0 7 0 .6 0 0
0 .5 6 0 . 0 4 0 0 .0  :  1 . 0 0 . 4 5 9 0 .3 8 9 0 .1 4 1 0 .6 0 0
0 .5 6 0 . 0 5 0 0 .0  :  1 . 0 0 . 4 2 0 0 .4 2 5 0 .1 3 0 0 .5 5 0
0 .4 5 0 . 1 0 0 0 .0  :  1 . 0 0 . 4 0 7 0 .5 4 5 0 .1 4 3 0 .5 5 0
0 .3 4 0 . 2 0 0 0 .0  :  1 . 0 0 . 4 2 8 0 .6 8 6 0 .1 2 2 0 .5 5 0
0 .3 4 0 . 3 3 3 0 .0  :  1 . 0 0 . 3 4 7 0 .8 4 9 0 .1 0 3 0 .4 5 0
0 .3 4 0 . 5 0 0 0 .0  :  1 . 0 0 . 2 9 4 1 .0 0 0 0 .1 0 6 0 .4 0 0

     S id e  S lo p e  0 . 5  :  1 . 0
Q = 1 5 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 5 6 0 . 0 2 0 0 .5  :  1 . 0 0 . 5 2 3 0 .3 4 9 0 .1 2 7 0 .6 5 0
0 .5 6 0 . 0 2 5 0 .5  :  1 . 0 0 . 4 9 0 0 .3 8 0 0 .1 1 0 0 .6 0 0
0 .5 6 0 . 0 3 3 0 .5  :  1 . 0 0 . 4 5 1 0 .4 2 3 0 .1 4 9 0 .6 0 0
0 .4 5 0 . 0 4 0 0 .5  :  1 . 0 0 . 4 8 1 0 .4 5 2 0 .1 1 9 0 .6 0 0
0 .4 5 0 . 0 5 0 0 .5  :  1 . 0 0 . 4 5 1 0 .4 9 2 0 .1 4 9 0 .6 0 0
0 .4 5 0 . 1 0 0 0 .5  :  1 . 0 0 . 3 7 0 0 .6 3 9 0 .1 3 0 0 .5 0 0
0 .3 4 0 . 2 0 0 0 .5  :  1 . 0 0 . 3 5 2 0 .8 2 7 0 .1 4 8 0 .5 0 0
0 .3 4 0 . 3 3 3 0 .5  :  1 . 0 0 . 3 0 4 1 .0 0 3 0 .1 4 6 0 .4 5 0
0 .3 4 0 . 5 0 0 0 .5  :  1 . 0 0 . 2 7 0 1 .1 6 9 0 .1 3 0 0 .4 0 0

    S id e  S lo p e  0 . 0  :  1 . 0
Q = 1 5 0  l i t / s B e d  W id t h C a n a l  S lo p e S id e  S lo p e W a t e r  D e p t h V e lo c i t y F r e e b o a r d C a n a l  D e p t h

( m ) ( % ) V e r  :  H o r ( m ) ( m / s ) ( m ) ( m )
0 . 8 9 0 . 0 2 0 0 .0  :  1 . 0 0 . 5 0 0 0 .3 3 7 0 .1 0 0 0 .6 0 0
0 .8 9 0 . 0 2 5 0 .0  :  1 . 0 0 . 4 6 0 0 .3 6 7 0 .1 4 0 0 .6 0 0
0 .7 8 0 . 0 3 3 0 .0  :  1 . 0 0 . 4 7 2 0 .4 0 8 0 .1 2 8 0 .6 0 0
0 .7 8 0 . 0 4 0 0 .0  :  1 . 0 0 . 4 4 0 0 .4 3 7 0 .1 1 0 0 .5 5 0
0 .6 7 0 . 0 5 0 0 .0  :  1 . 0 0 . 4 7 4 0 .4 7 2 0 .1 2 6 0 .6 0 0
0 .5 6 0 . 1 0 0 0 .0  :  1 . 0 0 . 4 4 0 0 .6 0 9 0 .1 1 0 0 .5 5 0
0 .4 5 0 . 2 0 0 0 .0  :  1 . 0 0 . 4 2 7 0 .7 8 0 0 .1 7 3 0 .6 0 0
0 .3 4 0 . 3 3 3 0 .0  :  1 . 0 0 . 4 8 7 0 .9 0 7 0 .1 1 3 0 .6 0 0
0 .3 4 0 . 5 0 0 0 .0  :  1 . 0 0 . 4 1 0 1 .0 7 6 0 .1 4 0 0 .5 5 0
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8) Road Crossing 

Road crossing should consist of brick made boxes and pipes. Boxes should be constructed at each side 
of the road and connected with pipes. Pipes should be installed at the depth of more than 30cm from 
the surface of the road. 30 cm soil cover is enough safe for gross weight 14 ton truck load. Pipes 
should be installed at the height of 10cm from canal bed, refer to the Figure 2-20. Siphon type is not 
recommended due to maintenance problems. It is recommended that the back filling material should 
be thoroughly compacted without destroying the canal walls.   

 
 
 
 
 
 
 

 

 

Figure 2-20 Standard Cross Section of Road Crossing 

 

2.5 Rehabilitation Work Method 

(1) Surface Preparation 

Ground surfaces in areas to be excavated or where facilities are to be located should be cleared of all 
trees, bush, debris and surface vegetation. Stumps and roots larger than 50 mm in diameter should 
completely uproot and removed. Matted roots, surface vegetation should be removed regardless of 
size; they should completely remove with roots to a depth of not less than 10 cm below ground surface. 
All trees or groups of trees designated should be protected from damage from any construction 
operations. 

(2) Excavation 

Excavation should be planned and carried out to minimize adverse effects on the existing facilities and 
structures, as well as the vehicular and pedestrian traffic of and around the construction site. 

Over excavation, below the depths indicated, should, unless otherwise be specified, refilled and 
compacted.  If soft or unsuitable soil is found at the excavated depth, additional excavation should be 
carried out to depth and filled and compacted. Soil disturbed or weakened and soils deteriorated by 
exposure to weather should be excavated and excavated areas refilled and compacted. 

Generally, all excavations should be kept free from water during construction. If soft or unsuitable soil 
is encountered after excavation to the designated bottom of the trench or structure, the ground should 
be excavated to a firm foundation level and filled over the excavated area with backfilling material. 

(3) Replacement and Embankment 

Material for the replacement and embankment should be placed in horizontal layers of uniform 
thickness over a width determined and in conformity with the lines, grades, sections, and dimensions. 
The layer of loose material other than rock should be not more than 30 cm thick. After adjustment of 
the moisture content, the loose material should be compacted. 

 

 

 30 cm 

10 cm 

Pipe Main canal

60 cm 
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(4) Stone Masonry 

1) Material 

i) Stone 
Stone for Stone Masonry should consist of field stone or rough un-hewn quarry stone as nearly 
rectangular in section as is practical, including such stone or material observed being in use on 
the existing work. The stone should be sound, tough, durable, dense, resistant to the action of 
air and water, and suitable in all respects for the purpose intended. The size of the stone should 
be 10 cm minimum and 30 cm maximum. 
ii) Sand 
Sand for mortar should be river sand, free from silt, salt and other organic foreign matter. 
iii) Water 
Water for mortar should be clean and free from harmful matter, such as oil, salts, organic 
matter, or any material which may have a harmful effect on the mortar. Potable water (except 
for bacteriological limits and conditions) is suitable for the mixing of mortar under all 
conditions. 
iv) Mortar mix 
Standard mixing proportion of cement and mortar is as follows, 
Ordinary Portland Cement    1 bucket of cement: 3 buckets of Sand 
Mortar should be mixed uniformly with water to the proper consistency for spreading by 
trowel. Mortar which has been mixed with water for more than 45 minutes should not be used. 

2) Construction  

Excavation should be made to the required shape and depth, and should be compacted to a firm, even 
surface. All surpluses, soft and unsuitable material should be removed and replaced with suitable 
material which should be thoroughly compacted. 

Stone should be washed with water before placing. Mortar should be pushed into the interstices of the 
stone within a short time after placing. The spaces between the stones are then filled with mortar. 
Sufficient mortar should be used to completely fill all voids, except that the face surface of the stone is 
left for exposition. The surface of stone masonry should be finished neatly and smoothly. After 
completion of Stone Masonry, it should be cured with water for more than 10 hours.  

(5) Gabion 

1) Material  

The wire mesh should be made of galvanized steel having a minimum size of 2.7 mm (0.106 inch) 
diameter. The length and width of bamboo gabion should be less than one meter and the height less 
than 0.6 meter. The gabions should consist of hard rocks which are durable rock pieces that might not 
deteriorate when submerged in water or exposed to severe weather conditions. Rock pieces should be 
generally uniformly graded in sizes ranging from 100mm to 200mm. All Voids should be evenly 
distributed. 

2) Construction  

The wire mesh should be twisted to form hexagonal openings of uniform sizes. The maximum linear 
dimension of the mesh opening should not exceed 110 mm (4 ½ inches) and the area of mesh opening 
should not exceed 51.6 sq.cm (8 square inches). The mesh should then be fabricated non-raveled. 
Non-raveling is defined as the ability to resist pulling apart at any of the twists or connections forming 
the mesh when a single wire strand in a section is cut. 

Gabion should be fabricated in such a manner that the side, ends, lid, and diaphragms can be 
assembled at the construction site into rectangular baskets of the specific sizes. Gabions should be of 
single unit construction, base, lids, ends, and sides should be either woven into a single unit or one 
edge of these members connected to the base section of the gabion in such a manner that the strength 
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and flexibility at the point of connection is at least equal to that of the mesh. 

The gabion should be equally divided by diaphragms, of the same mesh and gauge as the body of the 
gabions, into cells the length of which does not exceed the horizontal width. The gabion should be 
furnished with the necessary diaphragms secured in proper position on the base, such that no 
additional tying at this junction are necessary. 

The gabions are then filled with stone carefully placed by hand to assure alignment and avoid bulges 
with a minimum of voids. Alternate placing of rock and connection wires should be performed until 
the gabion is filled. After a gabion has been filled, the lid should be bent over until it meets the sides 
and edges. The lid should then be secured to the sides, ends and diaphragms with the wire ties or 
connecting wire in the manner described for assembling. 

The bamboo gabion should be fabricated at the site. Bamboo should be cut about 2cm in width. The 
space of vertical member should not be more than 10 cm. Horizontal member should be woven in and 
out the vertical member. The space of horizontal member should not be more than 3cm. Bottom 
member should be lattice arranged. The top of face should be woven with string or wire. 

(6) Brick Masonry 

1) Material 

Brick for brick masonry should be sound, tough, durable, dense, resistant to the action of air and water, 
and suitable in all respects for the purpose intended. Standard size of the brick should be 10 cm x 8 cm 
x 22 cm. Standard mixing proportion of cement and mortar should be as follows;  

Ordinary Portland Cement     1 bucket of Cement: 3 buckets of Sand 

2) Construction  

Brick should be laid straight. Thickness of joint mortar shall be 1 to 2 cm. The joint between the bricks 
should be filled with mortar completely and the surface of brick masonry finished neat and smooth. 

(7) Safety and Environment 

1) Safety  

Reasonable precaution to protect persons or property from injury should be exercised and maximum 
care should also be put in place for people around them.  

2) Environment 

All necessary precautions should be taken to secure the efficient protection of all waterways against 
pollution, including spillage of oil which may be likely to cause injury to fish or plant life. Waste water 
from washing tools for mortar work such as mortar box, shovels, buckets and trowels should not be 
poured into a river directly. 

2.6 Work Plan 

(1) General 

Construction plan is to establish that the way how the project is implemented safely and within the 
specified time and cost, and construction method and procedure. Construction work has different types, 
sizes, and locations and construction conditions are different from one to another. To execute these 
works in systematic and organized ways, the construction plan appropriate for each work needs to be 
prepared. 

i) Based on design, work method is established. 
ii) Based on design, quantity of required materials is calculated. 
iii) Based on quantity and work method, required manpower is calculated. 
iv) Based on quantity and manpower, construction cost is calculated. 
v) Based on manpower, work schedule is drawn up.  
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(2) Bill of Quantity  

Quantity of required materials should be calculated in accordance with drawing. Following items are 
calculated. 

- Excavation 
- Embankment 
- Stone masonry 
- Rubble stones 
- Mortar 
- Sand 
- Cement 
- Bricks  
- Pipes 
- Gabions 
- Others 

 
i) Excavation 
Quantity of excavation is calculated in accordance with cross section.  

 Vex = (A1 + A2)/2 x L1 + (A2 + A3)/2 x L2 + . . . . . + (An-1 +An)/2 x Ln 
  Vex: Excavation volume (m3)  
  An: Cross sectional area of excavation at An (m) 
  Ln: Distance between An-1 and An (m) 
 or 
  Vex = A x D (m3) 
  A: Excavation area (m2) 
  D: Excavation depth (m) 

ii) Embankment 
Quantity of embankment shall be calculated in accordance with cross section.  

 Vem = (A1 + A2)/2 x L1 + (A2 + A3)/2 x L2 + . . . . . + (An-1 +An)/2 x Ln 
 Vem: Embankment volume (m3)  
 An: Cross sectional area of embankment at An  (m) 
 Ln: Distance between An-1 and An (m) 

 
iii) Stone masonry 
Quantity of stone masonry is calculated in accordance with cross section.  
iv) Rubble stone (stone masonry) 
Quantity of rubble stone for stone masonry is calculated as follows 

 Vrs = Vsm x 1.08 (m3) 
 1.08: coefficient of loss 
 Vrs: Volume of rubble stone (m3) 
 Vsm: Volume of stone masonry (m3) 

 
v) Mortar for stone masonry 
Quantity of mortar for stone masonry is calculated as follows 

 Vmo = Vsm x 0.5 x 1.1 (m3) 
 Vmo: Volume of mortar for stone masonry (m3)  
 Vsm: Volume of stone masonry (m3) 
 0.5: coefficient of ratio 
 1.1: coefficient of loss 

vi) Sand for mortar 
Quantity of sand for mortar is calculated as follows 

 Vsa = Vmo x 0.8 (m3)  
 Vsa: Volume of sand (m3) 
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 Vmo: Volume of mortar (m3) 
 
vii) Cement 
Quantity of cement for mortar is calculated as follows  

 Vc = Vmo x 9.0 (bags) 
 Vc: Volume of cement (bags) 
 Vmo: Volume of mortar (m3) 

viii) Bricks 
Quantity of bricks is calculated in accordance with drawings.  
Standard quantity of brick canal is shown in next page. 
 
ix) Gabions 
Dimension of gabion wire net is 1.0m x 1.0m x 4.0m or 1.0m x 1.0m x 2.0m. 
Dimension of bamboo gabion is be 0.6m (height) x 1.0m x 1.0m. 
x) Rubble stones for gabion  
Quantity of rubble stone for gabion is calculated as follows 

 Vrsg = Vga x 0.95 (m3) 
 0.95: coefficient of ratio 
 Vrsg: Volume of rubble stone (m3) 
 Vga: Volume of gabion (m3) 

Example of quantity calculation procedure is presented in Figure 2-21 and Figure 2-22 below 
and recording sheet is shown in Table 2-35. 

 

Figure 2-21 Main Canal Section (Rectangular) and Quantity Calculations 

 

     M a in  C ana l (R ec tangu la r)

S tandard  size o f b r ick sha ll be  220m m  ｘ  100m m  ｘ  80m m

(1 ) B  = 0 .36m , H  =  0 .38m    w a ll 4  laye rs
Q uantity  pe r length o f 2 .35  m
B rick 13  ｘ  10 =  130  pcs
M ortar 0 .015  x 0 .1  x  2 .35 x  4  x  2  + 0 .015 x 0 .08 x  2 .35 x  4

  +  0 .015  x 0 .08 x  0 .1  x  13  x 10 =  0 .05508 m ^3
Q uantity  pe r length o f 1 .0  m
B rick 130  / 2 .35  x  1 .1  =  60 .85 pcs        1 .1 : coeffic ien t o f lo ss
M ortar 0 .05508  /  2 .35  x  1 .3  =  0 .0305　 m ^3     1 .3  coe ffic ien t o f loss

(2 ) B  = 0 .36m , H  =  0 .475  m    w a ll 5  la yers
Q uantity  pe r length o f 2 .35  m
B rick 15  ｘ  10 =  150  pcs
M ortar 0 .015  x 0 .1  x  2 .35 x  5  x  2  + 0 .015 x 0 .08 x  2 .35 x  4

  +  0 .015  x 0 .08 x  0 .1  x  15  x 10 =  0 .06453 m ^3
Q uantity  pe r length o f 1 .0  m
B rick 150  / 2 .35  x  1 .1  =  70 .21 pcs        1 .1 : coeffic ien t o f lo ss
M ortar 0 .06453  /  2 .35  x  1 .3  =  0 .0357　 m ^3     1 .3  coe ffic ien t o f loss

100m m
360m

H

8
0
m

m

b ric k 220x100x80m m

m ortar t=15m m
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Site:

1 Weir Stone Masonry standard cross section
A1 = (0.6 + 1.9) x 1/2 x 1.3 + 1.9 x 0.5 = 2.575 m^2
end cross section
A2 = (0.6 + 0.9) x 1/2 x 0.3 = 0.225 m^2

V1 = 2.575 x 7.5 = 19.31 m^3
V2 = (2.575 + 0.225) x 1/2 x (2.0 + 3.0) = 7.00 m^3
V = 19.31 + 7.0 = 26.31

rubble stone 26.31 x 1.08 = 28.41m^3 28.4 m^3

mortar 26.31 x 0.5 x 1.1 =14.47 m^3
sand 14.47 x 0.8 = 11.58 m^3 11.6 m^3
cement 14.47 x 450 kg / 50 kg = 130.23 bag 131.0 bag

gabion 17.0 pc
rubble stone  1.0 x 1.0 x 2.0 x 0.95 x 15 =28.5 m^3 28.5 m^3

2 Intake Stone Masonry A1 = (1.24 + 2.64) x 1/2 x 1.4 = 2.72 m^2
A2 = (1.0 + 2.2) x 1/2 x 1.2 = 1.92 m^2
V1 = (2.72-1.92) x (1.0 + 0.6 + 1.2 + 1.0) = 3.04 m^3
V2 = 1.92 x 0.6 = 1.15 m^3
V3 = 1.92 x 1/2 x 1.2 = 1.15 m^3
V = 3.04 + 1.15 + 1.15 = 5.34 m^3

rubble stone 5.34 x 1.08 = 5.77 m^3 5.8 m^3
mortar 5.34 x 0.5 x 1.1 = 2.94 m^3
sand 2.94 x 0.8 = 2.35 m^3 2.4 m^3
cement 2.94 x 450 kg / 50 kg = 26.46 bag 26.0 bag

PVC φ150 3.6 m

Amount Unit RemarksNo. Item
Specifoication/

Quality
calculation

Figure 2-22 Main Canal Section (Trapezoidal) and Quantity Calculation 
 

Table 2-35 Example of Quantity Calculation Sheet 
 

        M a in  C a n a l ( T r a p e z o id )

( 1 ) B  =  0 .3 6 m ,  H  =  0 .3 9 m    w a l l  4  la y e r s
Q u a n t i t y  p e r  le n g t h  o f  2 .3 5 m
B r ic k 　 　 　 W a l l 1 0  p c s  x  4  la y e r s  x  2  w a l ls  =  8 0  p c s
　 　 　 　 　 　 B a s e 1 0  p c s  x  3  r o w s  =  3 0  p c s
            T o t a l 8 0  +  3 0  =  1 1 0  p c s
M o r t a r 　   W a l l ,  B a s e 0 .0 1 5  x  0 .0 8  x  2 .3 5  x  1 0  +  0 .0 1 5  x  0 .0 8  x  0 .1 5  x  1 1 x  1 0  =   0 .0 4 8  m ^ 3
　 　 　 　 　 　 C o r n e r ( 0 .0 8  x  0 .0 8  x  t a n ( 3 1 .7 2 ° )  x  1 / 2  x  2  x  2 )  x  2 .3 5  =  0 .0 1 8 6  m ^ 3
            T o t a l 0 .0 4 8  +  0 .0 1 8 6  =  0 .0 6 6 6  m ^ 3 　 　 　 p e r  1 m 　 0 .0 6 6 6  /  2 .3 5  = 　 0 .0 2 8 3 　 m ^ 3
Q u a n t i t y  p e r  le n g t h  o f  1 .0 m
B r ic k 　 　 1 1 0  /  2 .3 5  x  1 .1  =  5 1 .4 9  p c s
M o r t a r 0 .0 6 6 6  /  2 .3 5  x  1 .3  = 　 0 .0 3 6 8 　 m ^ 3

( 2 ) B  =  0 .3 6 m ,  H  =  0 .5 0 m    w a l l  5  la y e r s
Q u a n t i t y  p e r  le n g t h  o f  2 .3 5 m
B r ic k 　 　 　 W a l l 1 0  p c s  x  5  la y e r s  x  2  w a l ls  =  1 0 0  p c s
　 　 　 　 　 　 B a s e 1 0  p c s  x  3  r o w s  =  3 0  p c s
            T o t a l 1 0 0  +  3 0  =  1 3 0  p c s
M o r t a r 　   W a l l ,  B a s e 0 .0 1 5  x  0 .0 8  x  2 .3 5  x  1 2  +  0 .0 1 5  x  0 .0 8  x  0 .1 1  x  1 3  x  1 0  =   0 .0 5 1  m ^ 3
　 　 　 　 　 　 C o r n e r ( 0 .0 8  x  0 .0 8  x  t a n ( 3 1 .7 2 ° )  x  1 / 2  x  2  x  2 )  x  2 .3 5  =  0 .0 1 8 6  m ^ 3
            T o t a l 0 .0 5 1  +  0 .0 1 8 6  =  0 .0 6 9 6  m ^ 3 　 　
Q u a n t i t y  p e r  le n g t h  o f  1 .0 m
B r ic k 　 　 1 3 0  /  2 .3 5  x  1 .1  =  6 0 .8 5  p c s
M o r t a r 0 .0 6 9 6  /  2 .3 5  x  1 .3  = 　 0 .0 3 8 5 　 m ^ 3

( 3 ) B  =  0 .3 6 m ,  H  =  0 .6 2 m    w a l l  6  la y e r s
Q u a n t i t y  p e r  le n g t h  o f  2 .3 5 m
B r ic k 　 　 　 W a l l 1 0  p c s  x  6  la y e r s  x  2  w a l ls  =  1 2 0  p c s
　 　 　 　 　 　 B a s e 1 0  p c s  x  3  r o w s  =  3 0  p c s
            T o t a l 1 2 0  +  3 0  =  1 5 0  p c s
M o r t a r 　   W a l l ,  B a s e 0 .0 1 5  x  0 .0 8  x  2 .3 5  x  1 4  +  0 .0 1 5  x  0 .0 8  x  0 .1 1  x  1 5  x  1 0  =  0 .0 5 9 3  m ^ 3
　 　 　 　 　 　 C o r n e r ( 0 .0 8  x  0 .0 8  x  t a n ( 3 1 .7 2 ° )  x  1 / 2  x  2  x  2 )  x  2 .3 5  =  0 .0 1 8 6  m ^ 3
            T o t a l 0 .0 5 9 3  +  0 .0 1 8 6  =  0 .0 7 7 9  m ^ 3 　 　
Q u a n t i t y  p e r  le n g t h  o f  1 .0 m
B r ic k 　 　 1 5 0  /  2 .3 5  x  1 .1  =  7 0 .2 1  p c s
M o r t a r 0 .0 7 7 9  /  2 .3 5  x  1 .3  = 　 0 .0 4 3 1 　 m ^ 3

b r ic k

3 6 0 m m

H1
.0

0 . 5

m o r t a r  t = 1 5 m m
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(3) Man Power and Tools Planning 

Standard of required manpower, material and tools for each work is estimated as Table 2-36. These 
were established. 

(4) Construction Cost 

Construction cost is calculated based on bill of quantity and man power. Example of cost calculation 
sheet is shown in Table 2-37. 

(5) Work Schedule 

Based on quantity and required manpower for each item, construction period for each item is estimated. 
If the available labor per day is enough, putting large manpower into the work, shorten the 
construction period is shortened. Example of manpower planning is shown in the Table 2-32. Based on 
this man power planning, work progress schedule is drawn up. If man power is enough, work items 
can be executed simultaneously. Example of work progress schedule is shown in the Figure 2-23.  

 

 

Box

1 Discharge Box 1.0m x 1.0m x 0.855m (Depth) wall 9 layers
Brick wall 0.215 x 0.855 x (1.43 x 2 + 1.0 x 2) = 0.893 m^3

base 1.43 x 1.43 x 0.175 = 0.358 m^3
opening not considered
total 0.893 + 0.358 = 1.251 m^3

1.251 / (0.235 x 0.115 x 0.095) x 1.1= 536.00 pc 536.0 pc

Mortar wall 0.015 x 0.215 x (1.43 x 2 + 1.0 x 2) x 9 = 0.141 m^3
0.015 x 0.215 x (0.08 x 9) x ((1.43 x 2 +1.0 x 2) / 0.235) =  0.048 m^3

base 0.015 x (1.43 x 1.43 + 0.175 x (1.43 / 0.235) +  0.175 x (1.43 / 0.115)) = 0.079 m^3
opening not considered
inside plastering 1.0 x 1.0 x 0.8 x 0.015 = 0.012 m^3
total (0.141 + 0.048 + 0.079 + 0.012) x 1.3 = 0.364 m^3

sand 0.364 x 0.8 = 0.291 m^3 0.291 m^3
cement 0.364 x 450kg / 50kg = 3.276 bag 3.276 bag

2 Box 0.6m x 0.6m x 0.475m (Depth) wall 5 layers
Brick wall 0.215 x 0.475 x (1.03 x 2 + 0.6 x 2) = 0.333 m^3

base 1.03 x 1.03 x 0.175 = 0.186 m^3
opening not considered
total 0.333 + 0.186 = 0.519 m^3

0.519 / (0.235 x 0.115 x 0.095) x 1.1= 222.37 pc 223.0 pc

Mortar wall 0.015 x 0.215 x (1.03 x 2 + 0.6 x 2) x 5 = 0.052 m^3
0.015 x 0.215 x (0.08 x 5) x ((1.03 x 2 +0.6 x 2) / 0.235) =  0.018 m^3

base 0.015 x (1.03 x 1.03 + 0.175 x (1.03 / 0.235) +  0.175 x (1.03 / 0.115)) = 0.051 m^3
opening not considered
inside plastering 0.6 x 0.6 x 0.475 x 0.015 = 0.003 m^3
total (0052 + 0.018 + 0.051 + 0.003) x 1.3 = 0.161 m^3

sand 0.161 x 0.8 = 0.129 m^3 0.129 m^3
cement 0.161 x 450kg / 50kg = 1.449 bag 1.449 bag

No. Item Unit Remarkscalculation
Specifoication

/Quality
Amount
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Table 2-36 Standards of Required Manpower, Materials and Tools 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

L a b o r  M a t e r i a l  a n d  T o o l s

1 - 1 M o r t a r     p e r  1 m ^ 3 0 . 8 9 m ^ 3 / d a y / 1 s e t
M a t e r i a l
 C e m e n t O r d i n a r y  P o r t l a n d 9 . 0 0 b a g s 4 5 0 k g
 S a n d R i v e r  s a n d 0 . 8 0 m ^ 3  1 . 0  x  0 . 8
 M a t e r i a l  T o t a l

L a b o r
 M o r t a r  m i x i n g u n s k i l l e d  l a b o r 2 . 2 5 m a n  2  x  9  /  8
 H e l p e r u n s k i l l e d  l a b o r 4 . 5 0 m a n  4  x  9  /  8
 L a b o r  T o t a l 6 . 7 5 m a n

T o o l s  ( D a i l y )
 S h o v e l 2 . 0 0 p c s
 B u c k e t 2 0  l i t 2 . 0 0 p c s
 W h e e l  b a r r o w 1 . 0 0 p c
 M o r t a r  b o x 1 . 0 0 p c

1 - 2 M o r t a r     p e r  0 . 8 9 m ^ 3  /  d a y /  1  s e t
M a t e r i a l
 C e m e n t O r d i n a r y  P o r t l a n d 8 . 0 0 b a g s 4 0 0 k g
 S a n d R i v e r  s a n d 0 . 7 1 m ^ 3  0 . 8 9  x  0 . 8
 M a t e r i a l  T o t a l

L a b o r
 M o r t a r  m i x i n g u n s k i l l e d  l a b o r 2 . 0 0 m a n
 H e l p e r u n s k i l l e d  l a b o r 4 . 0 0 m a n
 L a b o r  T o t a l 6 . 0 0 m a n

T o o l s  ( D a i l y )
 S h o v e l 2 . 0 0 p c s
 B u c k e t 2 0  l i t 2 . 0 0 p c s
 W h e e l  b a r r o w 1 . 0 0 p c
 M o r t a r  b o x 1 . 0 0 p c

2 - 1 C o n s t r u c t i o n  o f  b r i c k  c a n a l   r e c t a n g u l a r  W = 0 . 3 6 m ,  D = 0 . 3 8 m   w a l l  4  l a y e r s
1 2 m  /  d a y  /  1  s e t
M a t e r i a l
B r i c k s 7 3 0 . 2 0 p c s  6 0 . 8 5  x  1 2
M o r t a r 1 : 3 0 . 3 7 m ^ 3  0 . 0 3 1  x  1 2
 M a t e r i a l  T o t a l

L a b o r / d a y
 F o r e m a n 1 . 0 0 m a n
 M o r t a r  m i x i n g u n s k i l l e d  l a b o r 4 . 0 0 m a n 1  d a y
 E x c a v a t i o n u n s k i l l e d  l a b o r 2 . 0 0 m a n s h a p i n g
 B r i c k  l a y i n g s k i l l e d  l a b o r 1 . 0 0 m a n

u n s k i l l e d  l a b o r 3 . 0 0 m a n
 H e l p e r u n s k i l l e d  l a b o r 4 . 0 0 m a n
T o t a l  l a b o r 1 5 . 0 0 m a n

I t e m n a m e
s p e c i f i c a t i o n ,
q u a l i t y ,  s h a p e

q u a n t i t y u n i t r e m a r k s

T o o l s  ( D a i l y )
 S h o v e l 2 . 0 0 p c s
 B u c k e t 2 0  l i t 4 . 0 0 p c s
 W h e e l  b a r r o w 3 . 0 0 p c s
 M o r t a r  b o x 1 . 0 0 p c
 T r o w e l 4 . 0 0 p c s
 D r u m 1 . 0 0 p c
 H o e 2 . 0 0 p c s
 L i n e  l e v e l 1 . 0 0 p c
 S t r i n g 1 . 0 0 r o l l
 B r i c k  b o l s t e r 1 . 0 0 p c
 B u i l d e r ' s  l e v e l 1 . 0 0 p c
 M e a s u r i n g  t a p e 1 . 0 0 p c
 P e g

2 - 2 C o n s t r u c t i o n  o f  b r i c k  c a n a l   r e c t a n g u l a r  W = 0 . 3 6 m ,  D = 0 . 4 7 5 m   w a l l  5  l a y e r s
1 0 . 4 m  /  d a y  /  1  s e t
M a t e r i a l
B r i c k s 7 3 0 . 1 8 p c s  7 0 . 2 1  x  1 0 . 4
M o r t a r 1 : 3 0 . 3 7 m ^ 3  0 . 0 3 6  x  1 0 . 4
 M a t e r i a l  T o t a l

L a b o r / d a y
T h e  s a m e  a s  2 - 1
T o o l s
T h e  s a m e  a s  2 - 1

3 - 1 C o n s t r u c t i o n  o f  B r i c k  c a n a l   t r a p e z o i d  W = 0 . 3 6 m ,  D = 0 . 3 9 m   w a l l  4  l a y e r s
1 4 . 2 m  /  d a y  /  1  s e t
B r i c k s 7 3 1 . 1 6 p c s  5 1 . 4 9  x  1 4 . 2
M o r t a r 1 : 3 0 . 5 3 m ^ 3  0 . 0 3 7  x  1 4 . 2
 M a t e r i a l  T o t a l

L a b o r / d a y
T h e  s a m e  a s  2 - 1
T o o l s
T h e  s a m e  a s  2 - 1

3 - 2 C o n s t r u c t i o n  o f  b r i c k  c a n a l   t r a p e z o i d  W = 0 . 3 6 m ,  D = 0 . 5 0 m   w a l l  5  l a y e r s
1 2 m  /  d a y  /  1  s e t
M a t e r i a l
B r i c k s 7 3 0 . 2 0 p c s  6 0 . 8 5  x  1 2
M o r t a r 1 : 3 0 . 4 7 m ^ 3  0 . 0 3 9  x  1 2
 M a t e r i a l  T o t a l

L a b o r / d a y
T h e  s a m e  a s  2 - 1
T o o l s
T h e  s a m e  a s  2 - 1

u n i t r e m a r k sI t e m n a m e
s p e c i f i c a t i o n ,
q u a l i t y ,  s h a p e

q u a n t i t y
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 H e l p e r u n s k i l l e d  l a b o r 0 . 6 7 m a n
T o t a l  l a b o r 4 . 3 3 m a n

T o o l s  ( D a i l y )
 S h o v e l 1 . 0 0 p c s
 B u c k e t 2 0  l i t 2 . 0 0 p c s
 W h e e l  b a r r o w 1 . 0 0 p c
 M o r t a r  b o x 1 . 0 0 p c
 T r o w e l 2 . 0 0 p c s
 D r u m 1 . 0 0 p c
 H o e 1 . 0 0 p c
 B r i c k  b o l s t e r 1 . 0 0 p c
 B u i l d e r ' s  l e v e l 1 . 0 0 p c
 M e a s u r i n g  t a p e 1 . 0 0 p c
 P e g

5 E x c a v a t i o n   ( b y  h a n d ) p e r  1 0 m ^ 3
L a b o r
u n s k i l l e d  l a b o r 7 . 8 0 m a n

T o o l s
 S h o v e l 3 . 0 0 p c s
 P i c k a x e 2 . 0 0 p c s
 H o e 2 . 8 0 p c s
 S t r i n g 1 . 0 0 r o l l
 P e g

6 H a u l i n g  e x c a v a t e d  m a t e r i a l   p e r  1 . 0  m ^ 3  b y  w h e e l  b a r r o w
L a b o r
 u n s k i l l e d  l a b o r ～ 2 0 ｍ 0 . 0 2 m a n
 W h e e l  b a r r o w 2 0 ～ 4 0 m 0 . 0 6 m a n

4 0 ～ 6 0 m 0 . 1 4 m a n
6 0 ～ 8 0 m 0 . 2 4 m a n
8 0 ～ １ 0 0 m 0 . 3 4 m a n
1 0 0 ～ 1 2 0 m 0 . 4 4 m a n
1 2 0 ～ 1 4 0 m 0 . 5 6 m a n
1 4 0 ～ 1 6 0 m 0 . 6 6 m a n
1 6 0 ～ 1 8 0 m 0 . 7 8 m a n
1 8 0 ～ 2 0 0 m 0 . 9 0 m a n
o n e  w a y  d i s t a n c e

7 E m b a n k m e n t  ( b y  h a n d ) p e r  1 0 m ^ 3
 u n s k i l l e d  l a b o r 7 . 6 0 m a n

T o o l s
 S h o v e l 2 . 0 0 p c s
 H o e 3 . 6 0 p c s
 R a m m e r 2 . 0 0 p c s
 S t r i n g 1 . 0 0 r o l l
 P e g

I t e m n a m e
s p e c i f i c a t i o n ,
q u a l i t y ,  s h a p e

q u a n t i t y u n i t r e m a r k s

3 - 3 C o n s t r u c t i o n  o f  b r i c k  c a n a l   t r a p e z o i d  W = 0 . 3 6 m ,  D = 0 . 6 2 m   w a l l  6  l a y e r s
1 0 . 4 m  /  d a y  /  1  s e t
M a t e r i a l
B r i c k s 7 3 0 . 1 8 p c s  7 0 . 2 1  x  1 0 . 4
M o r t a r 1 : 3 0 . 4 5 m ^ 3  0 . 0 4 3  x  1 0 . 4
 M a t e r i a l  T o t a l

L a b o r / d a y
T h e  s a m e  a s  2 - 1
T o o l s
T h e  s a m e  a s  2 - 1

4 - 1 C o n s t r u c t i o n  o f  d i s c h a r g e  b o x  1 0 0 0 m m  x  1 0 0 0 m m  x  8 5 5 m m  ( D e p t h )  w a l l  9  l a y e r s
1  l o c a t i o n  /  d a y  /  1  s e t
B r i c k s 5 3 6 . 0 0 p c s
M o r t a r 1 : 3 0 . 3 6 m ^ 3
 M a t e r i a l  T o t a l

L a b o r / l o c a t i o n     1 l o c a t i o n  /  1  d a y
 F o r e m a n 1 . 0 0 m a n
 M o r t a r  m i x i n g u n s k i l l e d  l a b o r 4 . 0 0 m a n
 E x c a v a t i o n u n s k i l l e d  l a b o r 1 . 0 0 m a n
 B r i c k  l a y i n g s k i l l e d  l a b o r 1 . 0 0 m a n

u n s k i l l e d  l a b o r 2 . 0 0 m a n
 H e l p e r u n s k i l l e d  l a b o r 2 . 0 0 m a n
T o t a l  l a b o r 1 1 . 0 0 m a n

T o o l s  ( D a i l y )
 S h o v e l 1 . 0 0 p c s
 B u c k e t 2 0  l i t 3 . 0 0 p c s
 W h e e l  b a r r o w 2 . 0 0 p c
 M o r t a r  b o x 1 . 0 0 p c
 T r o w e l 2 . 0 0 p c s
 D r u m 1 . 0 0 p c
 H o e 1 . 0 0 p c
 B r i c k  b o l s t e r 1 . 0 0 p c
 B u i l d e r ' s  l e v e l 1 . 0 0 p c
 M e a s u r i n g  t a p e 1 . 0 0 p c
 P e g

4 - 2 B o x 6 0 0 m m  x  6 0 0 m m  x  4 7 5 m m  ( D e p t h )  w a l l  5  l a y e r s
B r i c k s 2 2 3 . 0 0 p c s
M o r t a r 1 : 3 0 . 1 6 m ^ 3
 M a t e r i a l  T o t a l

L a b o r / l o c a t i o n     3 l o c a t i o n s  /  1  d a y
 F o r e m a n 0 . 3 3 m a n
 M o r t a r  m i x i n g u n s k i l l e d  l a b o r 2 . 0 0 m a n
 E x c a v a t i o n u n s k i l l e d  l a b o r 0 . 3 3 m a n
 B r i c k  l a y i n g s k i l l e d  l a b o r 0 . 3 3 m a n

u n s k i l l e d  l a b o r 0 . 6 7 m a n

u n i t r e m a r k sI t e m n a m e
s p e c i f i c a t i o n ,
q u a l i t y ,  s h a p e
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L a b o r
 F o r e m a n 0 . 1 3 m a n
 S k i l l e d  l a b o r 0 . 2 5 m a n
 U n s k i l l e d  l a b o r 3 . 5 0 m a n
 T o t a l  l a b o r 3 . 8 8 m a n

T o o l s  ( D a i l y  )
 W h e e l  b a r r o w 2 . 0 0 p c s
 B u c k e t 2 . 0 0 p c s
 P l i e r 2 . 0 0 p c s
 B u i l d e r ' s  l e v e l 1 . 0 0 p c
 M e a s u r i n g  t a p e 1 . 0 0 p c

1 1 - 2 G a b i o n  w o r k    p e r  p i e c e 2 . 0 m x  1 . 0 m x  0 . 5 m

M a t e r i a l
 R u b b l e  s t o n e 0 . 9 5 m ＾ 3
 G a b i o n  w i r e  n e t 1 . 0 0 p c
 T o t a l  m a t e r i a l

L a b o r
 F o r e m a n 0 . 1 0 m a n
 S k i l l e d  l a b o r 0 . 2 0 m a n
 U n s k i l l e d  l a b o r 2 . 0 0 m a n
 T o t a l  l a b o r 2 . 3 0 m a n

T o o l s  ( D a i l y )
 T h e  s a m e  a s  1 1 - 1

1 2 D i s c h a r g e  P i p e  i n s t a l l a t i o n  p e r  1 0 0 m
M a t e r i a l
 P V C  p i p e c l a s s  6 1 6 . 7 p c

F o r e m a n 0 . 5 0 m a n
 U n s k i l l e d  l a b o r 7 . 5 0 m a n
 T o t a l  l a b o r 8 . 0 0 m a n

1 3 G a t h e r i n g  s t o n e s p e r  1 0 m ^ 3    d i s t a n c e  5 0 m
U n s k i l l e d  l a b o r 1 5 . 0 0 m a n

T o o l s  ( d a i l y )
 W h e e l  b a r r o w 7 . 0 0 p c s
 1 4  l b s  h a m m e r 4 . 0 0 p c s
 4  l b s  h a m m e r 2 . 0 0 p c s
 C h i s e l 2 . 0 0 p c s

1 4 T r a c t o r  t r a i l e r  l o a d i n g  a n d  u n l o a d i n g
 4  m ^ 3  /  1  t r i p ,   4  t r i p s  /  d a y  =  1 2  m ^ 3  /  d a y
u n s k i l l e d  l a b o r 1 5 . 0 0 m a n

s p e c i f i c a t i o n ,
q u a l i t y ,  s h a p e

q u a n t i t y u n i t r e m a r k sI t e m n a m e

8 F i n i s h i n g  s l o p e  ( c u t  e a r t h )   p e r  1 0 0 m ^ 2
 L a b o r
 F o r e m a n 1 . 4 0 m a n
 U n s k i l l e d  l a b o r 1 1 . 8 0 m a n
 T o t a l  l a b o r 1 3 . 2 0 m a n

T o o l s
 S h o v e l 4 . 0 0 p c s
 H o e 7 . 8 0 p c s
 S t r i n g 1 . 0 0 r o l l

9 F i n i s h i n g  s l o p e  ( e m b a n k m e n t )   p e r  1 0 0 m ^ 2
 L a b o r
 F o r e m a n 1 . 6 0 m a n
 U n s k i l l e d  l a b o r 2 5 . 8 0 m a n
 T o t a l  l a b o r 2 7 . 4 0 m a n

T o o l s
 S h o v e l 4 . 0 0 p c s
 H o e 2 1 . 8 0 p c s
 S t r i n g 1 . 0 0 r o l l

1 0 S t o n e  m a s o n r y p e r  1 m ^ 3
M a t e r i a l
 R u b b l e  s t o n e 1 . 0 8 m ＾ 3
 M o r t a r 0 . 5 5 m ^ 3
 T o t a l  m a t e r i a l

L a b o r  ( n o t  i n c l u d e  m o r t a r  m i x i n g )
 F o r e m a n 0 . 3 0 m a n
 S k i l l e d  l a b o r 0 . 6 0 m a n
 U n s k i l l e d  l a b o r 3 . 6 0 m a n
 T o t a l  l a b o r 4 . 5 0 m a n

T o o l s  ( D a i l y ,  n o t  i n c l u d e  m o r t a r  m i x i n g )
 B u c k e t 2 0  l i t 4 . 0 0 p c s
 W h e e l  b a r r o w 4 . 0 0 p c
 T r o w e l 4 . 0 0 p c s
 B u i l d e r ' s  l e v e l 1 . 0 0 p c
 M e a s u r i n g  t a p e 1 . 0 0 p c
 P e g

1 1 - 1 G a b i o n  w o r k    p e r  p i e c e 2 . 0 m x  1 . 0 m x  1 . 0 m

M a t e r i a l
 R u b b l e  s t o n e 1 . 9 0 m ＾ 3 2 . 0  x  0 . 9 5
 G a b i o n  w i r e  n e t 1 . 0 0 p c
 S t e e l  w i r e
 T o t a l  m a t e r i a l

I t e m n a m e
s p e c i f i c a t i o n ,
q u a l i t y ,  s h a p e
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Table 2-37 Example of Cost Calculation Sheet 

 

 

 

 

 

 

 

 
 

C o s t  E s t i m a t i o n N a m e  o f  t h e  S i t e :  E x a m p l e
U n i t  P r i c e P r i c e

M K M K
e x c a v a t i o n u n s k i l l e d  l a b o r 1 . 0 m a n 0 . 0 0 . 0 0 . 3 3 x 3
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 6 . 0 m a n 0 . 0 0 . 0 2 . 0 x 3
b r i c k  l a y i n g f o r e m a n 1 . 0 m a n 0 . 0 0 . 0 0 . 3 3 x 3

s k i l l e d  l a b o r 1 . 0 m a n 3 0 0 . 0 3 0 0 . 0 0 . 3 3 x 3
u n s k i l l e d  l a b o r 2 . 0 m a n 0 . 0 3 0 0 . 0 0 . 6 7 x 3

l a b o r  t o t a l 6 0 0 . 0

6 G a b i o n  W o r k
g a b i o n  2 . 0  x  1 . 0  x  1 . 0 8 . 0 p c s 1 1 0 0 0 . 0 8 8 , 0 0 0 . 0
r u b b l e  s t o n e 1 5 . 2 m ^ 3 0 . 0 0 . 0 2 . 0 x 0 . 9 5 x 8
s t e e l  w i r e 2 . 0 k g 1 2 5 0 . 0 2 , 5 0 0 . 0
m a t e r i a l  t o t a l 9 0 , 5 0 0 . 0

g a b i o n  w o r k f o r e m a n 1 . 0 m a n 0 . 0 0 . 0 0 . 1 3 x 8
s k i l l e d  l a b o r 2 . 0 m a n 3 0 0 . 0 6 0 0 . 0 0 . 2 5 x 8
u n s k i l l e d  l a b o r 2 8 . 0 m a n 0 . 0 0 . 0 3 . 5 x 8

l a b o r  t o t a l 6 0 0 . 0

7 F u e l d i e s e l 5 0 . 0 l i t 1 9 0 . 0 9 5 0 0 . 0

8 O t h e r s

T o t a l  M a t e r i a l  C o s t 9 2 1 , 0 6 6 . 0
r u b b l e  s t o n e 6 3 . 8 m ^ 3 0 . 0 0 . 0
s a n d 2 7 . 6 m ^ 3 0 . 0 0 . 0
c e m e n t o r d i n a r y  p o r t l a n d 3 1 0 . 3 b a g 2 , 5 0 0 . 0 7 7 5 , 8 0 0 . 0
b r i c k s 1 8 , 9 2 4 . 0 p c s 1 . 5 2 8 , 3 8 6 . 0
g a b i o n 8 . 0 p c s 1 1 , 0 0 0 . 0 8 8 , 0 0 0 . 0
s t e e l  w i r e 2 . 0 k g 1 , 2 5 0 . 0 2 , 5 0 0 . 0
P V C  p i p e φ 1 4 0  c l a s s 6 4 . 0 p c s 4 , 2 2 0 . 0 1 6 , 8 8 0 . 0
f u e l d i e s e l 5 0 . 0 l i t 1 9 0 . 0 9 , 5 0 0 . 0

T o t a l  L a b o r  C o s t 1 6 , 5 0 0 . 0
f o r e m a n 1 5 . 5 m a n 0 . 0 0 . 0 A E D O
s k i l l e d  l a b o r 5 5 . 0 m a n 3 0 0 . 0 1 6 , 5 0 0 . 0 i f  e m p l o y e d
u n s k i l l e d  l a b o r 8 3 9 . 1 m a n 0 . 0 0 . 0 F a r m e r s

T o t a l  C o n s t r u c t i o n  C o s t 9 3 7 , 5 6 6 . 0

S p e c i f i c a t i o n / Q u a
l i t y

Q u a n t i t yN o . I t e m U n i t R e m a r k s

C o s t  E s t i m a t i o n N a m e  o f  t h e  S i t e :  E x a m p l e
U n i t  P r i c e P r i c e

M K M K

1 P r e p a r a t i o n  W o r k
S i t e  c l e a r i n g u n s k i l l e d  l a b o r 1 5 . 0 m ･ d 0 . 0 0 . 0 1 d a y
G a t h e r i n g  s t o n e s u n s k i l l e d  l a b o r 9 4 . 8 m a n 0 . 0 0 . 0 6 3 . 8 / 1 0 x 1 5
G a t h e r i n g  s a n d u n s k i l l e d  l a b o r 3 7 . 8 m a n 0 . 0 0 . 0 2 5 . 2 / 1 0 x 1 5
l a b o r  t o t a l 0 . 0

2 S t o n e  M a s o n r y  W e i r V = 4 0 . 0 m ^ 3
r u b b l e  s t o n e 4 3 . 2 m ^ 3 0 . 0 0 . 0 4 0  x  1 . 0 8
s a n d 1 7 . 6 m ^ 3 0 . 0 0 . 0 4 0  x  0 . 5  x  1 . 1  x  0 . 8
c e m e n t o r d i n a r y  p o r t l a n d 1 9 8 . 0 b a g 2 , 5 0 0 . 0 4 9 5 , 0 0 0 . 0 4 0  x  0 . 5  x  1 . 1  x  9
m a t e r i a l  t o t a l 4 9 5 , 0 0 0 . 0

e x c a v a t i o n u n s k i l l e d  l a b o r 7 . 8 m a n 0 . 0 0 . 0 1 0 m ^ 3
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 1 3 2 . 0 m a n 0 . 0 0 . 0 4 0  x  0 . 5  x  1 . 1  x  6
s t o n e  m a s o n r y f o r e m a n 1 2 . 0 m a n 0 . 0 0 . 0 0 . 3  x  4 0

s k i l l e d  l a b o r 2 4 . 0 m a n 3 0 0 . 0 7 , 2 0 0 . 0 0 . 6  x  4 0
u n s k i l l e d  l a b o r 1 4 4 . 0 m a n 0 . 0 7 , 2 0 0 . 0 3 . 6  x  4 0

l a b o r  t o t a l

3 I n t a k e V = 5 . 0 m ^ 3
r u b b l e  s t o n e 5 . 4 m ^ 3 0 . 0 0 . 0 5 . 0  x  1 . 0 8
s a n d 2 . 2 m ^ 3 0 . 0 0 . 0 5  x  0 . 5  x  1 . 1  x  0 . 8
c e m e n t o r d i n a r y  p o r t l a n d 2 4 . 8 b a g 2 , 5 0 0 . 0 6 1 , 8 7 5 . 0 5  x  0 . 5  x  1 . 1  x  9
P V C φ = 1 4 0 1 . 0 p c 3 , 0 0 0 . 0 3 , 0 0 0 . 0 6 m
m a t e r i a l  t o t a l 6 4 , 8 7 5 . 0

e x c a v a t i o n u n s k i l l e d  l a b o r 1 . 6 m a n 0 . 0 0 . 0 2 m ^ 3
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 1 6 . 5 m a n 0 . 0 0 . 0 5  x  0 . 5  x  1 . 1  x  6
s t o n e  m a s o n r y f o r e m a n 1 . 5 m a n 0 . 0 0 . 0 0 . 3  x  5 . 0

s k i l l e d  l a b o r 3 . 0 m a n 3 0 0 . 0 9 0 0 . 0 0 . 6  x  5 . 0
u n s k i l l e d  l a b o r 1 8 . 0 m a n 0 . 0 9 0 0 . 0 3 . 6  x  5 . 0

l a b o r  t o t a l 1 , 8 0 0 . 0

4 M a i n  C a n a l  R e c t a n g u l a r W = 0 . 3 6    D = 0 . 3 8 3 0 0 . 0 m
b r i c k s 1 8 , 2 5 5 . 0 p c s 1 . 5 2 7 , 3 8 2 . 5 7 3 0 . 2 x 3 0 0 / 1 2
s a n d 7 . 4 m ^ 3 0 . 0 0 . 0 0 . 3 7 x 3 0 0 / 1 2 x 0 . 5
c e m e n t o r d i n a r y  p o r t l a n d 8 3 . 3 b a g 2 , 5 0 0 . 0 2 7 , 3 8 2 . 5 0 . 3 7 x 3 0 0 / 1 2 x 9
m a t e r i a l  t o t a l 5 4 , 7 6 5 . 0

e x c a v a t i o n u n s k i l l e d  l a b o r 9 . 6 m a n 0 . 0 0 . 0 7 5 m ^ 3 / 7 . 8
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 1 0 0 . 0 m a n 0 . 0 0 . 0 4 x 3 0 0 / 1 2
b r i c k  l a y i n g s k i l l e d  l a b o r 2 5 . 0 m a n 3 0 0 . 0 7 , 5 0 0 . 0 1 x 3 0 0 / 1 2

u n s k i l l e d  l a b o r 2 2 5 . 0 m a n 0 . 0 7 , 5 0 0 . 0 9 * 3 0 0 / 1 2
l a b o r  t o t a l 1 5 , 0 0 0 . 0

5 G u l l y  C r o s s i n g B o x    6 0 0  x  6 0 0  x  4 7 5 3 . 0 p c s
b r i c k s 6 6 9 . 0 p c s 1 . 5 1 , 0 0 3 . 5 2 2 3 . 0 x 3
s a n d 0 . 4 m ^ 3 0 . 0 0 . 0 0 . 1 6 x 0 . 8 x 3
c e m e n t 4 . 3 b a g 2 , 5 0 0 . 0 1 0 , 8 0 0 . 0 0 . 1 6 x 3 x 9
P V C  p i p e φ 1 4 0 3 . 0 p c 4 , 2 2 0 . 0 1 1 , 8 0 3 . 5 6 m
m a t e r i a l  t o t a l 2 3 , 6 0 7 . 0

S p e c i f i c a t i o n / Q u a
l i t y
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Table 2-38 Example of Manpower Planning

M a n p o w e r  P la n n i n g N a m e  o f  t h e  S i t e :  E x a m p le

A v a i l a b le  l a b o r
s k i l l e d  l a b o r 2  m a n  /  d a y
u n s k i l l e d  l a b o r 2 0  m a n  /  d a y

1 P r e p a r a t i o n  W o r k
S i t e  c l e a r i n g u n s k i l l e d  l a b o r 1 5 . 0 m a n ・ d a y 1 . 0 d a y 1 5 m a n / d a y
G a t h e r i n g  s t o n e s u n s k i l l e d  l a b o r 9 4 . 8 m a n ・ d a y 5 . 0 d a y 2 0 m a n / d a y
G a t h e r i n g  s a n d u n s k i l l e d  l a b o r 3 7 . 8 m a n ・ d a y 3 . 0 d a y 1 5 m a n / d a y
t o t a l 9 . 0 d a y

2 S t o n e  M a s o n r y  W e i r
e x c a v a t i o n u n s k i l l e d  l a b o r 7 . 8 m a n ・ d a y 1 . 0 d a y 8 m a n / d a y
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 1 3 2 . 0 m a n ・ d a y 6 m a n / d a y
s t o n e  m a s o n r y f o r e m a n 1 2 . 0 m a n ・ d a y 1 m a n / d a y

s k i l l e d  l a b o r 2 4 . 0 m a n ・ d a y 2 m a n / d a y
u n s k i l l e d  l a b o r 1 4 4 . 0 m a n ・ d a y 8 m a n / d a y

t o t a l 2 3 . 0 d a y

3 I n t a k e
e x c a v a t i o n u n s k i l l e d  l a b o r 1 . 6 m a n ・ d a y 1 . 0 d a y 2 m a n / d a y
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 1 6 . 5 m a n ・ d a y 6 m a n / d a y
s t o n e  m a s o n r y f o r e m a n 1 . 5 m a n ・ d a y 1 m a n / d a y

s k i l l e d  l a b o r 3 . 0 m a n ・ d a y 1 m a n / d a y
u n s k i l l e d  l a b o r 1 8 . 0 m a n ・ d a y 6 m a n / d a y

t o t a l 4 . 0 d a y

4 M a i n  C a n a l  R e c t a n g u la r W = 0 . 3 6    D = 0 . 3 8 3 0 0 . 0 m
e x c a v a t i o n u n s k i l l e d  l a b o r 9 . 6 m a n ・ d a y 1 . 0 d a y 1 0 m a / d a y
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 1 0 0 . 0 m a n ・ d a y 4 m a n / d a y
b r i c k  l a y i n g s k i l l e d  l a b o r 2 5 . 0 m a n ・ d a y 1 m a n / d a y

u n s k i l l e d  l a b o r 2 2 5 . 0 m a n ・ d a y 9 m a n / d a y
t o t a l 2 6 . 0 d a y

5 G u l l y  C r o s s i n g B o x    6 0 0  x  6 0 0  x  4 7 5 3 . 0 p c s
e x c a v a t i o n u n s k i l l e d  l a b o r 1 . 0 m a n ・ d a y 1 m a n / d a y
m o r t a r  m i x i n g u n s k i l l e d  l a b o r 6 . 0 m a n ・ d a y 6 m a n / d a y
b r i c k  l a y i n g f o r e m a n 1 . 0 m a n ・ d a y 1 m a n / d a y

s k i l l e d  l a b o r 1 . 0 m a n ・ d a y 1 m a n / d a y
u n s k i l l e d  l a b o r 2 . 0 m a n ・ d a y 2 m a n / d a y

t o t a l 1 . 0 d a y

6 G a b io n  W o r k 2 . 0 x 1 . 0 x 1 . 0 8 p c s
g a b i o n  w o r k f o r e m a n 1 . 0 m a n ・ d a y 1 m a n / d a y

s k i l l e d  l a b o r 2 . 0 m a n ・ d a y 1 m a n / d a y
u n s k i l l e d  l a b o r 2 8 . 0 m a n ・ d a y 1 4 m a n / d a y

t o t a l 2 . 0 d a y

S p e c i f i c a t i o n /
Q u a l i t y

Q u a n t i t y

2 . 0

N o . I t e m U n i t

2 2 . 0

3 . 0

2 5 . 0

d a y

R e m a r k sd a yp e r io d

1 . 0

d a y

d a y

d a y

d a y
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CHAPTER 3 O&M OF IRRIGATION FACILITIES 

 

3.1 River Diversion Weir 

As per fixed type weir of stone masonry or gabion, no routine maintenance work is usually required. 
Inspection around the weir should be carried out periodically and after every flood and every year 
before starting dry season irrigation. Following items should be inspected, 

- Damaged part of stone masonry. 
- Damaged part of gabion. 
- Scouring at downstream of the weir. 
- Sediment at upstream. 
- Scouring at both side abutments. 

Damaged part of stone masonry gabion should be repaired with mortar and damaged part of gabion 
should also be considered for rehabilitation. Scoured part at downstream of the weir should be 
protected by gabion or stone pitching. Scoured side abutment should be replaced with stone masonry 
or gabion, or reinforced with gabion or sand bags. In the case that sediment accumulated to inflow to 
canal, it should be removed. Maintenance check list is shown in the Table 3-1. 

3.2 Water Impounding Dam 

Inspection around the dam should be carried out periodically and after every flood and every year 
before starting dry season irrigation. Following things are inspected. 

- Water seepage from embankment  
- Erosion, collapse and/or cracks of embankment 
- Damage and/or crack of spillway stone masonry 
- Scouring at both side of spillway 
- Sediment around intake facility 
- Function of intake and outlet gates, valves 

Maintenance check list is shown in the Table 3-1. 

3.3 Motorized Pump 

Mechanical equipment is affected by, increased wear, deformation, or deterioration during operation, 
low performance shortened life by the occurrence of severe oil leaks and moisture, weather conditions, 
artificial obstacles, etc. As these items cause problems, it is necessary that careful periodic inspections 
and maintenance be made. Inspection cycles differ by the kind of equipment, conditions of use, 
importance, frequency of trouble, dirt quantity, temperature, and quality of work. 

(1) Check Lists  

During maintenance, it is necessary to prepare check lists introducing inspection items, contents of 
inspections and inspection marks for each installation and piece of equipment from management 
standards. Maintenance check list is shown in the Table 3-1. 

(2) Records 

During maintenance, prepare inspection record tables before hand, and fill in measured dimensions of 
each component and others for use of future maintenance. 

(3) Inspection Cycles 

The concept of daily, monthly and annual inspections is described below. 
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1) Daily Inspections 

Daily inspection check for any disorder before the operator operates any equipment and check 
equipment function by actual operation. If any disorder is found during these inspections, appropriate 
measures such as immediate repair should be taken for minor problems and entry made in record 
books.  

2) Monthly Inspections 

Monthly inspection and checking for problems should be done atleast once a month. This is performed 
by an operator on each piece of equipment. If any minor disorder is found in this check, appropriate 
measures such as immediate repair should be taken and entry made in record books. For a problem 
which is considered to have a major effect on the function or life of the equipment, appropriate 
measures must be taken in the form of a precise inspection by an expert.  

3) Annual Inspections 

Annual inspections check the total function of each piece of equipment. This is performed annually by 
operator and should be completed before an operation period. If possible, total trial operation should 
be accomplished during this inspection.  

(4) Periodic Maintenance 

Periodic maintenance is desirable to be executed once in 5 to 8 years, though it differs by the use of 
structures and repair of damage, wear and other abnormal component; and parts replacement is carried 
out on mechanic’s diagnosis. Before periodic maintenance of work based on pre-determined plan, tool 
preparation, necessary replacement items, packing, lubricating oil, etc. is necessary. 

(5) Temporary Maintenance 

Temporary maintenance is performed to prevent trouble and accidents before hand in event 
discrepancies are found during daily and periodic inspections other than periodic maintenance. 

3.4 Canals 

(1) Main and Secondary Canals 

Stream water usually contains certain amount of suspended particulars, causing sedimentation in the 
canal. Eroded soil loss from field also gets into canal, resulting in the sedimentation in the canal. 
Maintenance work for canal should be done at least once before the irrigation season starts. 
Maintenance works required for the canal are; cleaning, weeding, de-silting, re-shaping, and also 
minor repairs as described below; 

1) Earth canal 

- Bushes and trees on the canal embankments should be removed. They may obstruct the 
water flow and their roots open the banks and develop leakages. 

- Grasses, sediments and debris in the canal should be removed. While cleaning the canal, 
care must be so taken that the original shape of the cross-sections is kept. For this, a 
wooden frame with exact dimensions of the designed cross-section can be of great help. 

- Crossing sections by people and animals (livestock) along the canal should be 
strengthened by hard compaction or lined with stones, bricks or masonry. 

- Holes/cracks in the canal should be filled with sticky clay soil, and eroded sections should 
be rebuilt to the original shape. 

2) Brick lined canal 

- Grasses, sediments and debris in the canal should be removed. 
- Cracks and water leaking point should be repaired with mortar. 
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(2) Division Box, Discharge Box and Turnout 

Division box, discharge box and turnout are made of brick masonry and the same maintenance work as 
brick masonry canal is required. In addition, maintenance on stop-log grooves is required. Damaged 
stop-log grooves should be repaired and reshaped with mortar to meet to stop-log. In case the 
connection part to earth canal is scoured, the part should be reinforced with gravel laying. 
Maintenance check list is shown in the Table 3-1. 

3.5 Maintenance Cost 

Maintenance cost for each item is roughly estimated as shown in Table 3-2. 

 

Table 3-1 Maintenance Check Lists 

 
 
 
 
  

I t e m F re q u e n c y P o in t  t o  b e  c h e c k e d F in d in g s
1 . R iv e r  D a ily W a te r  le v e l E n o u g h  o r  n o t . 
   c o n d it io n s D a ily W a te r  f lo w  c o n d it io n s S ta b le  o r  n o t . F lo o d , r ic h  o r  d ro u g h t .

D a ily S e d im e n t If  it  is  a  lo t  to  a ffe c t  in ta k e , it  s h a ll b e  re m o v e d .
O th e rs W a t e r  q u a lit y , f lo ta g e  e tc .

2 . W e ir A n n u a lly
C ra c k  o r  d a m a ge  o f  s to n e
m a s o n ry

S m a ll s c a le  o r  la r g e  s c a le . N e e d  re p a ir  o r  n o t

A t  a f te r E ro s io n  a t  a b u tm e n t N e e d  re p a ir  o r  p ro te c t io n  o r  n o t
A n n u a lly W a te r  le a k a g e S m a ll s c a le  o r  la r g e  s c a le . N e e d  re p a ir  o r  n o t

A n n u a lly
R iv e rb e d  s c o u r in g  a t
d o w n s t re a m

N e e d  p ro te c t io n  o r  n o t

D a ily S e d im e n t If  it  is  a  lo t  to  a ffe c t  in ta k e , it  s h a ll b e  re m o v e d .
A n n u a lly D a m a ge  o f  g a b io n S m a ll s c a le  o r  la r g e  s c a le . N e e d  re p a ir  o r  n o t

A n n u a lly
S u b s id e n c e  a n d  d e fo rm a t io n
o f  g a b io n

S ta b le  o r  n o t . N e e d  re p a ir  o r  n o t .

O th e rs

3 . In ta k e A n n u a lly
C ra c k  o r  d a m a ge  o f  s to n e
m a s o n ry

S m a ll s c a le  o r  la r g e  s c a le . N e e d  re p a ir  o r  n o t

D a ily S e d im e n t If  it  is  a  lo t  to  a ffe c t  in ta k e  p ip e s , it  s h a ll b e  re m o v e d .
D a ily T ra s h If  it  is  a  lo t  to  b lo c k  in ta k e  p ip e s , it  s h a ll b e  re m o v e d
D a ily W a te r  le v e l E n o u g h  o r  n o t

M o n th ly D a m a ge  o f  p ip e s N e e d  re p a ir  o r  n o t .
D a ily F u n c t io n F u n c t io n in g  o r  n o t .

O th e rs
4 . O t h e rs M o n th ly C o n d it io n s  o f  s to p  lo g N e e d  re p a ir  o r  n o t .

M o n th ly C o n d it io n s  o f  g a t e N e e d  p a in t in g , r e a p ir  o r  n o t .
P ro te c t io n  b u n d C o lla p s e  o r  e ro s io n . N e e d  re p a ir  o r  n o t .

I t e m F re q u e n c y P o in t  t o  b e  c h e c k e d F in d in g s
1 . R e s e rv o ir D a ily W a te r  le v e l E le v a t io n

A n n u a lly S e d im e n t D e p th
O th e rs

2 . S p illw a y A n n u a lly
C ra c k  o r  d a m a ge  o f  s to n e
m a s o n ry

S m a ll s c a le  o r  la r g e  s c a le . N e e d  re p a ir  o r  n o t

A t  a ft e r
e v e ry  f lo o d

E ro s io n  a t  a b u tm e n t N e e d  re p a ir  o r  p ro te c t io n  o r  n o t

A t  a ft e r
e v e ry  f lo o d

E ro s io n  a t  d o w n s t re a m N e e d  re p a ir  o r  p ro te c t io n  o r  n o t

A t  f lo o d
t im e

F lo w  c a p a c ity E n o u g h  o r  n o t  (a t  f lo o d  t im e )

A t  f lo o d
t im e

F lo w  c o n d it io n  a t  f lo o d S ta b le  o r  n o t

A n n u a lly C o n d it io n s  o f  c h a n n e l D a m a g e , w e e d s  e tc .
O th e rs

3 . D a m  M o n th ly C ra c k  a t  e m b a n k m e n t If  th e re  is , c o n s u lt  w ith  ir r ig a t io n  e n g in e e r .
   e m b a n k m e n t M o n th ly E ro s io n  o f  e m b a n k m e n t S m a ll s c a le  o r  la r g e  s c a le . n e e d  re p a ir  im m e d ia te ly  o r  n o t .

M o n th ly C o lla p s e  o f  e m b a n km e n t S m a ll s c a le  o r  la r g e  s c a le . n e e d  re p a ir  im m e d ia te ly  o r  n o t .

M o n th ly
W a te r  le a k a g e  a t  d o w n
s t re a m

S m a ll s c a le  o r  la r g e  s c a le . e x p a n d in g  o r  n o t . N e e d  re p a ir
im m e d ia te ly  o r  n o t .

O th e rs

4 . In ta k e  a n d  A n n u a lly S e d im e n t If  it  is  a  lo t  to  a ffe c t  in ta k e  p ip e , it  s h a ll b e  re m o v e d .
   o u t le t D a ily T ra s h If  it  is  a  lo t  to  a ffe c t  in ta k e  p ip e , it  s h a ll b e  re m o v e d .

D a ily F u n c t io n F u n c t io n in g  o r  n o t .
O th e rs

5 . O t h e rs D a ily W a te r  q u a lit y A f fe c t  to  c ro p s  o r  n o t .

M a in t e n a n c e  C h e c k  L is t  fo r  R iv e r  D iv e r s io n  W e ir

M a in t e n a n c e  C h e c k  L is t  fo r  W a t e r  Im p o u n d in g  D a m
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Maintenance Check List for Pump and Engine 

Item Frequency Point to be checked Findings 
1. Diesel  Daily Appearance Need re-painting or not, Neede repair or not 
   Engine Daily Engine oil Enough or not 
  Daily Fuel tank Enough fuel or not 
  Daily Noise Abnormal noise or not 
  Daily Vibration Abnormal vibration or not 
  Daily Oil and fuel leakage Any leakage 
        
  Monthly Various bolts for loosening Tighten all bolts and nuts 
  Monthly Vent hole in the fuel tank cap Cleaning 
  Monthly Battery Water level 
  Monthly Fuel tank Cleaning 
  Monthly Fuel filter Cleaning 
        
  Monthly Engine oil filter element Need replacement or not  
  Monthly Fuel filter element Need replacement or not  
  Monthly Engine oil Replacement at every 500hrs (10HP) or every 200hrs (41HP)
  Monthly Paint condition  Need re-painting or not 
  Monthly Air cleaner Cleaning or replacement 
  Monthly Fan velt Adjust tension worn out or not 
    Cylinder head portion(nozzle,  valves Adjustment, cleaning 
    Shaft portion Adjustment 
    Main engine portion (piston, crank, etc) Adjustment, cleaning 
    Fuel injection system Adjustment, cleaning 
    Gasket Need replacement or not 
        
2. Pump  Daily Vibration Abnormal vibration or not 
  Equipment Daily Noise Abnormal noise or not 
  Daily Water leakage Small scale or large scale. Need repair or not. 
        
  Monthly Appearance Need re-painting or not, Need repair or not 
  Monthly Loose bolts Tighten all bolts and nuts 
  Monthly Coupling rubber wear Need replacement or not 
        
  Annually Gland packing wear condition Need replacement or not 
  Annually Grease Greasing 
  Annually Shaft center misalignment Adjustment 
  Annually Paint condition Need re-painting or not 
        
3.Others Daily Conditions of strainer. Clogged or not. Cleaning 
  Daily Conditions of suction pipe Damaged or not. (water leakage) 
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I t e m F r e q u e n c y P o in t  t o  b e  c h e c k e d F in d in g s
1 . B r ic k  o r  D a i ly W a t e r  f lo w  c o n d it io n s S m o o t h  o r  n o t
  c o n c r e t e M o n t h ly C r a c k  o r  d a m a g e S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e p a ir  o r  n o t

  lin e d  c a n a l A n n u a l ly
C o n d it io n s  o f  d r a in  d it c h
( a lo n g  t h e  m a in  c a n a l)

F u n c t io n in g  o r  n o t .  N e e d  e x c a v a t io n  o r  n o t .

M o n t h ly S e d im e n t S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e m o v a l o r  n o t
M o n t h ly W e e d s A  lo t  o r  a  f e w . N e e d  c le a r in g  o r  n o t .

O t h e r s
2 . E a r t h  c a n a l D a i ly W a t e r  f lo w  c o n d it io n S m o o t h  o r  n o t

M o n t h ly C r o s s  s e c t io n  a r e a E n o u g h  c r o s s  s e c t io n  o r  n o t
M o n t h ly E r o s io n N e e d  r e p a ir  o r  n o t
M o n t h ly W e e d s N e e d  c le a r in g  o r  n o t

O t h e r s
3 . R o a d D a i ly W a t e r  f lo w  c o n d it io n s S m o o t h  o r  n o t
   c r o s s in g  a n d M o n t h ly S e d im e n t S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e m o v a l o r  n o t
  g u lly  c r o s s in g M o n t h ly C r a c k  o r  d a m a g e S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e p a ir  o r  n o t

D a i ly T r a s h I f  it  is  a  lo t  t o  b lo c k  p ip e , it  s h a l l b e  r e m o v e d
O th e r s

4 . S t r u c t u r e s D a i ly W a t e r  f lo w  c o n d it io n s S m o o t h  o r  n o t
  ( d iv is io n  b o x , M o n t h ly S e d im e n t S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e m o v a l o r  n o t
  d r o p  b o x M o n t h ly C r a c k  o r  d a m a g e S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e p a ir  o r  n o t
  t u r n o u t ) M o n t h ly C o n d it io n s  o f  s t o p  lo g N e e d  r e p a ir  o r  n o t

O t h e r s
5 . O t h e r s

I t e m F r e q u e n c y P o in t  t o  b e  c h e c k e d F in d in g s
1 . R iv e r D a i ly W a t e r  f lo w  c o n d it io n s S t a b le  o r  n o t ,  f lo o d , r ic h  o r  d r o u g h t
   c o n d it io n s D a i ly W a t e r  le v e l E le v a t io n

D a i ly C o n d it io n s  o f  in t a k e  p o in t E n o u g h  d e p t h  o r  n o t ,  A n y  o b s t r u c t io n .
O t h e r s

2 . P ip e s M o n t h ly C r a c k  o r  d a m a g e S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e p a ir  o r  r e p la c e m e n t .
M o n t h ly W a t e r  le a k a g e S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e p a ir  o r  r e p la c e m e n t .

O t h e r s
3 . .  D is c h a r g e D a i ly W a t e r  f lo w  c o n d it io n s S m o o t h  o r  n o t
   b o x M o n t h ly S e d im e n t S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e m o v a l o r  n o t

M o n t h ly C r a c k  o r  d a m a g e S m a ll s c a le  o r  la r g e  s c a le .  N e e d  r e p a ir  o r  n o t

M o n t h ly
C o n d it io n s  o f  s t o p  lo g  a n d
g r o o v e

N e e d  r e p a ir  o r  n o t

O t h e r s
4 . O t h e r s

M a in t e n a n c e  C h e c k  L is t  f o r  C a n a l  S y s t e m

M a in t e n a n c e  C h e c k  L is t  f o r  P ip e l in e  S y s t e m
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Table 3-2 Maintenance Cost for Each System 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unit Price Price
MK MK

1 R iver D iversion We ir
1-1 Annual maintenance
(1) Removal of sediment unskilled labor 10.0 man 0.0 0.0 2man x 5 days

Total 10.0 man 0.0

1-2 Every 5 years
(1) Reapir of stone masonry weir, intake 0.50 m^3

rubble stone 0.27 m^3 0.0 0.0
sand 0.20 m^3 0.0 0.0
cement ord inary portland 2.25 bags 2,500.0 5,625.0
Fuel 10.00 lit 240.0 2,400.0 transportation
material total 8,025.0

mortar m ixing unskilled labor 6.0 man 0.0 0.0 1day
stone masonry foreman 1.0 man 0.0 0.0 1day

skilled labor 1.0 man 300.0 300.0 1day
unskilled labor 5.0 man 0.0 0.0 1day

labor total 300.0

(2) Repair of gabion
rubble stone 0.0 m^3 0.0 0.0
steel w ire 1.0 kg 150.0 150.0
material total 150.0

gabion work skilled labor 1.0 man 300.0 300.0 1day
gabion work unskilled labor 2.0 man 0.0 0 .0 1day
labor total 300.0

Every 5 years Total materia l 8,175.0
labor 600.0

2 Water Impounding Dam
2-1 Annual maintenance
(1) De-silting of the reservoir 200.0 m^3

Excavation unskilled labor 156.0 man 0.0 0.0
Hauling excavated materia l unskilled labor 88.0 man 0.0 0.0 100m
labor total 0 .0

2-2 Every 5 years
(1) Repair of Embankment 10.0 m^3

Embankment unskilled labor 7.6 man 0.0 0.0
Hauling materia l unskilled labor 4.4 man 0.0 0.0 100m
Finsing slope unskilled labor 1.2 man 0.0 0.0 10m^2
labor total 0 .0

(2) Repair of stone masonry 0.5 m^3 spillway
rubble stone 0.27 m^3 10.0 2.7
sand 0.20 m^3 10.0 2.0
cement ord inary portland 2.25 bags 2,500.0 5,625.0
Fuel 10.00 lit 240.0 2,400.0 transportation
material total 8,029.7

mortar m ixing unskilled labor 6.0 man 0.0 0.0 1day
stone masonry foreman 1.0 man 0.0 0.0 1day

skilled labor 1.0 man 300.0 300.0 1day
unskilled labor 5.0 man 0.0 0.0 1day

labor total 300.0

Every 5 years Total materia l 8,029.7
labor 300.0

2-3 Every 20 years
(1) Replacement of intake gate 1.0 set 150,000.0 150,000.0

(2) Replacement of outlet valve 1.0 set 150,000.0 150,000.0

Evry 20 years total 300,000.0

No. Item Unit Remarks
Specification/Qua

lity
Quantity
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3 Open Cana l System
3-1 Annual m a intenance
(1 ) C lean ing cana l 300m

unskilled labor 20 .0 m an 0 .0 0 .0

(2 ) Repa ir o f earth cana l
Re-shap ing unskilled labor 0 .0 0 .0 each p lot owner

3-2 Every 3  years
(1 ) Repa ir o f brick lin ing

equvalent to  10m  construction 10 .0 m
bricks 608.5 pcs 1 .5 912 .8 730 .2x10/12
sand 0 .2 m ^3 0 .0 0 .0 0 .34x10/12x0.5
cem ent ord inary portland 2 .6 bag 2 ,500 .0 6 ,375 .0 0 .34x10/12x9
m ateria l tota l 7 ,287 .8

m ortar m ix ing unskilled labor 4 .0 m an 0 .0 0 .0
brick lay ing skilled labor 1 .0 m an 300 .0 300 .0

unskilled labor 7 .5 m an 0 .0 0 .0 9*300/12
labor tota l 300 .0

(2 ) Repa ir o f structures
equ iva lent to  1 box construction 1 .0 box
bricks 223.0 pcs 1 .5 334 .5 223 .0x1
sand 0 .1 m ^3 0 .0 0 .0 0 .15x0 .8x1
cem ent 1 .4 bag 2 ,500 .0 3 ,375 .0 0 .15x1x9
m ateria l tota l 3 ,709 .5

m ortar m ix ing unskilled labor 4 .0 m an 0 .0 0 .0
brick lay ing forem an 0 .3 m an 0 .0 0 .0 0 .33x1

skilled labor 0 .3 m an 300 .0 99 .0 0 .33x1
unskilled labor 0 .7 m an 0 .0 0 .0 0 .67x1

labor tota l 99 .0

Every 3  years Tota l m ateria l 10 ,997 .3
labor 399 .0

4 M otorized Pum p System
4-1 Annual m a intenance
(1 ) M a intenance of Engine

Engine  O il 10 .0 lit 740 .0 7 ,400 .0
O il filter e lem ent 1 .0 pc 700 .0 700 .0
Fuel filte r e lem ent 1 .0 pc 700 .0 700 .0
A ir c leaner e lem ent 1 .0 pc 2 ,000 .0 2 ,000 .0

(2 ) M a intenance of Pum p
G rease 0 .5 kg 720 .0 360 .0

Annual total 11 ,160 .0

4-2 Every 5  years
(1 ) M a intenance of Engine

Bearing 1 .0 pc 1 ,200 .0 1 ,200 .0
Pa in ting 1 .0 set 1 ,600 .0 1 ,600 .0
G asket 1 .0 pc 1 ,200 .0 1 ,200 .0

(2 ) M a intenance of Pum p
G asket 1 .0 set 1 ,300 .0 1 ,300 .0
G asket m aker 1 .0 pc 650 .0 650 .0
Pa in ting 1 .0 set 1 ,600 .0 1 ,600 .0

(3 ) P ipe line
Replacem ent of p ipes 2 .0 pc 4,220 .0 8 ,440 .0

Every 5  years tota l 15 ,990 .0

* P rices o f spare  parts varies  accord ing to  the type of engine and pum p .
* P rices are rough  standard at the  tim e o f 2008 .
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CHAPTER 4. Water Management of Irrigation Systems 

 

4.1 Introduction 

Eight verification sites were selected in the study to verify the proposed plans and procedures 
mentioned in the “Action Plan (A/P)”. Table 4-1 shows the summary indicating outline of the selected 
irrigation schemes for verification sites and needs of rehabilitation for irrigation facilities. Based on 
this summary table, current prevailing problems in the fields of irrigation water management of the 
Medium-Scale Irrigation Scheme were identified, and then rehabilitation and improvement subjects 
were listed up as the issues of the “Technical Guideline”, as shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Subsequent deals with the discussions on these issues in terms of the “Technical Guideline” of the 
“Package Plan” in the field of irrigation water management. 

4.2 Topographic Survey to demarcate Irrigation Area 

Topographic map for the scheme should be prepared to delineate the exact boundaries of the beneficial 
areas and also to estimate their irrigation areas. The preparation of topographic map would be done by 
the Irrigation Officers in District Agricultural Office (DAO) in the manner of simplified survey 
methods applicable for development of medium-scale irrigation schemes. The survey methods and 
procedures of them are specified as follows (refer to Figure 4-1) 1. 

 

                                                      
1 In addition to the above two methods of topographic survey, the Study Team tried to introduce “the Plain 

Survey methods being popularly applied in Japan for preparation of topographic survey. However, related 
field level government officer in the Malawi did not agree willingly, which is thought to be no familiar with 
them.  

  Uncertain hectarage in size for irrigation area 
  No observation and identification of available water sources for irrigation 
  No considerations of the required irrigation water requirement for planning and 

designing irrigation facilities  
  Low awareness of water saving technology for irrigation by farmers/EPA 
  No countermeasures for effective dam operation in case of drought year 
  No record keepings on water management activities 
  Areas facing poor drainage such as water loggings at farm level in wet season 

  Topographic survey to demarcate irrigation area 
  Discharge measurements at rivers/creaks and irrigation canals 
  Installation of staff gauges and observation of canal discharges by water level 
  Estimation of irrigation water requirements 
  Determination of water supply and distribution methods 
  Formulation of reservoir operation rule 
  Record keepings for water management 
  Improvement of drainage conditions to alleviate water loggings at farm level 

Rehabilitation / Improvement 
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Figure 4-1      Illustration of Topographic Survey Methods 
 
 
Topographic Survey Method (Type-1) 
 

 
Topographic Survey Method (Type-2) 

 
Topographic Survey Method (Type-2) 
●●・ 
 
 
 
・ 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Grid-line (20m interval)Baseline 

Boundary of Area 
●

●

●

●

● 
● 

● 

● 
● 

●

●

●

●

Measuring and Leveling Points 

●

●

● 

● 
● 

●

●

●

●

●
●

●

●
●

●

●

● 

●

● 

● 

● 

● ● 
● 

●● 
● 

●

●

●

● 
● 

● 

● 
● 

●

●

●

● 

● 

● 

● 

● ● 

●

● 

● 

● 

 

Boundary of Area 

78



 
Final Report, Annex 1 Technical Guidelines August 2009 

Survey Methods and Procedures (Type-1) 
i) Perimeter survey for the scheme (angle against magnetic north line (α) and length (L) 

using compass and measuring tape or chain) with driving in piles 
ii) Topographic and leveling survey using leveling equipment at intersection points with 20 

m interval on the basis of baseline 
iii)  Drawing of topographic map with an adequate scale 
iv)  Production of contour lines 

Survey Methods and Procedures (Type-2) 
i) Decision of scheme perimeter with driving in piles by means of reconnaissance survey  
ii) Provision of baseline at the center of the delineated area 
iii) Provision of 20 m interval lines intersected at right angle with the baseline 
iv)  Topographic and leveling survey using leveling equipment at intersection points with 20 

m interval 
v)  Drawing of topographic map with an adequate scale  
vi)  Production of contour lines applying topographic map preparation software of “Surfer 8”, 

which is only available at ADD Level. 
Drawings 

Scale of Drawing is different depending on the size of survey areas as follows; 
Area ≧ 10 ha  ---  1 : 1,000 
Area ＜ 10 ha   ---  1 : 500 

After delineation of the beneficial areas, irrigable areas covered by each lateral/feeder canal should be 
decided. These areas are the base for estimation of irrigation water requirements. 

4.3 Discharge Measurements at Rivers / Creeks and Irrigation Canals 

(1) Float Methods 

River or creak discharges can be estimated when the stream is in a well-defined channel with a flow 
that would carry a small float such as a plastic water bottle or a wooden stick. By using a plastic water 
bottle or a stick, the discharges could be estimated by multiplying the flow velocity to be measured at 
which a float is carried along by the average cross-sectional area of the stream. This method can be 
described below.  

Procedures for Estimating Discharge Flow 
 
 
 
 
 
 
 
 
 

 
 
Procedure: 

1.  Select a straight section of the stream/creak at least 10 m long. The shape of the 
stream/creak along this section should be as uniform as possible. 

2.  Place a stake in the bank at the upstream end of the selected section (1) and measure 10 m 
downstream. 

3.  Place a stake at the downstream end of the selected section of the stream (3). 
4.  Place the floating object in the center of the stream at least five meter upstream of section 

Section 1 Section 2 Section 3 

L (at least 10 m) 

Start Finish 

Flow 

a 

b 
h 

79



 
Final Report, Annex 1 Technical Guidelines August 2009 

(1), and start timing when the object reaches section (1). 
5.  Stop timing when the floating object reaches section (3), and record the time in second. 
6.  Repeat steps 4 and 5 at least four times in order to determine the average time necessary for 

the stick to travel from section (1) to (3). The stick should not touch the stream bank during 
the trial. If it does, repeat the run and do not include the time for the bad trial when 
calculating the average time.  

7.  Measure the following in the selected stream section: the stream width (b), the surface 
water width (a), and the water depth (h). The cross section width in the selected portion of 
the stream will not be regular, and so (a), (b) and (h) need to be measured in several places 
to obtain an average value. 

8.  Calculate the average area of the stream cross-section (A), using the following equation: 
       A =1/2 x (a +b) x h 
9.  Calculate the average flow velocity (V) 
       V = 0.8 x L/t (m/sec) 
         Where; 

                t  =  Average travel time (sec) 
                L  =  Distance between section (1) to (3) (m) 
                0.8 =  Reduction factor because not all the water flow as fast as that in the center 

10. Calculate the flow discharge (Q) in the stream, using the following equation: 
       Q = V x A (m3/sec) 

(2)  Manning Methods 

In order to estimate the canal discharges in case of uniform flow with trapezoidal or rectangular canal 
section, following “Manning Formula” developed hydraulically can be applied.  

Q = A x V (m3/sec) 
Where ;  

Q  = Canal discharge (m3/sec) 
A = Canal cross section (m2) :  1/2 x (b1 + b2) x h 
V = Flow velocity (m/sec) :  1/n x R2/3 x I1/2 
h  = Water depth (m) 
n = Roughness coefficient: 0.016 
I = Gradient of canal: 1/2,000 

(3)  V-Notch Methods2 

For the small flows, a 90o V-notch weir can be used. Following figure shows a small and portable that 
can be easily made in a workshop at a low cost. 

90 Degree V-Notch Weir 
 
 
 
 
 
 
 
 
 
 
 

                                                      
2  Quoted from Field Guide on Irrigated Agriculture for Field Assistants, FAO, April 2001 

b1 

b2 

h 

0.20 m 0.6 m 0.20 m

0.7 m 

H=0.3 m 

D=0.4 m 

W=1.00 m 

θ= 90° 

Section of weir plate made 
from wooden board or steel 
sheet 

Sharp metal edge 
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６

５

４

The weir is set up across the stream so that all the water flow passes over the weir. It is normally 
necessary to seal around the base and sides of the weir plate with soil to ensure that water flows 
through the V-notch rather than under or around the sides of the plate. It is important that the top edge 
of the weir is horizontal.  

The depth of water flowing over the notch is measured using a portable scale or ruler placed at least 
three meter upstream of the weir. The flow can then be found from following table, which shows the 
depth of water flowing over the weir to flow in liters per second. A V-notch weir can only be used 
where the water level on the downstream side does not interfere with the flow through the Vee. 

Flow Rates measured with a 90°V-Notch Weir 
 

Over Flow Depth on 
V-Notch (mm) 

Discharge 
Q (lit/sec) 

Over Flow Depth on 
V-Notch (mm) 

Discharge 
Q (lit/sec) 

40 0.45 170 16.60 
50 0.78 180 19.15 
60 1.23 190 21.92 
70 1.81 200 24.92 
80 2.52 210 28.15 
90 3.38 220 31.62 

100 4.41 230 35.34 
110 5.59 240 39.31 
120 6.95 250 43.53 
130 8.49 260 48.02 
140 10.21 270 52.76 
150 12.14 280 57.79 
160 14.26 290 63.09 

 
Flow rates (Q) are expressed by the following equation; 
     Q = 8/15 x C x 2g1/2 x H5/2 
        Where;  

C : Flow coefficient 0.59 
H : Overflow depth on V-notch (m) 
g : Acceleration due to gravity, 9.8 

When a V-notch weir is used to measure the flow rate, the following should be checked; 

  Full stream flow passes over the weir (seal the edge of the weir plate to the banks and bed with 
clay from the stream bank) 

  Weir plate is level (from side to side) and vertical (not learning forwards or backwards) 
  Weir is in the center of the stream 
  Measuring portion of the gauge should be at least three meter 

upstream of the weir 

4.4 Installation of Staff Gauges and Observation of Canal 
Discharges by Water Level 

In the “Manning Formula” methods mentioned in the above, the water depth 
(h) of canal can be measured by staff gauges to be installed. 

(1) Fabrication and Installation of Staff Gauge 

  Staff gauges made of iron plate can be procured, although painting of 
scale on the wooden timber would be possible at the major towns in 
each ADD. 

  Staff gauges can be installed on the side-wall of the lined canal, at the 
river side and in the reservoir. 
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  It is ensured that the location of the staff gauges should not be affected by the turbulence of 
flow so that accurate gauge readings can be made. 

 

(2) Development of Discharge Rating Curve (“Stage-Discharge Curve”) 

Discharge rating curve (“Stage-Discharge Curve”) is useful to get corresponding discharges to be 
converted from the observed water depth. The Stage-Discharge Curve” can be shown by calculating 
discharges applying the above-mentioned “Manning Formula”.  

Figure 4-2 shows the “Stage-Discharge Curve” thus calculated, and their tabulation of the 
“Stage-Discharge Table” in case of the Chibwana Irrigation Scheme. 

(3) Observation of Canal Discharge 

Canal water level at the main canal should periodically be observed by the members of “Water-Board 
Sub-Committee” at the fixed time every day. These water levels should be converted to the quantity of 
discharges using the above “Stage–Discharge Table”, and recorded in the record book.
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4.5   Estimation of Irrigation Water Requirements 

(1) Climate and Meteorological Data 

In the aspects of irrigation water management, estimation of irrigation water requirements is one of the 
essential elements to formulate the development plan for the irrigation schemes in each ADD. In the 
process for estimating the irrigation water requirements, the reference crop evapo- transpiration (ETo) 
for maize and upland crops could be estimated using the “CROPWAT 4 for Windows Computer 
Software” 3, being popular in the agricultural development plan in Malawi, which is based on the 
FAO Penman- Monteich Equation. On the other hand, the ETo for paddy rice could be estimated using 
the modified Penmam Methods. The Penman-Monteith equation is given by the following equation: 

 
 

 
 

Where;  
  ETo =  Reference evapo-transpitation (mm/day) 
  Rn  =  Net radiation at the crop surface (MJ/m2per day) 
  G  =  Soil heat flux density (MJ/m2per day) 
  T  =  Mean daily air temperature at 2 m height (℃） 
  U2  =  Wind speed at 2 m height (m/sec) 
  Es  =  Saturation vapour pressure (kpa) 
  Ea  =  Actual vapour pressure (kpa) 
  Es – ea =  Saturation vapour pressure deficit (pka) 

△     ＝  Slope of saturation vapor pressure curve at temperature T (kpa/℃) 
γ  =  Psychometric constant (kpa/℃) 

 

Crop water requirements (ETc/CWR) were estimated by multiplying ETo mentioned in the above by a 
crop coefficient (Kc), that is: 

 
ETc = ETo x Kc 

 
Where; 
  ETc/CWR =  Crop water requirements (mm/day) 
  ETo =  Reference crop evapo-transpiration (mm/day) 

Kc  =  Crop coefficient 
 

The above mentioned climatic and meteorological data presenting representative stations in each ADD 
were collected from the Meteorological Department, Ministry of Transport and Communication in 
Blantyre. 

Figure 4-3 shows the location map of climatic and meteorological observation stations in eight ADD, 
and also Table A.2-1 in the Attached Data shows tabulated climate and meteorological data observed 
at each station. 

 
 
 
 

                                                      
3 Detailed procedures for the “CROPWAT 4 for Windows Computer Software” are referred to “attached Data-1: 

Manual for CROPWAT 4 Windows Computer Software”. 
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     Figure 4-3      Location Map of Meteorological Observation Stations in Eight ADD 
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(2) Proposed Cropping Patterns 

Following cropping patterns are planned as a representative one in each area to calculate crop water 
requirements and irrigation water requirements, considering topography, water availability, soil 
conditions, current farming practices, marketing conditions, etc. around each areas 

Proposed Representative Cropping Pattern in Eight ADD 
 

Month Cropping Pattern 
1 2 3 4 5 6 7 8 9 10 11 12

Type-1: 
Maize (S) + Maize (W1) + Maize(W2) 

 
 
 
 

           

Type-2: 
Rice (S) + Maize (W2) 

 
 
 

           

 

(3) Estimation of Irrigation Water Requirements 

In estimating irrigation water requirements applying the “CROPWAT” equation mentioned above, 
following procedures and assumptions are taken into considerations; 

 
 Crop coefficient : Crop coefficients for maize and upland crop are referred to the 

authorized values in the computer program, while those for paddy 
rice are quoted from FAO Technical paper NO. 24 (refer to Figure 
A.2-1 and A.2-2 in the Attached Data) 

 
 Effective rainfall :  Upland Crops 

Effective rainfall for the upland crop is counted in calculating 
irrigation water requirement. Following UDDA Soil Conservation 
Service method (USSCS) will be applied to estimate an effective 
rainfall; 
 

   Effective rainfall/month = monthly rainfall (R) x (125 – 0.2 x R) / 
125 for R < 250 mm 

   Effective rainfall/month = 125 + 0.1 x R for R > 250 mm 
 
   Paddy Rice 

Effective rainfall for paddy rice was estimated based on the 
following criteria; 
 
10-day rainfall (R10) < 10 mm  :  0 % 
R10 < (N +LP) x 10 day  :  100 % 
R10> (N +LP) x 10 day  :  (N+ LP) x 10 day x100/R10 
Where :   N   :  Nursery water 
   LP  :  Land preparation water 

 
 
 
 

Maize (S) 

Maize (W1) 
Maize (W2) 

Rice (S) 
Maize (W2) 

86



 
Final Report, Annex 1 Technical Guidelines August 2009 

 Irrigation efficiency (IE) : Following irrigation efficiencies will be used.  
        

Items Upland Crops Paddy Rice 
Application Efficiency 70 % 80 % 
Canal Efficiency (Main/Lateral) 90 % 90 % 
              (Farm Ditch) 80 % 80 % 
Overall Irrigation Efficiency 50 % 58 % 

 
 Net irrigation water requirements (NWR):  
  Net irrigation water requirements (NWR) will be calculated by 

deducting the effective rainfall estimated on the 10-day basis by 
following equation; 

 
NWR = ETc - Re  
  Where;   

 NWR : Net irrigation requirements (mm/day) 
 ETc :  Crop evapo-transpiration (mm/day) 
 Re :  Effective rainfall (mm) 

 
 Gross irrigation water requirements (GWR): 
  Gross irrigation water requirements (GWR) will be calculated by 

taking into consideration overall irrigation efficiencies (IE). The 
GWR will be estimated by the following equation.  

 
GWR= NIR/IE 
 Where;   

 GWR :  Gross irrigation water requirements (mm/day) 
 NWR : Net irrigation water requirements (mm/day)  
 IE  : Overall irrigation efficiency 
 

Table A.2-2 in the Attached Data shows the major dimensions for 18 station-wised cropping patterns 
covering eight ADD. 10-day interval of irrigation water requirements will be calculated at the 18 
stations based on the above mentioned procedures and pre-conditions, and their results are 
summarized Table 4-2. 

(4) Irrigation Water Requirements for System Capacity 

Irrigation water requirements (IWR) to plan the system capacity will be determined by taking into 
consideration the time of irrigation hours per day and working day per week. The following equation 
will be used for the determination of the IWR: 

 
 IWR = GWR x A x 10,000 /(Hr x 3,600) x 7/v 
      Where, 

IWR :  Irrigation water requirements for system capacity (lit./sec) 
GWR :  Gross irrigation water requirements ( mm/day) 
A :  Irrigation area (ha) 
Hr :  Water supply hours per day (hrs) 
V :  Working days per week (days) 
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Data-1:    Manual for CROPWAT 4 Windows Computer Software 
 
1. Outline of CROPWAT 4 Windows Computer Software  

In the process for estimating the irrigation water requirements, the reference crop evapo- transpiration 
(ETo) for maize and upland crops can be estimated using the “CROPWAT 4 for Windows Computer 
Software”, being popular in the agricultural development plan in Malawi, which is based on the FAO 
Penman- Monteich Equation. The Penman-Monteith equation is given by the following equation 

 
 

 
 
 

Where;  
  ETo =  Reference evapo-transpitation (mm/day) 
  Rn  =  Net radiation at the crop surface (MJ/m2per day) 
  G  =  Soil heat flux density (MJ/m2per day) 
  T  =  Mean daily air temperature at 2 m height (℃） 
  U2  =  Wind speed at 2 m height (m/sec) 
  Es  =  Saturation vapour pressure (kpa) 
  Ea  =  Actual vapour pressure (kpa) 
  Es – ea =  Saturation vapour pressure deficit (pka) 

△     ＝  Slope of saturation vapor pressure curve at temperature T (kpa/℃) 
γ  =  Psychometric constant (kpa/℃) 

 

Crop water requirements (ETc/CWR) can be estimated by multiplying ETo mentioned in the above by 
a crop coefficient (Kc), that is: 

 
ETc = ETo x Kc 

 
Where; 
  ETc /CWR =  Crop water requirements (mm/day) 
  ETo  =  Reference crop evapo-transpiration (mm/day) 

Kc  =  Crop coefficient 
 
2. Installation of “CROPWAT 4 Windows Computer Software” 
“CROPWAT 4” Software application is installed by the following ways; 

 
a) Set-up CD on the CD drive, and then open the Cropwat unzipped folder, 
b) Double click on the file called setup.exe, and follow the on-screen instruction, 
c) Create a folder on the C : drive called Cropwat Files, 
d) Copy all the files from Cropwat/Africa files unjipped to the newly created Cropwat Files 

folder, 
e) Launch Cropwat, 
f) When wanting to retrieve data, navigate to the Cropwat Files folder, and choose the relevant 

country file, 
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3. Interface and Menu Systems 
a) Click My-computer, and then select Drive C, 
b) Click CROPWAT, and then double click “CROPWAT Cropwat 4 Windows”, 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

c) Cropwat for Windows main screen appears as follows, 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

d) Main Menu and Tool Bar 

The main “route” through the program follows the menu options along the top of the screen, and 
also you can access the data entry windows using the icons in the Tool Bar. 

 
 
 
 

 
 
 

1) First, you enter data (either using menu option File or Input Data) 
2) Next, you define your scheduling criteria (use menu option Schedule, Criteria), 
3) The results can be seen in tabular or graphical form (menu options Tables and Graphs) 
4) You can save the results into ASCII file 

 

Input Data Scheduling Tables Graphs Editor 

Click 
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4. Actual Operation of CROPWAT 4 Windows Computer Software 
4.1 Data needed for Calculation 

Following data required for Crop Water Requirements and Scheduling calculation have to be prepared 
in advance; 

  Climate data consisting of temperature, wind speed, actual sunshine hours, humidity (refer to 
Table A.2-1) 

  Cropping pattern consisting of one or more crop file names, planting date (sowing, 
transplanting, harvesting date, growing periods), and rate of cropping area (refer to Table 
A.2-2), 

  Monthly rainfall data at the observation station  
  Soil type information consisting of soil texture, rooting depth, readily available soil moisture 

(refer to Table A.2-2). 
 

4.2  Creation of Folders to save Calculation Results 

Prior to the calculation, necessary Folders to save calculation results for each irrigation scheme have 
to be created in the Reports of Cropwat Files, 

a) Click Cropwat in drive C, and then double click Reports, 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click 
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b)   Create scheme-wised Folders 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.3  Calculation of Crop Water Requirements and Scheduling 
a)  Climate 
By Means of Retrieve Way (in Case Climate Database is available in Cropwat Software) 

 
1. Open CROPWAT, Cropwat 4 Windows 
2. Input Data (click) → Climate (click) → Retrieve (click) 

 
 
 
 
 
 
 
 
 
 
 
 

3. C:¥ (double click) → CROPWA~1 (double click) AFRICA~1 (double click) → MALAWI 
(double click) 

4. “List Files of Type ▼”(click) → select “Old Climate File (＊.pen)” → Present the Climate 
Stations in File Name → Select the objective station (MUZIMBA.PEN) → Ok 

 
 
 
 

CROPWAT 

CLIMATE

REPORTS

01 Mantha Irrigation Scheme 

S-Ma-1 

W1-Ma-1

W2-To-1

02 Bethani Irrigation Scheme 

03 Kachere Irrigation Scheme

SCHEDULING

SOIL 

CROPS 

Click 
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5. Present “Any ETo data currently in memory will be cleared” → Ok 
6. Tables (click) → Climate & ETo (click) → Present “Climate Data Table” → Report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Present “Saving Climate & ETo Data in a Formatted File” →  Mantha Scheme in 
Directories (double click) → Selection of S-Ma-1 folder → Input Climate. txt in the space 
of “＊”.txt in File Name → OK 

8. Present “Data saved successfully in C:¥Cropwatw ¥Report ¥ 01 Mantha ¥Climate.txt → 
OK 

9. Close (click) 
 
 
By Means of Data Input Way (in Case Climate Database is not available in Cropwat Software) 
 

1. Open CROPWAT, Cropwat 4 Windows 
2. Click Input Data (click) → Climate (click) → Enter/Modify (click) 
3. Present “Monthly Climate Data” → Input Climate Data in January → Next (click) → 

Input Data up-to December → Save 
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4. Present “Data saved successfully in C: ¥Cropwatw ¥Climate ¥Kasungu.pem” 
5. Present “Saving Climate Data” → Input Kasungu. Pen in File Name → OK → Ok 
6. Table (click) → Climate & ETo (click) → Present Climate & ETo → Report (click) 
7. Present “Saving Climate & ETo Data in a Formatted File” →  Kachere Scheme in 

Directories (double click) → Select S-Ma-1 folder → Input Climate. txt in the space of 
“＊”.txt → OK → Close 

 
b) Rainfall 
By Means of Retrieve Way (in Case Climate Database is available in Cropwat Software) 
 

1. Input Data (click) → Rainfall (click) → Retrieve (click) 
2. C:¥ (double click) →  CROPWA~1 (double click) →  AFRICA~1 (double click) → 

MALAWI (double click) 
3. “List Files of Type ▼” (click) → select “Old Rainfall File.cli (＊.Cli)” → Present the 

Rainfall Stations in File Name → Select the objective station (Muzimba.Cli) → Ok 
4. Table (click) → Rainfall (click) → present “Monthly Rainfall Data” → Report (click) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Present “Saving Rainfall Data in a Formatted File” → Mantha Scheme in Directories 
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(double click) → Select “S-Ma-1” folder → Input “Rain.txt” in the space of “＊”.txt → 
Ok 

6. Present “Data saved Successfully in C: ¥Cropwatw ¥01 Mantha ¥Rain.txt → OK 
7. Close (click) 

 
By Means of Data Input Way (in Case Climate Database is not available in Cropwat Software) 

1. Input Data (click) → Rainfall (click) → Enter/Modify (click)  
2. Present “Monthly Rainfall Data Form” →  Input Monthly Rainfall Data → 

Automatically converted into Effective Rainfall → Save (click) 
3. Present “Saving Rainfall Data” →  Input Kasungu.crm in File Name → OK → OK 
4. Table (click) → Rainfall (click) → Present Monthly Rainfall Data → Report (click) 
5. Present “Saving Rainfall Data in a Formatted File” → Kachere Scheme in Directories 

(double click) → Selection of S-Ma-1 folder → Input Rain. txt in the space of ＊.txt → 
OK → Close (click X) 

 
c) Crops – Cropping Pattern 

1. Input Data (click) → Crops (click) → Cropping Pattern (click)→ Enter/Modify (click) 
 
 
 
 
 
 
 
 
 
 

2. Present “Cropping Pattern Planning” → Browse Crop Data File (click) → Select Crop 
(Exa. MAIZE. CRO) in Retrieve Crop Data → OK 

3. Input First Planting Date Day      / Month       → Input Percentage of Total Area 
Planted to Crop        →  OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Save Report (click) → Cropping Pattern (click) → Mantha in Directories (double click) 
→ S-Ma-1 (double click) 

5. Present “Saving Cropping Pattern Data in a Formatted File” → Input Croppat.txt in File 
Name → OK → OK 

6. Close (click X) 

21  11 
100 

Click 
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d) Crops – Crop Coefficient 

1. Input Data (click) → Crops (click) → Cropping Coefficient (click) → Enter/Modify 
(click) 

2. Present “Crop Data” → Input Planting Day      / Month       
 
3. Change “Stage Days” → (I)        (II)        (III)        (IV)          

 
4. Change “Root Depth”        

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Report (click) → Present “Saving Crop Data in a Formatted File” → Mantha (double 
click) → S-Ma-1 (double click) 

6. Present “Saving Crop Data in a Formatted File” → Input Cropcoef.txt in File Name → 
OK → OK 

7.  Close (click X) 
 
e) Soil 

1. Input Data (click) → Soil (click) → Enter/Modify (click) 
2. Present “Soil Data” → Retrieve (click) 
3. Present “Retrieve Soil Data” → Medium (click) → OK 
4. Present “Soil Data” → Change “Total Available Soil Moisture” →   
5. Change “Maximum Rooting Depth” →  
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6. Report (click) → Present “Saving Soil Data in a Formatted File” → “Mantha” (double 
click) → “S-Ma-1”(double click) 

7. Present “Saving Soil Data in a Formatted File” → Input “Soil.txt in File Name” → OK 
→ OK 

8. Close (click X) 
 
f) Crop Water Requirement (CWR) 

1. Table (click) → CWR (click) → Present “Crop Water Requirement Table” 
2. Change “Time Step (days)” →        
 
3. Change “Irrigation Efficiency” →        

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Report (click) → Present “Saving CWR Data in a Formatted File” → “Mantha” (double 
click) → “S-Ma-1” (double click) 

5. Present “Saving CWR Data ub a Formateted File” → Input “FWS.txt in File Name”→ 
OK → OK 

6. Close (click) 
 
g) Print Out the Calculated Data 

1. Click My-Computer, and then select Drive C 
2. Double Click “CROPWAT” 
3. Report (click) → Select “Mantha” → Select “S-Ma-1” 
4. Present “Each File of Climate, Rain, Croppat, Cropcoef, Soil, CWR” 
5. Print out Each File 
 
 
 
 
 
 
 
 
 

10 

50 

97



 
Final Report, Annex 1 Technical Guidelines August 2009 

Calculated Crop Water Requirements (CWR) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
h) Collection Ways for Inputed Data 

1. Click My-Computer, and then select Drive C 
2. Open CROPWAT, “CROPWAT Cropwat 4 Windows” 
3. Input Data (click) → Climate (click) → Enter/Modify (Click) → Retrieve (click) → 

Select “Kasungu” → OK  
4. Present “Confirm Action Table”, and “Any ETo data currentlt in memory will be cleared” → 

OK 
5. Next (click) → Collection of Input Data → Report (click) 
6. Select “Kasungu” and “S-Ma-1” → Put “File Name (Climate. Txt)” → OK 
7. Inquireing “Overwrite ?” → “Yes” → OK 
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